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THIS PRODUCT CONTAINS CERTAIN COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL, THE USE OF WHICH IS SUBJECT TO
THIS END-USER LICENSE AGREEMENT (THE "AGREEMENT"). DO NOT PROCEED WITH THE INSTALLATION OF THIS PRODUCT UNTIL YOU
(LATER DEFINED AS LICENSEE) HAVE READ THIS AGREEMENT AND AGREE TO BE BOUND BY AND BECOME A PARTY TO THIS
AGREEMENT.  BY PROCEEDING WITH THE INSTALLATION OF THIS PRODUCT (OR AUTHORIZING ANY OTHER PERSON TO DO SO), YOU
AND YOUR COMPANY ACCEPT THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU MAY EXIT THE
INSTALLATION PROCESS AND RETURN THIS PRODUCT, ALL MEDIA AND DOCUMENTATION, AND PROOF OF PAYMENT, TO THE PLACE
YOU OBTAINED THEM FOR A FULL REFUND WITHIN TEN (10) DAYS OF FIRST ACQUIRING THIS PRODUCT. WRITTEN APPROVAL IS NOT A
PREREQUISITE TO THE VALIDITY OR ENFORCEABILITY OF THIS AGREEMENT AND NO SOLICITATION OF ANY SUCH WRITTEN APPROVAL
BY OR ON BEHALF OF LEGATO SHALL BE CONSTRUED AS AN INFERENCE TO THE CONTRARY.  IF YOU HAVE ORDERED THIS PRODUCT,
LEGATO'S ACCEPTANCE IS EXPRESSLY CONDITIONAL ON YOUR ASSENT TO THESE TERMS TO THE EXCLUSION OF ALL OTHER TERMS; IF
THESE TERMS ARE CONSIDERED AN OFFER BY LEGATO, ACCEPTANCE IS EXPRESSLY LIMITED TO THESE TERMS.

1. DEFINITIONS

1.1 Authorization Code:  means the code provided to Licensee by Legato
for permanent authorization to use the Software. The Authorization Code
is provided to Licensee once the Enabler Code is registered with Legato.

1.2 Documentation:  means any user reference materials on any media,
provided by Legato for use with the Software.

1.3 Enabler Code: means the code provided by Legato for activation of the
Software.

1.4 Licensee:  means the person or entity acquiring this License or for
whom this License was acquired.

1.5 Software means the object code copy of the software program provided
to You in association with this Agreement, together with the associated
original electronic media and all accompanying manuals and other
documentation, and together with all enhancements, upgrades, and
extensions thereto that may be provided by Legato to You from time to
time.

2. OWNERSHIP AND ADMINISTRATION OF SOFTWARE

2.1 Ownership and Title. As between the parties, Legato, and its licensors,
own and shall retain all right, title, and interest in and to: (i) the Software
including all intellectual property rights embodied therein; (ii) all of the
service marks, trademarks, trade names, or any other designations
associated with the Software; and (iii) all copyrights, patent rights, trade
secret rights, and other proprietary rights relating to the Software.
Licensee further acknowledges and agrees that it shall have no rights with
respect to any of the foregoing rights other than the rights expressly set
forth in this Agreement.

2.2 Software Activation.  Legato employs Enabler Codes and
Authorization Codes that enable the use of the Software. The Software is
shipped in a "Media Kit" which consists of object code software on
CD-ROM and an Enabler Code for initial activation of the Software or the
Software and Enabler Code may be delivered electronically. Once Legato
receives confirmation from Licensee that the Enabler Code is installed and
is provided with the host ID information, Legato will provide the
Authorization Code to Licensee.  Legato administers the generation and
distribution of Enabler and Authorization Codes, which administration
may be modified by Legato from time to time.

2.3 Administration of Software. Legato may include on the media with the
Software additional computer programs which are not currently licensed
for use by Licensee and to which the Enabler Code or Authorization code
will not permit access. Inclusion of such additional computer programs in
no way implies a license from Legato and access or use of such programs
is strictly prohibited unless Licensee procures the right to use any such
program and the applicable Enabler Code is provided thereto.

3. LICENSE GRANT

3.1 Grant.  Legato grants to Licensee a non-exclusive, nontransferable,
non-sublicensable, perpetual, unless terminated in accordance with the
provisions of this Agreement, license (the "License") to (i) use the Software
installed in accordance with the Documentation and only on the licensed
computer solely for its own internal operations; and (ii) move the Software
temporarily in case of computer system malfunction. The License granted
under this Agreement does not constitute a sale of the Software or any
portion or copy of it. Licensee may not use the Software on more than one
computer system unless otherwise specifically authorized by an explicit
Software product, or additional licenses for additional computers are
purchased.  Rights not expressly granted are reserved by Legato.  Where
the Software is provided to Licensee at no charge for evaluation purposes
only, the License granted is limited to a continuous thirty (30) day period,
commencing with the acceptance of this Agreement (the "Evaluation
Period").  At the conclusion of the Evaluation Period, Licensee agrees to
destroy the Software and certify its destruction to Legato, in writing,
within ten (10) days, or shall return the Software to Legato or purchase a
perpetual license.

3.2 Copies.  Licensee may make copies of the Software provided that any
such copy is : (i) created as an essential step in utilization of the Software
on the licensed computer and is used in no other manner; or (ii) used for
archival purposes to back-up the licensed computers. All trademark and
copyright notices must be reproduced and included on such copies.
Licensee may not make any other copies of the Software.

3.3 Restrictions on use. Licensee shall not, and shall not aid, abet, or permit
any third party to:  (i) decompile, disassemble, or otherwise reverse
engineer or attempt to reconstruct or discover any source code or
underlying ideas or algorithms of the Software by any means whatsoever;
(ii) remove any identification, copyright, or other notices from the
Software; (iii) provide, lease, lend, use for timesharing or service bureau
purposes, or otherwise use or allow others to use the Software or any
portion thereof to or for the benefit of third parties; (iv) create a derivative
work of any part of the Software; or (v) develop methods to enable
unauthorized parties to use the Software.  If EC law is applicable, the
restrictions in Section 3.3 (i) are limited so that they prohibit such activity
only to the maximum extent such activity may be prohibited without
violating the EC Directive on the legal protection of computer programs.
Notwithstanding the foregoing, prior to decompiling, disassembling, or
otherwise reverse engineering any of the Software, Licensee shall request
Legato in writing, to provide Licensee with such information or assistance
and Licensee shall refrain from decompiling, disassembling, or otherwise
reverse engineering any of the Software unless Legato cannot or has not
complied with such request in a commercially reasonable amount of time.

3.4 Purchase Orders.  Nothing contained in any purchase order,
acknowledgment, or invoice shall in any way modify the terms or add any
additional terms or conditions to this Agreement.

3.5 Updates. This section applies if the Software acquired is an update to
the original Software ( the "Update").  An Update does not constitute a
legally licensed copy of the Software unless purchased as an Update to a
previous version of the same Software.  The Update may only be used in
accordance with the provisions of this Agreement.  The Update, together
with the original Software, constitute one (1) legally licensed copy of the
Software.

3.6 Evaluation License.  This Section applies if the Software is being used
for an initial thirty (30) day evaluation period. The license is valid only for
a period of thirty (30) days from the delivery of the Software, and is
designed to allow Licensee the right to evaluate the Software during such
period.  In the event that Licensee desires to enter into a longer-term
license agreement with Legato, Licensee shall obtain an appropriate
Enabler and Authorization Code in accordance with Section 2.2 above,
upon payment of applicable fees, which authorizes use of the Software
after such evaluation period, but only subject to all of the terms and
conditions of this Agreement.  In the event Licensee determines not to
enter into a licensing transaction with Legato at the end of such thirty (30)
day evaluation period, then Licensee's rights under this Agreement shall
terminate automatically and Licensee shall promptly return to Legato or
destroy all copies of the Software and so certify to Legato.

4. MAINTENANCE AND SUPPORT

4.1 Legato has no obligation to provide support, maintenance, upgrades,
modifications, or new releases under this Agreement. Legato may provide
such services under separate agreement.

5. LIMITED WARRANTY

5.1 Media and Documentation.  Legato warrants that if the media or
documentation are damaged or physically defective at the time of delivery
of the first copy of the Software to Licensee and if defective or damaged
product is returned to Legato (postage prepaid) within thirty (30) days
thereafter, then Legato will provide Licensee with replacements at no cost.

5.2 Software.  Subject to the conditions and limitations of liability stated
herein, Legato warrants for a period of thirty (30) days from the delivery
of the first copy of the Software to Licensee that the Software, as delivered,
will materially conform to Legato's then current published
Documentation for the Software.  This warranty covers only problems
reported to Legato during the warranty period.



5.3 Remedies. The remedies available to Licensee hereunder for any such
Software which does not perform as set out herein shall be either repair or
replacement, or, if such remedy is not practicable in Legato's opinion,
refund of the license fees paid by Licensee upon a return of all copies of the
Software to Legato.   In the event of a refund this Agreement shall
terminate immediately without notice.

6. TERM AND TERMINATION

6.1 Term.  The term of this Agreement is perpetual unless terminated in
accordance with its provisions.

6.2 Termination.  Legato may terminate this Agreement, without notice,
upon Licensee's breach of any of the provisions hereof.

6.3 Effect of Termination.  Upon termination of this Agreement, Licensee
agrees to cease all use of the Software and to return to Legato or destroy
the Software and all Documentation and related materials in Licensee's
possession, and so certify to Legato. Except for the License granted herein
and as expressly provided herein, the terms of this Agreement shall
survive termination.

7. DISCLAIMER AND LIMITATIONS

7.1 Warranty Disclaimer.  EXCEPT FOR THE LIMITED WARRANTY
PROVIDED IN SECTION 5 ABOVE, LEGATO MAKES NO
WARRANTIES WITH RESPECT TO ANY SOFTWARE AND DISCLAIMS
ALL STATUTORY OR IMPLIED WARRANTIES, INCLUDING
WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR ARISING FROM A
COURSE OF DEALING OR USAGE OF TRADE AND ANY
WARRANTIES OF NONINFRINGEMENT.  ALL SOFTWARE IS
PROVIDED "AS IS" AND LEGATO DOES NOT WARRANT THAT THE
SOFTWARE WILL MEET ANY REQUIREMENTS OR THAT THE
OPERATION OF SOFTWARE WILL BE UNINTERRUPTED OR ERROR
FREE.  ANY LIABILITY OF LEGATO WITH RESPECT TO THE
SOFTWARE OR THE PERFORMANCE THEREOF UNDER ANY
WARRANTY, NEGLIGENCE, STRICT LIABILITY OR OTHER THEORY
WILL BE LIMITED EXCLUSIVELY TO THE REMEDIES SPECIFIED IN
SECTION 5.3 ABOVE.  Some jurisdictions do not allow the exclusion of
implied warranties or limitations on how long an implied warranty may
last, so the above limitations may not be applicable.  This warranty
provides specific legal rights.  Other rights vary from state to state.
Licensee acknowledges and agrees that Legato is not responsible for and
will have no liability for hardware, software, or other items or services
provided by persons other than Legato.

8. LIMITATION OF LIABILITY

8.1 Limitation of Liability. NOTWITHSTANDING ANYTHING ELSE IN
THIS AGREEMENT OR OTHERWISE, AND EXCEPT FOR BODILY
INJURY, LEGATO WILL IN NO EVENT BE LIABLE OR RESPONSIBLE
FOR OR OBLIGATED WITH RESPECT TO THE SUBJECT MATTER OF
THIS AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT
LIABILITY, OR OTHER LEGAL CONTRACTUAL OR EQUITABLE
THEORY FOR:  (I) ANY INDIRECT,  SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND WHETHER
OR NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH
DAMAGES; OR (II) DAMAGES FOR LOST PROFITS OR LOST DATA; OR
(III) COST OF PROCUREMENT OF SUBSTITUTE GOODS,
TECHNOLOGY, SERVICES, OR RIGHTS; OR (IV) FOR ANY MATTER
BEYOND ITS REASONABLE CONTROL.  NOTWITHSTANDING
ANYTHING IN THIS AGREEMENT TO THE CONTRARY OR THE
FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITATION OF
LIABILITY OR LIMITED REMEDY, LEGATO'S ENTIRE AGGREGATE
LIABILITY ARISING FROM OR RELATING TO THIS AGREEMENT OR
THE SUBJECT MATTER HEREOF, UNDER ANY LEGAL THEORY
(WHETHER IN CONTRACT, TORT, INDEMNITY OR OTHERWISE)
SHALL BE LIMITED TO THE AMOUNTS RECEIVED BY LEGATO FOR
THE SOFTWARE DURING THE SIX (6) MONTH PERIOD PRIOR TO
THE DATE THE CLAIM AROSE FOR THE PARTICULAR LEGATO
SOFTWARE THAT CAUSED THE LIABILITY.

9. MISCELLANEOUS

9.1 Governing Law. This Agreement shall be governed by the laws of the
State of California, as applied to agreements entered into and to be
performed entirely within California between California residents,
without regard to the principles of conflict of laws or the United Nations
Convention on Contracts for the International Sale of Goods.

9.2 Government Restricted Rights.  This provision applies to Software
acquired directly or indirectly by or on behalf of any government.  The
Software is a commercial software product, licensed on the open market at
market prices, and was developed entirely at private expense and without
the use of any government funds.  Any use, modification, reproduction,
release, performance, display, or disclosure of the Software by any
government shall be governed solely by the terms of this Agreement and
shall be prohibited except to the extent expressly permitted by the terms of
this Agreement, and no license to the Software is granted to any
government requiring different terms.

9.3 U.S. Government Users. As defined in FAR section 2.101, DFAR section
252.227-7014(a)(1), DFAR section 252.227-7014(a)(5), or otherwise, all
software and accompanying documentation provided in connection with
this Agreement are "commercial items," "commercial computer software"
and/or "commercial computer software documentation." Consistent with
DFAR section 227.7202 and FAR section 12.212, any use, modification,
reproduction, release, performance, display, disclosure, or distribution
thereof by or for the U.S. Government shall be governed solely by the
terms of this Agreement and shall be prohibited except to the extent
expressly permitted by the terms of this Agreement. Licensee will ensure
that each copy used or possessed by or for the government is labeled to
reflect the foregoing.

9.4 Export and Import Controls.  Regardless of any disclosure made by
Licensee to Legato of an ultimate destination of the Products, Licensee will
not directly or indirectly export or transfer any portion of the Software, or
any system containing a portion of the Software, to anyone outside the
United States (including further export if Licensee took delivery outside
the U.S.) without first complying with any export or import controls that
may be imposed on the Software by the U.S. Government or any country
or organization of nations within whose jurisdiction Licensee operates or
does business.  Licensee shall at all times strictly comply with all such
laws, regulations, and orders, and agrees to commit no act which, directly
or indirectly, would violate any such law, regulation or order.

9.5 Assignment.  This Agreement may not be assigned or transferred by
Licensee without the prior written consent of Legato which shall not be
unreasonably withheld. Legato may assign or otherwise transfer any or all
of its rights and obligations under this Agreement upon notice to Licensee.

9.6 Sole Remedy and Allocation of Risk.  Licensee's sole and exclusive
remedy is set forth in this Agreement. This Agreement defines a mutually
agreed-upon allocation of risk, and the License price reflects such
allocation of risk.

9.7 Equitable Relief.  The parties agree that a breach of this Agreement
adversely affecting Legato's intellectual property rights in the Software
may cause irreparable injury to Legato for which monetary damages may
not be an adequate remedy and Legato shall be entitled to equitable relief
in addition to any remedies it may have hereunder or at law.

9.8 No Waiver.  Failure by either party to enforce any provision of this
Agreement will not be deemed a waiver of future enforcement of that or
any other provision, nor will any single or partial exercise of any right or
power hereunder preclude further exercise of any other right hereunder.

9.9 Severability.  If for any reason a court of competent jurisdiction finds
any provision of this Agreement, or portion thereof, to be unenforceable,
that provision of the Agreement will be enforced to the maximum extent
permissible so as to effect the intent of the parties, and the remainder of
this Agreement will continue in full force and effect.

10. ENTIRE AGREEMENT

10.1 This Agreement sets forth the entire understanding and agreement
between the parties and may be amended only in a writing signed by
authorized representatives of both parties. No vendor, distributor, dealer,
retailer, sales person, or other person is authorized by Legato to modify
this Agreement or to make any warranty, representation, or promise which
is different than, or in addition to, the warranties,  representations, or
promises made in this Agreement.
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Preface

The Legato NetWorker Disaster Recovery Guide, Release 6.1 contains information

on how to prepare for a disaster before one strikes and how to recover from a

disaster.

Using the NetWorker software to back up your data is the first step in a

disaster recovery program. The next step is deciding how to recover your data

after a disaster.

Audience
The information in this guide is intended for the following audiences:

• System administrators who perform backup and recovery procedures,

and maintain the safety of the data located over a network

• Managers who want to learn how to implement a disaster recovery

program

• Users who are responsible for implementing disaster recovery plans and

procedures

Product Documentation
Legato offers an extensive archive of product documentation at its web site

www.legato.com. Most of the documents are in Adobe® Acrobat® Portable

Document Format (PDF), and can be viewed by downloading and installing

the Adobe Acrobat Reader. The Reader is available in the /viewers/acroread
directory on the Legato Documentation Suite CD-ROM, or directly from

Adobe at www.adobe.com. To install and use the Reader on the platform of your

choice, refer to the instructions in the CD-ROM’s /viewers/acroread/readme.txt
file or at the Adobe web site.
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Conventions
This document uses the following typographic conventions and symbols to

make information easier to access and understand.

Convention Indicates Example

boldface Names of DOS or UNIX line

commands, daemons,

options, programs, or scripts

The nsradmin command starts the

command line version of the administration

program.

italic in text Pathnames, filenames,

computer names, new terms

defined in the Glossary or

within the chapter, or

emphasized words

Displayed messages are also written to

/nsr/logs/daemon.log.

italic in command
line

A variable that you need to

provide in the command line

nwadmin -s server-name

fixed-width Examples and information

displayed on the screen

media waiting: recover waiting for
8mm 5GB tape volume name

fixed-width,
boldface

Commands and options that

you must type exactly as

shown

nsr_shutdown -a

Menu_Name>

Command

A path or an order to follow

for making selections in the

GUI

Volume>Change Mode>Appendable

Important: Information that you must

read and follow to ensure

successful backup and

recovery of your data
Important: You must install the NetWorker

Module software in the same directory

where you installed the NetWorker client

binaries.



Preface

Legato NetWorker, Release 6.1
Disaster Recovery Guide 17

Information and Services
Legato offers a variety of methods, including electronic, telephone, and fax

support, for you to obtain company, product, and technical information.

General Information

The Legato web site provides most of the information that you need. If you

want technical bulletins and binary patches, you can also access the Legato

FTP site. If you have specific sales or training needs, e-mail or call Legato.

Technical Support

The Support section of the Legato web site provides contact information,

software patches, technical documentation, and information about available

support programs.

• If you have an active support agreement, you may access TechDialog, the

Legato integrated product knowledge base. You may also contact Legato

Technical Support for help with Legato software issues.

• If you do not have an active support agreement, contact LegatoCare to

purchase annual Software Update Subscriptions, Legato Technical

Support services, or per-update/per-incident support.

Legato Service or
Resource

Technical
Bulletins

Binary
Patches

Company &
Product
Information

Training
Programs

www.legato.com Yes Yes Yes Yes

ftp.legato.com
(log in as anonymous)

Yes Yes

Legato Sales

(650) 210-7000 (option 1)

sales@legato.com

Yes

Legato Education Services

(650) 842-9357

training@legato.com

Yes
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Licensing and Registration

To license and register your Legato products, go to the Legato licensing web

site. To change contact information, transfer licenses, or ask questions about

licensing, contact Legato using one of the following methods.

Customer Feedback
Legato welcomes your comments and suggestions about software features, the

installation procedure, and documentation. Please send any suggestions and

comments to feedback@legato.com. You will receive a notice confirming receipt

of your e-mail. Although we cannot respond personally to every request, we

consider all your comments and suggestions during product design.

Help us improve our documentation and be eligible to win a prize by

completing a brief survey. Visit the Legato web site at www.legato.com, go to the

Technical Documentation page, and then look for the link to the Legato

Documentation Survey.

Licensing and Registration Contact

Legato licensing web site http://license.legato.com

Telephone number 650) 812 6000 (option 3, option 3)a

+31 23 554 8881b

a. Contact information for Americas, Asia, and Pacific.

b. Contact information for Europe, Middle East, and Africa.

Fax number (650) 745-1477a

+31 23 554 8808b

E-mail licensing@legato.coma

licensingemea@legato.comb
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Chapter 1: Introduction

The Legato NetWorker Disaster Recovery Guide, Release 6.1 provides step-by-step

instructions for recovering from a disaster on supported NetWorker 6.1 client

and server platforms.

Note: The term “autochanger” refers to a variety of backup devices:

autoloader, carousel, datawheel, jukebox, library, and near-line storage.

What Is a Disaster?
For the purpose of this guide, a disaster is any situation in which the day-to-day

access to data (for example, working files, software programs, or system files)

is disrupted. A disaster can also damage network components, such as data,

devices, hardware, media, and software.

A disaster can be the result of any one or a combination of the following:

• Computer viruses that can corrupt data

• Hardware and software failures

• Infrastructure interruptions, inconsistencies, or loss of services such as

communication or network connections

The degree of loss during a disaster can range from one or more files lost when

a disk crashes to an entire computer system. The degree of severity of the

disaster determines the procedures you might need to perform to recover your

data.
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Disaster Recovery Guide Overview
The guide includes the following chapters that will help you prepare for and

perform a recovery of your NetWorker servers, clients, and storage nodes:

• “Chapter 3: Windows NT 4.0/UNIX Disaster Recovery” on page 27

• “Chapter 4: Windows 2000 Disaster Recovery” on page 61

• “Chapter 5: NetWare Disaster Recovery” on page 91

• “Chapter 6: Windows 95/98 Client Disaster Recovery” on page 113

• “Chapter 7: NetApp Client Disaster Recovery” on page 121

• “Chapter 8: Microsoft Cluster Disaster Recovery (Windows NT 4.0)” on

page 127

• “Chapter 9: Microsoft Cluster Disaster Recovery (Windows 2000)” on

page 145

• “Chapter 10: Sun Cluster Disaster Recovery” on page 153

• “Chapter 11: Compaq Cluster Disaster Recovery” on page 157

• “Chapter 12: HP-UX Cluster Disaster Recovery” on page 161

• “Chapter 13: Legato Cluster for AIX, HP-UX, Linux, and Solaris Disaster

Recovery” on page 165

• “Chapter 14: Legato Cluster for Windows Disaster Recovery” on

page 175

• “Chapter 15: HACMP for AIX Disaster Recovery” on page 183
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Chapter 2: Preparing for a Disaster

This chapter contains concepts, information, and links to procedures on

preparing for a disaster.

If you are viewing the online version of this guide, print out a hard copy and

store it in a safe location.

Preparing for Disaster
You should back up important data on a scheduled basis. The more time and

effort you invest in incorporating, maintaining, and testing a backup solution,

the better prepared you will be in the event of a disaster.

Ensure that your servers are backed up regularly using a backup group.

Otherwise, a bootstrap will not be saved (because backups performed using

the command line or the NetWorker User program do not save the NetWorker

server bootstrap). You should also ensure that a local backup device on the

server is used to back up the server’s bootstrap.

In the case of a NetWorker version upgrade, always perform a scheduled

backup of the NetWorker server right after the upgrade. This ensures that a

new version (upgraded version) bootstrap is saved.

The bootstrap can be printed from the savegrp.log file, which is located in the

nsr directory. Refer to the appropriate Administrator’s Guide for instructions on

how to configure the NetWorker software to send bootstrap information

directly to a printer or to a specified e-mail address. If the bootstrap is backed

up to a pool other than the preconfigured pools, save the name of the pool

along with the bootstrap.
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To ensure that you can recover from network-related disasters, you must have

access to the key information related to each computer within your

organization that needs protection. Maintain a copy of this key information on

site, so that it can be easily accessed by those assigned to perform disaster

recovery.

Important: Having the correct information on hand in case a disaster occurs is

a key element in recovering from a disaster as quickly as possible.

Enact strict guidelines regarding the access, maintenance, and usage of this

key information, and maintain the information in an onsite locale that is the

most resistant to disaster.

Gathering the Key Information
Maintain accurate records for each hardware, software, network, device, and

media component within your organization.

Computer Hardware Information

The following information regarding computer hardware must be maintained

and kept up-to-date:

• Filesystem configuration

• Fully Qualified Domain Names, IP addresses, and hostnames

• For Domain Name Service (DNS) clients, maintain the DNS host’s

internet address and its hostname

• Hard drive configuration information

• Media device names

• Hardware vendor contact information and contract number

• Configuration information for each piece of hardware, both active and

inactive, within the organization or organizational site
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To obtain hardware information for a specific operating system, see:

• NetApp®: “Replacing a Hard Drive” on page 122

• NetWare®: “Obtaining the Hard Drive Information” on page 92

• Windows® 95/98: “Obtaining the Hard Drive Information” on page 114

• Windows NT® 4.0/UNIX®: “Obtaining the Hard Drive Information” on

page 29

• Windows® 2000: “Obtaining the Hard Drive Information” on page 63

Computer Software Information

The following information regarding computer software must be maintained

and kept up-to-date:

• Copies of the original operating system and software media and patches

(and where they are located)

• Software enabler and authorization codes

• Software vendor contact information and contract number

• The operating system version and patches installed

• Operating system configuration information

• Emergency media that can be used to restore a computer in the event of a

disaster

• NetWorker bootstrap information for each NetWorker server

• Kernel configuration and location information

• Device drivers
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To obtain software information for a specific operating system, see:

Platform Recovery/Repair
Prerequisite
Information

Windows NT 4.0/UNIX Recovering the UNIX Operating

System

page 31

Repairing the Windows NT 4.0

Operating System

page 35

Recovering the Windows NT 4.0

Operating System

page 40

Recovering a Windows NT 4.0/

UNIX NetWorker Server

page 44

Recovering NetWorker Client or

NetWorker Storage Node Data

page 56

Windows 2000 Recovering the Windows 2000

Operating System

page 64

Recovering a Windows 2000

NetWorker Server

page 69

Recovering NetWorker Client or

NetWorker Storage Node Data

page 85

Recovering Microsoft Cluster

Server Host Systems

page 145

NetWare Recovering the NetWare Operating

System

page 94

Recovering a NetWare NetWorker

Server

page 97
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Platform Recovery/Repair
Prerequisite
Information

Windows 95/98 Recovering the Windows 95/98

Operating System

page 115

Recovering a Windows 95/98

NetWorker Client

page 118

NetApp Recovering the Data ONTAP™

Operating System

page 122

Recovering a NetApp NetWorker

Client

page 125
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Chapter 3: Windows NT 4.0/UNIX Disaster
Recovery

This chapter describes how to perform a disaster recovery on a Windows NT

4.0 or UNIX system using NetWorker 6.1 software.

Disaster Recovery Procedures Overview
Following is a brief overview of disaster recovery procedures. These

procedures are explained in detail in subsequent sections in this chapter.

1. Reinstall the operating system, if necessary.

2. Reinstall the NetWorker software, if necessary.

3. If you are using a stand-alone device, configure the device and load the

volume containing the latest bootstrap.

4. If you are using an autochanger:

a. Run the jbconfig command to install the autochanger.

b. Run the nsrjb -HE command to reset the autochanger.

c. Run the nsrjb -Iv -S# command to inventory the backup tape in slot #
containing the latest bootstrap.

d. Run the nsrjb -lnv -S# -f device-name command to load the backup

tape in slot # into the device.

5. If you know the bootstrap save set ID, run the mmrecov command to

recover the media database and resource configuration files.

If you do not know the bootstrap save set ID, run the

scanner -B device-name command to locate the bootstrap save set ID; then

run the mmrecov command to recover the media database and resource

configuration files.
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6. Stop the NetWorker services (Windows NT)/daemons (UNIX).

7. Copy the contents of the res.R directory to the res directory.

8. Restart the NetWorker services (Windows NT)/daemons (UNIX).

9. Run the nsrjb -HE command to reset the autochanger.

10. If you are using an autochanger, run the nsrjb -Iv command to

re-inventory the autochanger; or run the nsrjb -Iv -S command to

re-inventory only the affected slots.

11. Run the nsrck -L7 command to recover the indexes.

12. Start NetWorker User (Windows NT)/nwrecover (UNIX).

13. Recover the client data.

Entries in the following table point to sections in this chapter that describe

disaster recovery procedures you might need to follow, depending on the

situation.

To recover... See...

Hard drive • “Replacing a Hard Drive” on page 29

Operating system • “Recovering the UNIX Operating

System” on page 31

• “Repairing the Windows NT 4.0

Operating System” on page 35

• “Recovering the Windows NT 4.0

Operating System” on page 40

NetWorker server • “Recovering a Windows NT

4.0/UNIX NetWorker Server” on

page 44

Any client or storage node data • “Recovering Client or Storage Node

Data” on page 56

Data • Refer to the appropriate Legato

backup utility Administrator’s Guide

Legato Celestra Power/NDMP

data

• Refer to the appropriate Legato

Celestra® Administrator’s Guide
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Important: (Windows NT) You must recover disk data or application data

prior to recovering the registry or system state.

Replacing a Hard Drive
To replace a hard drive:

• Obtain the hard drive information.

• Replace the hard drive.

Obtaining the Hard Drive Information

The following information is required to replace a hard drive. Obtain the

information using the commands appropriate for your operating system.

• Size of the drive

• Volume size, filesystem type (Windows NT)

• Filesystem volume information (UNIX)

• Volume label assigned to each disk partition

This information includes details about:

• How the disk is partitioned

• How the disk is loaded

• The size of the disk

• Each logical volume (size and label)

• Each filesystem

Note: Though it will not affect NetWorker operation, you may also note any

use of mirroring, RAID/striping, compression, or volume sets.
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How to Replace a Hard Drive

If you are experiencing the failure of one or more hard drives, refer to the

appropriate documentation for your operating system and the appropriate

hard drive vendor documentation for detailed instructions on how to replace

your hard drive(s).

Important: Install a new drive that is the same size or larger than the original

drive. This will ensure that you can recover all of the drive’s data.

To begin the recovery process, recover:

• The UNIX operating system, if necessary. For details, see “Recovering the

UNIX Operating System” on page 31.

• The Windows NT operating system, if necessary. For details, see

“Recovering the Windows NT 4.0 Operating System” on page 40.

• The NetWorker server, if necessary. For details, see “Recovering a

Windows NT 4.0/UNIX NetWorker Server” on page 44.

• Any client or storage node data, if necessary. For details, see “Recovering

Client or Storage Node Data” on page 56.

• All other data not listed above (for example, application data and user

data) using the Legato backup utility you used to back up the data. For

details, refer to the appropriate Legato Administrator’s Guide.
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Recovering the UNIX Operating System
To recover the UNIX operating system:

• Meet the operating system recovery prerequisites.

• Recover the operating system.

Prerequisites

To recover the operating system, you need the following information:

• Version and patch level of the operating system

• TCP/IP properties:

– Adapter type

– IP address

– Default gateway

– Subnet mask

– DNS server

• Computer properties:

– Hostname

– DNS domain name

– Superuser password

• Device and SCSI drivers

• Boot files required for booting the kernel. For example:

– /unix

– /boot

– /etc/default/boot

– /stand/vmunix

Note: Refer to the appropriate documentation for your operating system to

determine which boot files should not be overwritten during a recovery.
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How to Recover the UNIX Operating System

This section describes how to recover the UNIX operating system. Use this

process to recover the operating system back to the original computer or to a

different computer.

You can recover the operating system by performing either a:

• Complete installation. In this instance you perform a complete

installation and configuration of the operating system.

— or —

• Partial installation. In this instance you install and configure only those

files that enable the computer to communicate over the network. Then,

recover the remaining operating system and configuration files using

NetWorker.

Important: Do not recover the operating system from an X session. Rather,

recover the operating system in single-user mode from the system console.

To recover the operating system, follow these procedures, explained in detail

in the following sections:

1. Install the operating system.

2. Configure the operating system.

3. Test the operating system and configure the devices.
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Task 1: Install the Operating System

To install the operating system:

1. Install the same version and patch level of the UNIX operating system into

its original location. Refer to the UNIX documentation accompanying the

operating system for details.

If you want to upgrade the operating system, first recover the operating

system as it was previous to the disaster, and then perform the upgrade.

2. Recreate all of the filesystems that were previously on the computer.

The filesystems must be:

• The same filesystem type.

• At least the same size as before to hold all of the backed-up data.

At a minimum, configure the root volume group and kernel parameters,

such as asynchronous I/O. If the resources are available, reconstruct

non-root volume group filesystems and logical volumes.

Task 2: Configure the Operating System

To configure the operating system:

1. Configure the network exactly as it was configured before the disaster. If

you do not, the NetWorker software will treat the computer as a new
computer. If the computer has a different host ID you must reregister the

NetWorker software. Refer to the appropriate NetWorker 6.1 Installation
Guide for details.

2. If you are recovering the operating system to a different computer, assign

the same hostname for the new computer. If you do not use the same

hostname, you will not be able to recover the NetWorker indexes associated

with the original computer.

3. Configure the date and time as they were configured before, including the

time zone.

4. Install any additional UNIX components or services before recovering the

computer’s data.

5. Reboot the computer.
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Task 3: Test the Operating System and Configure the Devices

To test the operating system and configure the devices:

1. Configure any devices required by the NetWorker software, for example

SCSI passthru devices for autochangers.

2. Perform a test to verify that the:

• Name to Address resolution and TCP/IP are functioning properly.

This test is performed by running ping to communicate with a client

or storage node, and then running ping on the client to reach the

server.

• Operating system is functioning properly.

• Tape drive is functioning properly. This test can be performed using

the mt commands.

• Devices are recognized by the operating system. If the devices are not

recognized by the operating system, you might need to:

– Load the SCSI driver.

– Install the device driver software.

– Modify the device configuration files to enable the computer to

communicate with the device during recovery. Refer to the

NetWorker 6.1 Administrator’s Guide, UNIX Version for details.

To complete the recovery process, recover:

1. The NetWorker server, if necessary. For details, see “Recovering a

Windows NT 4.0/UNIX NetWorker Server” on page 44.

2. Any client or storage node data, if necessary. For details, see “Recovering

Client or Storage Node Data” on page 56.

3. The computer’s data using the Legato backup utility you used to back up

the data. Refer to the appropriate Administrator’s Guide for details.
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Repairing the Windows NT 4.0 Operating System
To repair the Windows NT 4.0 operating system:

• Meet the Windows NT operating system repair prerequisites.

• Repair the operating system.

Prerequisites

To repair the Windows NT 4.0 operating system, you need the following:

• Original Windows NT operating system setup diskettes.

• Windows NT CD-ROM and service pack (same version/level as was

previously installed).

• Backup or clone volume containing the most recent Emergency Repair

Disk data (REPAIRDISK: save set) or a current Emergency Repair Disk.

• Administrator account password. This is only required if you are

repairing the registry, if available, or system state.

How to Repair the Windows NT 4.0 Operating System

To repair the Windows NT 4.0 operating system, follow these procedures,

explained in detail in the following sections:

1. Use NetWorker software on a different machine to create an Emergency

Repair Disk (if you do not have a current Emergency Repair Disk for the

target machine).

2. Use the Emergency Repair Disk to repair the operating system.
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Task 1: Use NetWorker to Create an Emergency Repair Disk (if required)

This section describes how to create an Emergency Repair Disk using

NetWorker.

Important: Since the operating system of the target machine needs repair, you

must use another Windows NT machine with a NetWorker client to create the

Emergency Repair Disk (this is referred to as a Directed Recover).

Prior to creating the Emergency Repair Disk, ensure that the following

prerequisites are true:

• Ensure that the computer you wish to use to create the Emergency Repair

Disk is a functional NetWorker client.

• Ensure that the computer you wish to use to create the Emergency Repair

Disk is connected to the NetWorker server that backed up the failed

computer’s REPAIRDISK.

• Ensure that the computer you wish to use to create the Emergency Repair

Disk is included in the Remote Access List of the computer you are

recovering. The Remote Access List is contained in the computer’s

associated client resource on the NetWorker server. For instructions, refer

to the NetWorker 6.1 Administrator’s Guide, Windows Version.

• If the earlier prerequisites are not true, you must update your server.

Before updating your server, ensure that the account creating the

Emergency Repair Disk (<username>@<computer>) is on the

Administrator's list (this will provide you with the proper permissions to

update the server). For instructions, refer to the NetWorker 6.1
Administrator’s Guide, Windows Version.

There are two ways to recover the Emergency Repair Disk data:

• Using the NetWorker User program. See “Using NetWorker User” on

page 37.

— or —

• Using the recover command. See “Using the recover Command” on page

37.
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Using NetWorker User

To recover the Emergency Repair Disk data using the NetWorker User

program:

1. Insert a formatted diskette (1.44 MB) into drive A.

2. From the Operation menu, select Directed Recover. The Source Client

window appears.

3. Select the computer you want to recover the data from (the computer on

which the disaster occurred) and click OK. The Destination Client window

appears.

4. Select the computer you want to recover the data to, and click OK. This is

the Windows NT computer on which you are creating the Emergency

Repair Disk.

5. Select and mark the REPAIRDISK directory.

6. From the Options menu, select Recover Options.

7. Enter a:\  in the Relocate Recovered Data To box.

8. Click Start to recover the Emergency Repair Disk data.

NetWorker creates the Emergency Repair Disk by recovering the source

client’s repair disk data to the diskette in drive A.

Important: If the repair disk file is larger than 1.44 MB, it will not fit onto a

diskette. This is a known limitation in the Windows NT operating system; a

workaround is not yet available.

Using the recover Command

To recover the Emergency Repair Disk data using the recover command,

follow these steps on the Windows NT server where the data for the failed

computer was saved:

1. Insert a formatted diskette (1.44 MB) into drive A.

2. Change to the directory containing the NetWorker binaries. By default the

binaries are located in the %SystemDrive%\Program Files\nsr\bin
directory.
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3. Recover the Emergency Repair Disk data using the recover command as

follows:

recover -c failed-hostname

recover>  cd /

recover>  add REPAIRDISK

recover>  relocate a:\

recover>  recover

This procedure initiates the recovery of the failed computer’s

REPAIRDISK data to the server’s drive A.

Task 2: Use the Emergency Repair Disk to Repair the Windows NT 4.0
Operating System

To use the Emergency Repair Disk to repair the Windows NT 4.0 operating

system:

1. Insert Windows NT Setup Disk 1 into drive A and reboot the computer.

2. When prompted, insert Windows NT Setup Disk 2 into drive A and press

[Enter].

3. Press [R] to select the Repair option from the Windows NT Setup Welcome

Screen.

4. Select the emergency repair options for your situation.

5. Select Continue and press [Enter].

6. When prompted, insert Windows NT Setup Disk 3 into drive A, press

[Enter], and follow the instructions.

7. Insert the Emergency Repair Disk into drive A and press [Enter]. When

prompted:

• Press [Enter] to repair the specified file.

• Press [Esc] if you do not want to repair the specified file.

If the operating system is damaged beyond repair, you must recover it. See

“Recovering the Windows NT 4.0 Operating System” on page 40 for

details.

8. Reboot the computer.

The operating system should now be repaired.
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9. Verify that:

• The operating system is functioning properly.

• The network protocols are functioning properly. Test by running

ping.

• The devices are recognized by the operating system.

• The Name to Address resolution is correct. Run nslookup using the

Fully Qualified Domain Name of the Windows NT NetWorker

backup server, client, or storage node.

10. If you are using a device with a default configuration that is not directly

supported by Windows NT, you might need to reinstall the device driver

software.

To complete the recovery process, recover:

• The NetWorker server, if necessary. See “Recovering a Windows NT

4.0/UNIX NetWorker Server” on page 44 for details.

• Any client or storage node data, if necessary. See “Recovering Client or

Storage Node Data” on page 56 for details.

• The computer’s data using the Legato backup utility you used to back up

the data. Refer to the appropriate Administrator’s Guide for details.
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Recovering the Windows NT 4.0 Operating System
To recover the Windows NT 4.0 operating system:

• Meet the operating system recovery prerequisites.

• Recover the operating system.

Prerequisites

To recover the operating system, you need the following:

• Windows NT CD-ROM and service pack (same version/level as was

previously installed).

• Location of the operating system.

• TCP/IP properties:

– Adapter type

– IP address

– Default gateway

– Subnet mask

– DNS server

• Windows NT Server/workstation properties:

– Computer name

– Domain name

– Administrator name and password

• Date/time properties.

• Virtual memory settings.

• Protocols installed.

• Localization Properties information for Windows NT.

• See “Dynamic Host Configuration Protocol (DHCP) and Windows

Internet Naming Service (WINS) Databases” on page 55 for more

information about requirements.
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How to Recover the Windows NT 4.0 Operating System

This section describes how to recover the Windows NT 4.0 operating system.

You can use this process to recover the operating system back to the original

computer or to a different computer.

You can recover the operating system by performing a:

• Complete installation. In this instance you perform a complete

installation and configuration of the operating system.

— or —

• Partial installation. In this instance, you install and configure only those

files that enable the computer to communicate over the network. Then,

recover the remaining operating system and configuration files using

NetWorker.

To recover the operating system, follow these procedures, explained in detail

in the following sections:

1. Install the Windows NT 4.0 operating system.

2. Test the operating system and configure the devices.

Task 1: Install the Windows NT 4.0 Operating System

To install the operating system:

1. Install the same version, service pack, and patch level of the Windows NT

operating system into its original location. Refer to the documentation

accompanying the operating system for details.

If you want to upgrade the operating system, first recover the operating

system as it was previous to the disaster, then perform the upgrade.

2. Install the computer as a Workstation or Server, not as a BDC (Backup

Domain Controller) or PDC (Primary Domain Controller).

3. Install the computer into a Workgroup, not into a Domain.

4. Configure the TCP/IP properties as they were configured before, with the

same hostname, IP address, default gateway, subnet mask, and DNS

server.
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Important: If you are recovering the operating system to a different computer,

you must:

— Use the same hostname for the new computer. If you do not use the same

hostname you will not be able to recover the NetWorker indexes associated

with the original computer.

— Assign the same TCP/IP address for the new computer, otherwise it will be

assigned a new host ID by NetWorker. If this computer does not have the same

TCP/IP address as the original computer, you must reregister the NetWorker

software. Refer to the NetWorker 6.1 Installation Guide, Windows Version for

details.

5. Configure the Windows NT server/workstation properties as they were

configured before the disaster. Make sure that you use the same computer

name, administrator name, and password.

6. Configure the Localization Properties as they were configured before the

disaster.

7. Restart the computer after installing the Windows NT operating system.

8. Reset the Virtual Memory Settings as they were configured before by

selecting System>Performance>Change in Control Panel.

Important: Do not upgrade OEM drivers for network interface cards (NIC)

with the OEM Service Pack version of the NIC.

9. To apply the new settings, restart the computer after the service pack is

installed.
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Task 2: Test the Operating System and Configure the Devices

To test the operating system and configure the devices:

1. Configure any devices required by NetWorker, for example, SCSI passthru

devices for autochangers.

2. Verify that the:

• Operating system is functioning properly.

• Network protocols are functioning properly. Test by running ping.

• The Name to Address resolution is correct. Test by running nslookup
using the Fully Qualified Domain Name of the Windows NT

NetWorker backup server, client, or storage node.

• Devices are recognized by the operating system. If the devices are not

recognized by the operating system, you might need to:

– Load the SCSI driver.

– Install the device driver software.

To complete the recovery process, recover:

• The NetWorker server, if necessary. For details, see “Recovering a

Windows NT 4.0/UNIX NetWorker Server” on page 44.

• Any client or storage node data, if necessary. For details, see “Recovering

Client or Storage Node Data” on page 56.

• The computer’s data using the Legato backup utility you used to back up

the data. Refer to the appropriate Administrator’s Guide for details.

Once you have recovered the computer’s data and rebooted the computer:

• If you want to use Active Desktop, install it.

• If the computer is a Backup Domain Controller, synchronize it with the

Primary Domain Controller.

• If the computer is a Primary Domain Controller, synchronize it with the

domain.
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Recovering a Windows NT 4.0/UNIX NetWorker Server
To recover a NetWorker server:

• Meet the NetWorker server recovery prerequisites.

• Recover the NetWorker server.

Prerequisites

To recover the NetWorker server, you need the following:

• Version and patch level of NetWorker.

• Location of NetWorker.

• NetWorker server installation media.

• Backup or clone volumes containing the server bootstrap and indexes.

• For UNIX systems, any links to the NetWorker directories (for example,

/nsr -> /usr/nsr).

Important: If you are trying to recover the NetWorker server on a Windows

NT computer, follow the instructions in the following section: “Dynamic Host

Configuration Protocol (DHCP) and Windows Internet Naming Service

(WINS) Databases” on page 55 before recovering the NetWorker server. This

will ensure that the Windows NT DHCP databases and WINS databases are

properly restored.
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How to Recover a Windows NT 4.0/UNIX NetWorker Server

This section describes how to recover a NetWorker server. You can use the

following process to recover the NetWorker server back to the original

computer or to a different computer.

Note: If you want to recover the NetWorker server to a different computer,

refer to Technical Bulletin 364: How to Rename a NetWorker Server (NT) or

Technical Bulletin 365: How to Rename a NetWorker Server (UNIX) for important

information (refer to the Legato web site www.legato.com under

Support/Documentation/Technical Bulletins).

Important: If your Windows NT 4.0/UNIX NetWorker server was also being

used as a Legato License Manager server (not recommended) and a disaster

recovery is required on the NetWorker server, the lictype.res file of the Legato

License Manager is not restored. This is because the Legato License Manager

files and directories are not considered part of NetWorker. After completing

the disaster recovery on the NetWorker server, you must explicitly recover the

Legato License Manager as a client of the NetWorker server.

To recover a NetWorker server, follow these procedures, explained in detail in

the following sections:

1. Install NetWorker.

2. Configure NetWorker.

3. Locate the server’s bootstrap save set ID.

4. Recover the NetWorker server bootstrap.

5. Rename the NetWorker server configuration files.

6. Recover all indexes for clients on the NetWorker server. (Because a

NetWorker server is always a client of itself, this step includes recovering

the client indexes that are associated with the server.)

7. Recover the NetWorker server’s client data.

8. Complete the server recovery.

Note: If you are using Windows NT 4.0 and you are using DHCP or WINS, see

“Dynamic Host Configuration Protocol (DHCP) and Windows Internet

Naming Service (WINS) Databases” on page 55.
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Task 1: Install NetWorker

Important: If you upgraded directly from Windows NT NetWorker 4.3 or

Windows NT NetWorker 5.7 to Windows NT NetWorker 6.0 and later and you

have not yet performed a scheduled backup of the NetWorker server since the

upgrade, you must reinstall the previously installed version of NetWorker

(Windows NT NetWorker 4.3 or Windows NT NetWorker 5.7) and use it to

recover the bootstrap before proceeding. Once you have recovered the

bootstrap using the previously installed version of NetWorker, reinstall

NetWorker 6.x and proceed as normal. This additional step applies only to

Windows NT NetWorker 4.3 and Windows NT NetWorker 5.7 bootstraps.

To install NetWorker:

1. Install the same version of NetWorker into its original location. Refer to the

appropriate NetWorker 6.1 Installation Guide for installation instructions.

Note: If you want to upgrade the NetWorker server, first recover the server to

its original state, then perform the upgrade.

2. Install any NetWorker patches that were installed prior to the disaster.

3. If you are using UNIX, recreate any links that you had to the NetWorker

directories (such as the NetWorker indexes and configuration files).

Task 2: Configure NetWorker

To configure NetWorker:

1. Configure the Device resource(s).

If you want to recover your data using a stand alone device, ensure that

the stand alone device resource exists (this is defined in your /nsr/res
directory). If you want to use a stand alone device and the stand alone

resource does not exist, create the stand alone device.

If you want to recover your data using an autochanger, ensure that the

autochanger resource exists (this is defined in your /nsr/res directory).

Otherwise, add and configure the autochanger using the jbconfig
command. Refer to the appropriate NetWorker 6.1 Administrator’s Guide for

details on how to use the jbconfig command.
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If you are using an autochanger, reset the autochanger using the

nsrjb -vHE command. This command resets the autochanger, ejects

backup volumes, reinitializes the element status, and checks each slot for

a volume.

If your autochanger does not support the -E option, initialize the element

status using sjiielm (on Linux, use ielem).

If you are using an autochanger, inventory the autochanger using the

nsrjb -I command. This will help you determine whether the volumes

required to recover the bootstrap are located inside the autochanger.

2. If you are recovering a relocated server’s file index from a NetWorker 6.0

or later version backup, this step is no longer necessary.

If you are recovering the server’s file index from a NetWorker pre-6.x

version backup and you relocated the server’s file index path to a new

location:

a. Edit the Index Path attribute in the server’s associated Client resource

to the original path.

b. Shut down and restart the NetWorker services (Windows NT) or

daemons (UNIX). This will enable NetWorker to recognize that the

index path has changed.

For instructions on how to shutdown and restart the NetWorker

services (Windows NT) or daemons (UNIX), refer to “Task 5: Rename

the NetWorker Server Configuration Files” on page 51 before

proceeding to “Task 3: Locate the Server’s Bootstrap Save Set ID”.

Task 3: Locate the Server’s Bootstrap Save Set ID

This section describes how to locate the save set ID for the NetWorker server’s

latest bootstrap. The bootstrap contains the media database and resource

configuration files.

Important: If you routinely move your NetWorker backup media to an offsite

location for safekeeping and a subsequent file recover operation generates a

mount request, the recover will wait until an operator satisfies the mount

request. To avoid delays when recovering files, use the mminfo -mv command

to list the media that is associated with the file you want to recover and to

retrieve the media from the offsite storage before starting the recover.
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To locate the save set ID of the most recent bootstrap (if you do not already

have this information):

1. Insert the most recent media or clone volume(s) used for scheduled

backups into the appropriate device.

2. At the system console/command prompt, switch to the directory where

the NetWorker binaries and executables are located.

3. If you are using an autochanger, insert the first volume of the bootstrap

save set into the first drive of the autochanger using the following

command:

nsrjb -lnv -S slot -f device-name

where slot is the slot where the first volume is located and device-name is the

pathname for the first drive. You can obtain this device-name using the

inquire command.

4. Use the scanner -B command to determine the save set ID of the most

recent bootstrap on the media: scanner -B device-name. For example:

Windows NT:

scanner -B \\.\Tape0

Solaris:

scanner -B /dev/rmt/0hbn

Linux:

scanner -B /dev/nst0

If you do not locate the save set ID of the most recent bootstrap on the most

recent media, run the scanner -B command on preceding media to locate

the save set ID of the most recent bootstrap.

5. When you see the output, record both the bootstrap save set ID and the

volume label.
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Task 4: Recover the NetWorker Server Bootstrap

This section describes how to recover the NetWorker server bootstrap using

the mmrecov command.

Note: In NetWorker 6.0 and later, the mmrecov command is only used to

recover the NetWorker server’s media database and resource configuration

files; the nsrck command is used to recover the server’s client indexes.

To recover the NetWorker server bootstrap:

1. Use the mmrecov command to recover the NetWorker server’s bootstrap

(media database and resource configuration files). For example:

Windows NT:

D:\Program Files\nsr\bin> mmrecov

The following output appears:

mmrecov: Using madrid.spain.com as server

UNIX:

mmrecov

The following output appears:

mmrecov: Using madrid.spain.com as server

Important: The mmrecov command overwrites the server’s media database. It

does not overwrite the resource configuration files, as mmrecov recovers them

to the resource directory: res.R. For more information, refer to mmrecov
reference pages in the Legato Command Reference Guide for the syntax and

options for this program (refer to your Documentation Suite CD or the Legato

web site www.legato.com under Support/Documentation/Manuals).

2. If the following message appears, enter the name of the device you are

using for the recovery (this message only appears if the server has multiple

devices configured and enabled).

Windows NT:

What is the name of the device you plan on using
[\\.\Tape1]?  \\.\Tape0

UNIX:

What is the name of the device you plan on using
[/dev/rmt/0hbn]?  /dev/rmt/0hbn
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3. When the following message appears, enter the save set ID for the latest

bootstrap. If you are recovering a cloned version of the bootstrap, specify

the save set ID associated with the clone.

Enter the latest bootstrap save set ID []:  20076

4. When the following message appears, enter the file number to begin the

recovery. If unknown, press [Enter].

Enter starting file number (if known) [0]:  130

5. When the following message appears, enter the first record number to

begin the recovery. If unknown, press [Enter].

Enter starting record number (if known) [0]:  0

6. When the following message appears, follow the prompt:

Windows NT:

Please insert the volume on which save set ID 20076 started
into \\.\Tape0. When you have done this, press <RETURN>:

Note: If you ran scanner -B in the previous task, the volume should

already be loaded and you can just press <RETURN>. If the volume is not

loaded, insert it now, then press <RETURN>. The following message

appears:

Scanning \\.\Tape0 for save set 20076; this may take a
while...

UNIX:

Please insert the volume on which save set id 20076 started
into /dev/rmt/0hbn.

Once you have loaded the appropriate volume, the following message

appears:

Scanning /dev/rmt/0hbn for save set 20076; this might take
a while...

NetWorker then scans the volume for the appropriate save set and

recovers it.

Note: You can use the nwadmin program (click the Monitor tab in Windows

NT) to monitor the recovery of the media database and resource configuration

files.
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The NetWorker media database and resource configuration files are

recovered when the following message appears:

If your resource files were lost, they are now recovered
in the ‘res.R’ directory. Copy or move them to the ‘res’
directory, after you have shut down the service. Then
restart the service.

Otherwise, just restart the service.

If the on-line index for the server-name was lost, it can
be recovered using the nsrck command.

Task 5: Rename the NetWorker Server Configuration Files

Because the configuration files cannot be reliably overwritten while

NetWorker is running, mmrecov recovered the res directory as res.R by default.

In addition, mmrecov might have recovered another server’s configuration

file in this directory; stopping and restarting both the NetWorker Remote Exec

and NetWorker Backup and Recover Server services/daemons is

recommended.

To rename the configuration files in Windows NT:

1. Shut down the NetWorker Backup and Recover Server and NetWorker

Remote Exec services:

a. From the Windows NT Control Panel, select Services and select the

NetWorker Backup and Recover Server service.

b. Click Stop.

c. Select the NetWorker Remote Exec service.

d. Click Stop.

e. Click Close.

2. Rename the existing res directory to res.orig.

3. Rename the recovered res directory (res.R) to res.

4. From the Windows NT Control Panel, select Services, restart the

NetWorker Remote Exec service, and then restart the NetWorker Backup

and Recover Server service.

5. After you verify that the NetWorker configurations are correct, remove the

res.orig directory.
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To rename the configuration files in UNIX:

1. Shut down (stop) the daemons by entering the nsr_shutdown command

at the UNIX command prompt:

nsr_shutdown

2. Rename the existing /nsr/res directory to /nsr/res.orig:

mv res res.orig

3. Rename the recovered /nsr/res.R directory to /nsr/res:

mv res.R res

4. Restart NetWorker by first entering the nsrexecd command; then enter the

nsrd command to complete the NetWorker restart:

nsrexecd

nsrd

Note: You can also restart NetWorker by running the NetWorker startup script

for the appropriate platform.

5. After verifying that the NetWorker configurations are correct, remove the

/nsr/res.orig directory.

6. Run the nsrjb -HE command to reset the autochanger.

7. If you are using an autochanger, run the nsrjb -Iv command to

re-inventory the autochanger; or run the nsrjb -Iv -S command to

re-inventory only the affected slots.

Task 6: Recover All Indexes for Clients on the NetWorker Server

Once you recover the server’s media database and resource configuration files,

recover all indexes for clients on the NetWorker server.

To recover all indexes for clients on the NetWorker server:

1. Enter the nsrck -L7 command:

nsrck -L7 client-name

Note: If you do not supply a client name, the indexes of all clients will be

recovered.
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2. If you are using a cloned version of the index, NetWorker may prompt you

to load an original volume (not the clone volume).

To use the clone:

a. Enter a [Ctrl]+[c] to exit out of nsrck and verify that the pending

original volume message has terminated.

b. Delete the records of the original volume(s) using the

nsrmm -d volume-name command. For example:

NetWorker requests the original volume mars.1. Because this volume

is not available, delete the mars.1 volume from the media database

using the following command:

nsrmm -d mars.1

c. Enter the nsrck -L7 command:

nsrck -L7 client-name

Important: Once the media database and server resource configuration files

have been recovered, you may recover the client indexes in any order. It is not

necessary to recover the server’s own client index before recovering the index

of any other client.

If your clients have the NetWorker client installed, you may run on-demand

and scheduled saves once the media database and server resource

configuration files are recovered; however, you will not be able to browse the

saves for a client until you recover the client’s file index. You may use save set

recover to recover files before a client’s file index is recovered.

Task 7: Recover the NetWorker Server’s Client Data

This procedure describes how to recover the remainder of the NetWorker

server’s data, including the registry, using the NetWorker User program

(Windows NT) or the nwrecover program (UNIX).

To recover the NetWorker server data:

1. Log on as Administrator (Windows NT) or as root (UNIX).

2. Load and inventory the devices. This ensures that NetWorker can

recognize the location of each volume.

If you load a clone volume, NetWorker uses the clone volume for the

remainder of the recovery process.
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3. Run the NetWorker User program (Windows NT) or the nwrecover
program (UNIX).

4. Mark all the drives or filesystems, including %SystemDrive% (for example

C:/). Also, mark any operating system specific special backups, such as the

registry (5.5.1 clients) or SYSTEM STATE save set (5.7/6.0 and later

clients).

Important: To avoid having to reboot twice, make sure the SYSTEM STATE

save set is restored last. If you recover all save sets in a single operation,

NetWorker User will restore them in the correct order. If you recover save sets

in multiple NetWorker User operations, recover the SYSTEM STATE save set

last.

The bootstrap and indexes are browsable for NetWorker releases earlier than

6.0. If you are recovering a save set from a NetWorker release earlier than 6.0

and you select for recovery the drive where the NetWorker server nsr directory

is located (by default, %SystemDrive%\Program Files\nsr), be sure to unselect

the following subdirectories of the nsr directory: index, mm, res, bin.

5. Click Start to begin the recovery.

Task 8: Complete the Server Recovery

To complete the server recovery process:

1. Perform a test backup or recover to make sure the server is fully recovered.

2. Verify that the server and its associated clients are included in a scheduled

backup.
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Dynamic Host Configuration Protocol (DHCP) and Windows Internet
Naming Service (WINS) Databases

If you are using Windows NT 4.0 and you are using DHCP or WINS, it is

recommended that you regularly dump these databases and back up the

dumps with the NetWorker software.

Windows NT does not provide a programming interface for backup and

restore of the DHCP database or the WINS database, but you can configure

DHCP and WINS database dumps using DHCP Manager and WINS Manager.

You can back up these database dumps as part of your routine NetWorker

filesystem operations and then restore the dumps with the NetWorker

software if it ever becomes necessary. After restoring the dumps you can

import them, again using DHCP Manager or WINS Manager.

How to Dump, Back Up, Restore, and Import the WINS and DHCP
Databases

To dump, back up, restore, and import the WINS and DHCP databases:

1. To open the DHCP administrative interface, go to

Start>Programs>Administrative Tools>DHCP Manager.

2. To run DHCP dumps as necessary, configure the dumps from DHCP

Manager. A default dump location is provided, but you can specify a

different location. Make a note of the database dump location you choose.

3. To open the WINS administrative interface, go to

Start>Programs>Administrative Tools>WINS Manager.

4. To run WINS dumps as necessary, configure the dumps from WINS

Manager. A default dump location is provided, but you can specify a

different location. Make a note of the database dump location you choose.

5. As part of your routine NetWorker filesystem backups, specify the save

set(s) that include(s) the filesystem locations you specified for the DHCP

and WINS databases dumps. You can then restore a dump whenever it

becomes necessary.

6. To recover a DHCP or WINS database, open DHCP Manager or WINS

Manager and import the database that NetWorker backed up and restored.
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Recovering Client or Storage Node Data
To recover client or storage node data:

• Meet the client or storage node data recovery prerequisites.

• Recover the client or storage node data.

Prerequisites

To recover the client or storage node data, you need the following:

• Version and patch level of NetWorker.

• Location of NetWorker.

• NetWorker ClientPak for your operating system.

• Backup or clone volumes containing the NetWorker client data you wish

to recover.

How to Recover Windows NT 4.0/UNIX Client or Storage Node Data

This section describes how to recover client or storage node data. You can use

this process to recover the client or storage node data either back to the original

computer or to a different computer.

Important: If the NetWorker server has failed, it should be fully recovered and

functional before attempting to recover client or storage node data.

To recover client or storage node data, follow these procedures, explained in

detail in the following sections:

1. Install NetWorker, if necessary.

2. Recover the client or storage node data.

3. Complete the client or storage node data recovery.
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Task 1: Install NetWorker

This section describes how to install NetWorker on a client or storage node.

Before starting this procedure:

• Determine what Legato backup utility software was installed on the

computer prior to the disaster (for example, SmartMedia®, ClientPak®,

NetWorker Module).

• Determine what Legato backup utility patches were installed prior to the

disaster.

• Determine whether the Legato backup utility software or patches are

actually damaged to the point where they need to be reinstalled.

If the client’s or storage node’s NetWorker software is not properly installed

and running:

1. Install the same version of NetWorker, which had been installed on the

computer prior to the disaster, into its original location.

If you want to upgrade the client or storage node software, first recover the

client or storage node to its original state, and then perform the upgrade.

2. Install any NetWorker backup utility patches that were installed prior to

the disaster.

3. From the NetWorker User program (Windows NT) or the nwrecover
program (UNIX), perform a test recovery to ensure that the NetWorker

recovery process is functioning properly.

Task 2: Recover the Client or Storage Node Data

This section describes how to recover the client or storage node data, including

the registry or system state.

Important: (Windows NT) If you receive a message instructing you to reboot

the computer, you must reboot prior to recovering the registry (5.5.1 clients) or

system state (5.7/6.0 and later clients).
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To recover the client or storage node data:

1. To determine the volumes required to recover the client or storage node

data, use the mminfo -avot command on the server.

2. Start the NetWorker User program (Windows NT) or the nwrecover
program (UNIX).

3. Mark all the drives or filesystems and any operating system specific

special backups, such as the registry (5.5.1 clients) or SYSTEM STATE

(5.7/6.0 and later clients).

Note: To avoid having to reboot twice, make sure the SYSTEM STATE save set

is restored last. If you recover all save sets in a single operation, NetWorker

User will restore them in the correct order. If you recover save sets in multiple

NetWorker User operations, recover the SYSTEM STATE save set last.

Note: If you are recovering a NetWorker server, unmark any boot files required

for UNIX operating system recovery that you determined should not be

overwritten. See the “Prerequisites” section for “Recovering the UNIX

Operating System” on page 31 for more information.

4. For Windows NT only, recover the RepairDisk, if required.

Important: In version 5.5.x, NetWorker does not back up user profiles as part

of the %SystemRoot%\profiles directory; rather, it saves this data with the

REGISTRY: saveset. Therefore, the registry must be recovered in its entirety to

recover a user profile.

In NetWorker versions 5.7 and 6.0 and later, the user profile folders are stored

in the save set corresponding to the disk drive on which they are located (for

example, the C:\ save set). Therefore, this save set must be recovered to restore

a user profile.

The top level of user profiles folders is located at

%SystemDrive%\winnt\profiles (Windows NT 4.0).

5. Set the recover options by selecting the Overwrite Existing File from the

Options>Recover Options menu.
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Important: If you did not set the recover options, you must select the

Overwrite Existing File option when the Naming Conflict dialog box appears

during the recovery process. To enable automatic overwriting of files with the

same name, select the Suppress Further Prompting option in the Naming

Conflict dialog box.

6. Select Start.

For Windows NT, files in the Recycle Bin are not password-protected.

When the Password Protection window appears, select Recover>OK to

recover these files.

NetWorker logs the output of the recovery process to the NetWorker logs

directory (networkr.log), which is overwritten each time a recovery is

performed.

7. Reboot the computer. The computer should now be restored to the state

prior to the disaster.

Task 3: Complete the Client or Storage Node Data Recovery

To complete the client or storage node data recovery process:

1. Perform a test recovery using each of the Legato backup utilities

incorporated into your backup solution.

2. Recover your data using the Legato backup utility you used to back up the

data. Refer to the appropriate Administrator’s Guide for details.

For Windows NT only, once you have completed the recovery process:

• If you want to use Active Desktop, install it after you have recovered all

of the computer’s data.

• If the computer is a Backup Domain Controller (BDC), synchronize it

with the Primary Domain Controller (PDC).

• If the computer is a Primary Domain Controller (PDC), synchronize it

with the domain.
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Chapter 4: Windows 2000 Disaster Recovery

This chapter explains how to recover from a disaster on a NetWorker 6.0 and

later client or server host running Windows 2000.

Disaster Recovery Procedures Overview
Following is a brief overview of disaster recovery procedures. These

procedures are explained in detail in subsequent sections in this chapter.

1. Reinstall the operating system, if necessary.

2. Reinstall the NetWorker software, if necessary.

3. If you are using a stand-alone device, configure the device and load the

volume containing the latest bootstrap.

4. If you are using an autochanger, run each of the following commands from

a Windows command prompt:

a. Run the jbconfig command to install the autochanger.

b. Run the nsrjb -HE command to reset the autochanger.

c. Run the nsrjb -Iv -S# command to inventory the backup tape in slot #
containing the latest bootstrap.

d. Run the nsrjb -lnv -S# -f device-name command to load the backup

tape in slot # into the device.

5. If you know the bootstrap save set ID, run the mmrecov command from a

command prompt to recover the media database and resource

configuration files.

If you do not know the bootstrap save set ID, run the

scanner -B device-name command to locate the bootstrap save set ID; then

run the mmrecov command to recover the media database and resource

configuration files.
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6. Stop the NetWorker services.

7. Copy the contents of the res.R directory to the res directory.

8. Restart the NetWorker services.

9. Reset the autochanger.

10. If you are using an autochanger, run the nsrjb -Iv command to

re-inventory the autochanger; or run the nsrjb -Iv -S command to

re-inventory only the affected slots.

11. Run the nsrck -L7 command to recover the indexes.

12. Start NetWorker User.

13. Recover the client data and the client’s SYSTEM save sets.

Entries in the following table point to sections in this chapter that describe

disaster recovery procedures you might need to follow, depending on the

situation.

To recover... See...

Hard drive • “Replacing a Hard Drive” on page 63

Operating system • “Recovering the Windows 2000

Operating System” on page 64

NetWorker server • “Recovering a Windows 2000

NetWorker Server” on page 69

NetWorker client data or

NetWorker storage node data

• “Recovering NetWorker Client Data

or Storage Node Data” on page 85

Filesystem data • NetWorker 6.1 Administrator’s Guide,
Windows Version
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Replacing a Hard Drive
To replace a hard drive:

• Obtain the hard drive information.

• Replace the hard drive.

Obtaining the Hard Drive Information

Go to Start>Programs>Administrative Tools>Computer

Management>Storage>Disk Management to obtain the following information

about the damaged drive:

• Size of the drive

• Size, format, and volume label assigned to each disk partition

After you obtain this information, you can replace the hard drive.

How to Replace a Hard Drive

If a hard drive fails, refer to the hard drive vendor documentation and the

appropriate Microsoft Windows 2000 documentation for instructions on

replacing the drive.

Important: Install a new drive that is the same size as, or larger than, the

original drive. This will ensure that you have enough space to recover all of the

failed drive’s data. A recovery of the SYSTEM save sets (SYSTEM FILES,

SYSTEM DB, and SYSTEM STATE) requires extra disk space for temporary

files that are created during the operation. The operation might require as

much extra space as the total size of the SYSTEM save sets. Before a disaster

recovery, for an estimate of the amount of extra temporary disk space required,

run the mminfo command from a command prompt to check the size of the

SYSTEM save sets that are to be restored. (In many situations, about 500 MB of

extra disk space should be sufficient to restore the SYSTEM save sets.) After the

restore is complete and the computer is rebooted, the space used by the

temporary files is reclaimed by the operating system.
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To begin the recovery process, recover:

• The operating system, if necessary. See “Recovering the Windows 2000

Operating System” on page 64 for details.

• The NetWorker server, if necessary. See “Recovering a Windows 2000

NetWorker Server” on page 69 for details.

• Any client or storage node data, if necessary. See “Recovering NetWorker

Client Data or Storage Node Data” on page 85 for details.

• The data on the hard drive. For details, refer to the NetWorker 6.1
Administrator’s Guide, Windows Version.

Recovering the Windows 2000 Operating System
Before you recover the operating system, satisfy the prerequisites described in

the following section.

Prerequisites

To recover the operating system, you need the following information about the

state of the computer immediately prior to the disaster:

• Operating system version and all previously applied patches, service

packs, and option packs

• TCP/IP properties:

– IP address

– Default gateway

– Subnet mask

– DNS server

• Host properties

– Computer name (also called the hostname)

– Full domain name

– Administrator name and password

• Date/time properties

• Virtual memory settings

• Protocols installed
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How to Perform Multiple Disaster Recoveries

If you are performing multiple disaster recoveries (more than one computer),

you must recover each computer in the following order:

1. The NetWorker server component. See “Recover a Windows 2000

NetWorker Server” on page 70 for instructions.

2. The NetWorker storage node component.

If the backup device used by the NetWorker server is a storage node, you

might have to restore the storage node partially before attempting to

recover the NetWorker server.

For information about storage node recovery, see “How to Recover a

Windows 2000 NetWorker Client or Storage Node” on page 85.

3. The NetWorker client component. See“How to Recover a Windows 2000

NetWorker Client or Storage Node” on page 85 for instructions.

If you are performing a disaster recovery for a NetWorker 5.7 (or later)

client host running Windows 2000 in an MSCS environment, see

“Chapter 10: Sun Cluster Disaster Recovery” on page 153 for more

information.

How to Recover the Windows 2000 Operating System

You can recover the Windows 2000 operating system to the original computer

or to a different computer.

You can recover the operating system by performing either:

• A complete installation and configuration.

— or —

• A partial installation and configuration. In this case, you install and

configure only those files that enable the computer to communicate over

the network. Then you recover the remaining operating system and

configuration files using NetWorker.

Performing a Partial Installation

To recover the operating system by performing a partial installation:

1. Install and configure the operating system.

2. Test the operating system and configure the devices.

These procedures are explained in detail in the following sections.
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Task 1: Install the Operating System

To install the operating system:

1. Install the same Windows 2000 version, service pack, and patches that

were in use immediately prior to the disaster. Install these to the same path

location that was used before. Refer to the operating system

documentation for details.

2. Install the computer into a workgroup, not into a domain. If the computer

being recovered was previously a domain controller or a member of a

domain, it will be restored to the correct domain when the recovery is

complete.

3. Configure the computer host properties as they were configured before,

with the same computer name, fully qualified domain name,

administrator name, and password. (The fully qualified domain name for

a computer named kingdome, for example, might be

kingdome.seattle.washington.com.)

a. On the Desktop, right-click My Computer and select Properties on

the context menu.The System Properties dialog box appears.

(Another way to reach the System Properties dialog box is to select

Start>Settings>Control Panel and click on the System icon.)

b. In the System Properties dialog box, select the Network Identification

tab.

c. In the Network Identification dialog box, click the Properties button.

d. In the Identification Changes dialog box, click the More button.

e. In the DNS Suffix and NetBIOS Computer Name dialog box, ensure

that the field labeled “Primary DNS suffix of this computer” contains

your domain name. If not, enter your domain name in this field.

4. Configure the TCP/IP properties as they were configured before, with the

same hostname (domain name), IP address, default gateway, subnet mask,

and DNS server.

To see the TCP/IP property values, enter ipconfig /all at the command

line.
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5. Ensure that the hosts file (%SystemRoot%\system32\drivers\etc\hosts)

includes an entry with the IP address and computer name of the

NetWorker server to be used in the recovery. NetWorker requires this

entry when:

• DNS is not in use or no DNS server is available

• The NetWorker server host in a recovery operation is also a DNS

server

In either case, the entry in the hosts file should include the IP address, then

the fully qualified domain name, and then the computer name, all on the

same line, as in the following example:

123.56.890.474 charon.pluto.legato.com charon

Important: If you are recovering the operating system to a different computer,

you must:

— Use the same hostname for the new computer. If you do not use the same

hostname, you will not be able to recover the data saved by the NetWorker

server under the original hostname.

— Assign the same TCP/IP address for the new computer; otherwise the

computer will be assigned a new host ID by NetWorker. If this computer does

not have the same TCP/IP address as the original computer, you must

re-register the NetWorker software. Refer to the Legato NetWorker 6.1
Installation Guide, Windows Version for details.

6. Configure the Date/Time Properties as they were configured before.

7. Restart the computer after installing the operating system.

8. Reset the Virtual Memory Settings as they were configured before by

selecting Control Panel>System>Advanced>Performance

options>Virtual Memory>Change.

9. If you had any additional Windows 2000 components installed through

Windows 2000 Setup, such as Gateway Services for NetWare, install them

before recovering the computer data.
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Task 2: Test the Operating System and Configure the Devices

To test the operating system and configure the devices:

1. Configure any devices required by NetWorker, for example SCSI passthru

devices for autochangers.

2. Disable RSM on any removable storage library (robotic changer or

stand-alone drive) connected to the computer you are recovering.

a. On the Windows desktop, right click My Computer and select

Manage from the pop-up menu.

b. On the Computer Management navigation pane (left side of the

dialog box), expand Storage\Removable Storage\Physical Locations.

c. Right-click the library name and select Properties from the pop-up

menu.

d. On the General tab of the Properties dialog box, ensure that the

Enable Library check box is cleared.

e. Click OK to apply any changes and close the Computer Management

dialog box.

f. Repeat step b through step e for each removable storage library

connected to your NetWorker server.

3. Verify that:

• Operating system is functioning properly.

• Network protocols are functioning properly. Test by running ping.

• Name to Address resolution is correct. Test by running nslookup
using the fully qualified domain name of the Windows 2000

NetWorker backup server, client, or storage node.

• Necessary devices are recognized by the operating system. If the

devices are not recognized, you might need to:

– Load the SCSI driver.

– Install the device driver software.

To complete the recovery process, recover:

• The NetWorker server (if the host being recovered was acting as a

NetWorker server). See “Recovering a Windows 2000 NetWorker Server”

on page 69 for details.

• Any clients or storage nodes, if necessary. See “Recovering NetWorker

Client Data or Storage Node Data” on page 85 for details.

• The data.

After you recover the host’s data, install Active Directory if you want to use it.
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Recovering a Windows 2000 NetWorker Server

Important: If the computer that failed was a NetWorker server host, you will

need to recover the state of the server prior to the failure.

To recover a NetWorker server:

1. Satisfy the NetWorker server recovery prerequisites.

2. Recover the NetWorker server.

These procedures are explained in detail in the following sections.

Prerequisites

To recover a NetWorker server, you need the following information:

• Version and patch level of NetWorker that was in use when the node

failed.

• Backup or clone volumes containing the NetWorker server bootstrap,

which contains the following three items:

– NetWorker server media database

– NetWorker server configuration files

– Backup or clone volumes containing the NetWorker server and client

indexes

Important: Before you continue with the following procedure to recover a

NetWorker server, ensure that you understand the instructions in the

NetWorker 6.1 Administrator’s Guide, Windows Version regarding the proper way

to restore the NetWorker SYSTEM save sets.
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How to Recover a Windows 2000 NetWorker Server

You can recover the NetWorker server to the original computer or to a different

computer.

Important: If your Windows 2000 NetWorker server was also being used as a

Legato License Manager server (not recommended) and a disaster recovery is

required on the NetWorker server, the lictype.res file of the Legato License

Manager is not restored. This is because the Legato License Manager files and

directories are not considered part of NetWorker. After completing the

disaster recovery on the NetWorker server, you must explicitly recover the

Legato License Manager as a client of the NetWorker server.

To recover a NetWorker server, follow these main procedures, explained in

detail in the following sections:

1. Install NetWorker.

2. Configure NetWorker.

3. Locate the server’s bootstrap save set ID.

4. Recover the NetWorker bootstrap. Use clone volumes to recover the server

bootstrap, if necessary.

5. Rename the NetWorker server configuration files.

6. Recover all indexes for the clients of the NetWorker server. (Because a

NetWorker server is always a client of itself, this includes recovering the

client indexes that are associated with the server.)

7. Recover the NetWorker server data.

8. Complete the server recovery.

9. Verify the NetWorker server recovery.
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Task 1: Install NetWorker

Important: If you upgraded directly from Windows NT NetWorker 5.7 to

Windows NT NetWorker 6.0 and later and you have not yet performed a

scheduled backup of the NetWorker server since the upgrade, you must

reinstall Windows NT NetWorker 5.7 and use it to recover the bootstrap before

proceeding. Once you have recovered the bootstrap using the previously

installed version of NetWorker, reinstall NetWorker 6.x and proceed as

normal. This additional step applies only to Windows NT NetWorker 5.7

bootstraps.

To install NetWorker:

1. Install the same release of NetWorker that was used previously to its

original location. Refer to the NetWorker 6.1 Installation Guide, Windows
Version for instructions.

• If the NetWorker installation kit is available on a shared drive on the

network, you can install NetWorker over the network.

• If you want to upgrade the NetWorker server, first recover the server

to its original state, and then perform the upgrade.

• You do not need to reload the license enablers if the NetWorker

configuration files still exist. By default the configuration files are

located in the %SystemDrive%\Program Files\nsr\res directory.

2. Install any NetWorker patches that were in use prior to the disaster.

Task 2: Configure NetWorker

To configure NetWorker:

1. From NetWorker Administrator, check the settings in the Preferences tab

of the NetWorker server’s client resource. Verify that the computer’s

aliases are entered correctly. The settings might look something like the

following:

aliases:kingdome

kingdome.seattle.washington.com

2. Configure the Device resources to have the same settings as those being

recovered. Do not mount or relabel the volumes loaded on the new

devices.
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If you want to recover your data using an autochanger:

a. Add and configure the autochanger using the jbconfig command or

the auto-detection feature in NetWorker Administrator. Refer to the

Legato Command Reference Guide for information about using jbconfig;

refer to the NetWorker 6.1 Administrator’s Guide, Windows Version and

NetWorker Administrator Online Help for details on using

auto-detection.

b. Run the command nsrjb -vHE from a Windows command prompt.

This command resets the autochanger, ejects backup volumes,

re-initializes the element status, and checks each slot for a volume.

If your autochanger does not support the -E option to the nsrjb
command (to re-initialize the element status), initialize the element

status using sjiielm. For information about the nsrjb -E option and

the sjiielm command, refer to the Legato Command Reference Guide.

c. If you need to determine which volume contains the bootstrap,

inventory the autochanger using the nsrjb -Iv command. If you know

the slot number where the bootstrap is located, use the

nsrjb -Iv -S slot-number command to inventory that particular slot.

d. If the device to be used by the NetWorker server is a storage node,

refer to the NetWorker 6.1 Installation Guide, Windows Version for

details on configuring a storage node device.

3. Configure the Client resource associated with the server.

Set the browse and retention policies to a time value that covers the oldest

backup from which you are recovering. The browse policy is set to one

month by default. This will enable you to recover all of the server’s records

using mmrecov.

Important: If you do not reset the browse and retention policies, all of the

server’s records will be recovered. However, any records that are more than

one month old will be discarded because the browse policy is one month by

default.

4. If you are recovering a relocated server’s file index from a NetWorker 6.0

or later version backup, this step is no longer necessary.
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If you are recovering the server’s file index from a NetWorker pre-6.x

version backup and you moved the server’s file index path to a new

location:

a. Edit the Index Path attribute in the server’s associated Client resource

to the original path.

b. Restart the NetWorker services. This will enable NetWorker to

recognize that the index path has changed.

Task 3: Locate the Server’s Bootstrap Save Set ID

If you already know the bootstrap save set ID, skip this task and go to “Task 4:

Recover the NetWorker Server Bootstrap” on page 74.

The bootstrap contains the server’s media index and resource configuration

files. This data is needed to re-create your NetWorker server in the event of a

disaster. For more information about the bootstrap, see “Preparing for

Disaster” on page 21.

There are two ways to locate the save set ID of the most recent bootstrap:

1. The fastest way to determine the bootstrap save set ID is to find it in the

savegrp.log file (printed or e-mailed) for the group that includes the

NetWorker server.

By default, NetWorker automatically creates a bootstrap save set after each

scheduled backup and sends a copy to the default printer. You can also

configure NetWorker to e-mail a copy of the bootstrap after a scheduled

backup. If the bootstrap is neither printed nor e-mailed, NetWorker also

writes the bootstrap information to the end of the savegrp.log file that is

created for that particular backup.

The following example lines from a savegrp.log file show a bootstrap save

set ID of 565435905:

May 16 13:47:52 wayout.legato.com: * wayout.legato.com:bootstrap
May 16 13:47 2000 wayout.legato.com bootstrap information Page 1

May 16 13:47:52 wayout.legato.com: * wayout.legato.com:bootstrap

date time level ssid file record volume

May 16 13:47:52 wayout.legato.com: * wayout.legato.com:bootstrap
05/16/00 13:47:26 full 565435905  4 0 wayout.legato.com.001
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2. If the bootstrap information is not available from any of these sources, you

can use NetWorker’s scanner command (which might be somewhat

time-consuming) to locate the bootstrap save set ID, as follows:

a. Insert the media or clone volumes from the most recent scheduled

backups into the appropriate device. (Do not use NetWorker to insert

the media; NetWorker does not currently have the necessary

information to recognize the media).

Do not mount the new devices created in “Task 2: Configure

NetWorker” on page 71.

b. Restart the NetWorker server services.

c. If you are using an autochanger, insert the first volume of the

bootstrap save set into the first drive of the autochanger using the

following command:

nsrjb -lnv -S slot -f device-name

where slot is the slot where the first volume is located and

device-name is the pathname for the first drive. You can obtain this

device-name using the inquire command.

d. Run the scanner -B command to determine the save set ID of the

most recent bootstrap on the media volume. For example:

scanner -B \\.\Tape0

If you do not locate the save set ID of the most recent bootstrap on the

media volumes used for the most recent scheduled backup, run the

scanner -B command on the media volumes from the next most

recent scheduled backup to locate the save set ID of the most recent

bootstrap.

Task 4: Recover the NetWorker Server Bootstrap

This section describes how to recover the NetWorker server bootstrap using

the mmrecov command. By default, the NetWorker server bootstrap files

reside in the mm and res subdirectories of the nsr directory, which by default is

installed at %SystemDrive%\Program Files\nsr.

In NetWorker 6.x, the mmrecov command is used only to recover the

NetWorker server's media database and resource configuration files; the nsrck
command is used to recover the server's client indexes (including those of the

server). The mmrecov command will overwrite the server's existing online

media indices. Refer to the mmrecov and nsrck reference pages in the Legato
Command Reference Guide for details.
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Important: If you upgraded directly from Windows NT NetWorker 5.7 to

Windows NT NetWorker 6.0 and later and you have not yet performed a

scheduled backup of the NetWorker server since the upgrade, you must

reinstall Windows NT NetWorker 5.7 and use it to recover the bootstrap before

proceeding. Once you have recovered the bootstrap using the previously

installed version of NetWorker, reinstall NetWorker 6.x and proceed as

normal. This additional step applies only to Windows NT NetWorker 5.7

bootstraps.

To recover the NetWorker server bootstrap:

1. If you ran the scanner command in the previous task, skip this step and go

to step 2. If you did not run scanner, insert the backup media or clone

volumes that contain the most recent backup named “bootstrap” into the

storage device. Do not mount the new devices created in “Task 2:

Configure NetWorker” on page 71.

If you are using an autochanger, insert the first volume of the bootstrap

save set into the first drive of the autochanger, using the following

command:

nsrjb -nlv -S slot -f device-name

where slot is the slot where the first volume is located and device-name is the

pathname for the first drive. (Another way to do this is to use the

NetWorker Administrator Autochanger option. From NetWorker

Administrator, select Configure>Autochanger>Operations.)

Important: If you are using clone volumes and do not have all of these

volumes loaded, mmrecov will request the original volumes. You will need to

remove the original volumes from the database because the original volumes

are not available.

2. Use the mmrecov command to recover the NetWorker server’s bootstrap.

The following output appears:

mmrecov: Using madrid.spain.com as server
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Important: The mmrecov command will overwrite the server’s existing online

file and media indexes. The mmrecov command does not recover the

NetWorker clients’ online indexes. These indexes are recovered through

regular recovery procedures. Refer to the mmrecov and nsr_crash reference

pages in the Legato Command Reference Guide for details.

3. When the following message appears, enter the name of the device you are

using for the recovery (this message only appears if the server has

multiple devices configured and enabled):

What is the name of the device you plan on using
[\\.\Tape1]?  \\.\Tape0

4. When the following message appears, enter the save set ID for the latest

bootstrap. If you are recovering a cloned version of the bootstrap, specify

the save set ID associated with the clone.

Enter the latest bootstrap save set ID:  20076

5. When the following message appears, enter the file number to begin the

recovery. If unknown, enter zero.

Enter starting file number (if known) [0]:  130

6. When the following message appears, enter the first record number to

begin the recovery. If unknown, enter zero.

Enter starting record number (if known) [0]:  0

7. When the following message appears, ensure that the volume containing

the associated save set ID has been inserted into the backup device, for

example:

Please insert the volume on which save set ID 20076 started
into \\.\Tape0. When you have done this, press <RETURN>:

8. Once you have loaded the appropriate volume, the following message

appears:

Scanning \\.\Tape0 for save set 20076; this may take a
while...

The NetWorker software then scans the volume for the appropriate save

set. Once the save set has been located, the NetWorker software recovers

it. The NetWorker software uses nsrmmdbasm to recover the media
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database and uasm to recover the NetWorker resource configuration files.

You can use NetWorker Administrator to monitor the recovery of the

server’s media database and resource configuration files.

Important: The server media database might not be on the same volume as the

resource configuration files. If this is the case, the NetWorker software will

prompt you if additional media is required.

Task 5: Rename the NetWorker Server Configuration Files

Because the configuration files cannot be reliably overwritten while

NetWorker is running, mmrecov recovered the %SystemDrive%\Program
Files\nsr\res directory as %SystemDrive%\Program Files\nsr\res.R by default.

In addition, mmrecov may have recovered another server’s configuration file

in this directory; stopping and restarting the NetWorker Power Monitor,

NetWorker Backup and Recover, and NetWorker Remote Exec services is

recommended.

Before renaming the NetWorker server configuration files, you must shut

down the three NetWorker services in the following order:

• NetWorker Power Monitor

• NetWorker Backup and Recover

• NetWorker Remote Exec

To shut down the three NetWorker services, follow this procedure for each of

the services (in the order listed above):

1. Select the NetWorker service from the Windows 2000 menu by selecting

Start>Programs>Administrative Tools>Services.

2. Right-click the service.

3. Select Stop from the menu.

4. Before proceeding, wait for the service to shut down completely.
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Once you have shut down all three NetWorker services in the proper order,

rename the NetWorker server configuration files. To rename the NetWorker

server configuration files:

1. Rename the existing %SystemDrive%\Program Files\nsr\res directory to

%SystemDrive%\Program Files\nsr\Res.orig.

2. Rename the recovered %SystemDrive%\Program Files\res.R directory to

%SystemDrive%\Program Files\nsr\res.

After you rename the NetWorker server configuration files, you must start the

three NetWorker services in the following order:

• NetWorker Remote Exec

• NetWorker Backup and Recover

• NetWorker Power Monitor

To start the three NetWorker services, follow this procedure for each of the

services (in the order listed above):

1. Select the NetWorker service from the Windows 2000 menu by selecting

Start>Programs>Administrative Tools>Services.

2. Right-click the service.

3. Select Start from the menu.

4. Before proceeding, wait for the service to start completely.

Once you have started all three NetWorker services in the proper order, verify

that the NetWorker configurations are correct and then remove the res.orig
directory.
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Task 6: Reset and Inventory Your Autochanger

If you are using an Autochanger, perform you need to perform a reset and

inventory the contents.

1. Run the command nsrjb -vHE from a Windows command prompt. This

command resets the autochanger, ejects backup volumes, re-initializes the

element status, and checks each slot for a volume.

If your autochanger does not support the -E option to the nsrjb command

(to re-initialize the element status), initialize the element status using

sjiielm. For information about the nsrjb -E option and the sjiielm
command, refer to the Legato Command Reference Guide.

2. Run the nsrjb -Iv command from a Windows command prompt to

inventory the autochanger; or run the nsrjb -Iv -S command to inventory

only the affected slots.

Task 7: Recover All Indexes for Clients on the NetWorker Server

After you recover the server’s media database and resource configuration files,

you may recover the client indexes in any order. It is not necessary to recover

the server’s own client index before recovering the index of any other client.

Important: If your clients have the NetWorker client installed, you may run

manual and scheduled backups after the media database and server resource

configuration files are recovered; however, you will not be able to browse the

backups for a client until you recover the client’s file index. You may use save

set recover to recover files before a client’s file index is recovered.

To recover all indexes for clients on the NetWorker server:

1. At a Windows command prompt, enter the nsrck -L7 command:

nsrck -L7 client-name

Note: If you do not supply a client name, the indexes of all clients will be

recovered.
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2. If you are using a cloned version of the index, the NetWorker software

may prompt you to load an original volume (not the clone volume).

a. Enter [Ctrl]+[c] to exit nsrck and verify that the pending original

volume message has terminated.

b. Delete the records of the original volume(s) using the

nsrmm -d volume-name command. For example:

The NetWorker software requests the original volume mars.1. Because

this volume is not available, delete the mars.1 volume from the media

database using the following command:

nsrmm -d mars.1

c. Restart the NetWorker server services.

d. At a Windows command prompt, enter the nsrck -L7 command:

nsrck -L7 client-name

Task 8: Recover the NetWorker Server Data

Important: If you routinely move your NetWorker backup media to an off-site

location for safekeeping and a subsequent file recover operation generates a

mount request, the recover will wait until an operator satisfies the mount

request. To avoid delays when recovering files, use the mminfo -mv command

to list the media volume that is associated with the file you want to recover and

retrieve the media from the off-site storage before starting the recover.

To recover the remainder of the NetWorker server data, including the client

indexes, follow these steps:

1. Log on to Windows 2000 with local administrator privileges. To recover

the SYSTEM save sets, you must be logged on to the computer being restored
with local administrator privileges. Directed recovery of the SYSTEM save

sets is not supported in this release.

2. If you are using an autochanger, inventory it. This will ensure that

NetWorker can recognize the location of each volume.
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Important: After the media database and server resource configuration files

have been recovered, you may recover the client indexes in any order. It is not

necessary to recover the server’s own client index before recovering the index

of any other client.

If your clients have the NetWorker client installed, you may run on-demand

and scheduled saves once the media database and server resource

configuration files are recovered; however, you will not be able to browse the

saves for a client until you recover the client’s file index. You may use save set

recover to recover files before a client’s file index is recovered.

3. If you load a clone volume, the NetWorker software will use the clone

volume for the remainder of the recovery process if either of the following

is true:

• The original volume was not added back into the media database.

• The original volume was added back into the media database, but it

was not placed in an autochanger and inventoried.

However, if the original volume was added back into the media database,

placed in an autochanger and inventoried, the NetWorker software will

prompt you to mount the original volume.

4. Ensure that all drive letters that contained system information prior to the

node failure are accessible. The system information includes the boot

partition, system partition, and the partition that contains the databases

and database logs for the system state components.

5. Start NetWorker User.

6. Click the Recover speedbar button to open the Recover window.

NetWorker displays the associated computer’s directory structure in the

Recover window.

7. Select and mark all applicable drives for recovery (for example, C:\). Make

sure the NetWorker directory is included (the default path is

%SystemDrive%\Program Files\nsr). Also mark the SYSTEM save sets

(SYSTEM FILES, SYSTEM DB, and SYSTEM STATE) for recovery. For

details regarding these save sets, refer to the section on using NetWorker

with Windows 2000 in the NetWorker 6.1 Administrator’s Guide, Windows
Version.
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Important: To avoid having to reboot twice, make sure the SYSTEM STATE

save set is restored last. If you recover all save sets in a single operation,

NetWorker User will restore them in the correct order. If you recover save sets

in multiple NetWorker User operations, recover the SYSTEM STATE save set

last.

The bootstrap and indexes are browsable for NetWorker releases earlier than

6.0. If you are recovering a save set from a NetWorker release earlier than 6.0

and you select for recovery the drive where the NetWorker server nsr directory

is located (by default, %SystemDrive%\Program Files\nsr), be sure to unselect

the following subdirectories of the nsr directory: index, mm, res, bin.

8. Set the recover options by selecting the Overwrite Existing File radio

button from the Options>Recover Options menu.

Important: If you did not set the recover options, you will need to select the

Overwrite Existing File option when the Naming Conflict dialog box appears

during the recovery process. To enable automatic overwriting of files with the

same name, select the Suppress Further Prompting option in the Naming

Conflict dialog box.

9. Click the Start speedbar button to begin the recovery.

Task 9: Complete the NetWorker Server Recovery

After the recovery operation is complete, follow these steps to finish the

process:

1. Check the %SystemDrive%\Program Files\nsr\logs\networker.log file to

verify that no errors were generated during the recover sessions. If errors

are found, you may need to rerun the recover once the cause of the errors

has been addressed.

2. Restart the computer and verify that the NetWorker Backup and Recover

Server, NetWorker Power Monitor, and NetWorker Remote Exec services

have started.
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Important: After recovery of the NetWorker server, the operating system must

be rebooted. The reboot operation provides for the complete restoration of the

system protected files and restarting of services which were automatically

stopped prior to recovery.

Task 10: Verify the NetWorker Server Recovery

To verify the NetWorker server recovery:

1. Verify that all services related to the Windows 2000 system state that were

previously installed have been restarted. You can use Event Log Viewer to

check for service-startup errors. Refer to the sections on preparing to

recover the SYSTEM save sets in the NetWorker 6.1 Administrator’s Guide,
Windows Version for a list of these services.

2. Use the Event Viewer to examine the event log for the Windows protected

files to verify that there are no errors regarding replacing files.

3. If the NetWorker server was previously configured as a domain controller,

verify that the drives configured to store the Active Directory database

and log files have been recovered.

4. Verify that any applications which were running prior to the disaster, such

as Microsoft Office, have been properly restored by restarting the

applications and viewing previously saved documents.

5. Perform a test backup or restore to ensure that the server is fully

recovered.

6. Verify that the server and its associated clients are included in a scheduled

backup.
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Dynamic Host Configuration Protocol (DHCP)
and Windows Internet Naming Service (WINS) Databases

Windows 2000 does not provide a programming interface for backup and

restore of the DHCP database or the WINS database. However, you can

configure and automate DHCP and WINS database dumps using Windows

2000 administrative tools, back up and restore the database dumps as part of

your routine NetWorker filesystem operations, and finally import the

databases using the same Windows 2000 administrative tools you used to

configure the dumps.

If you are using DHCP or WINS, you can dump, back up, restore, and import

these databases as follows:

1. To open the DHCP administrative console, go to

Start>Programs>Administrative Tools>DHCP.

2. Configure and automate DHCP database dumps from the DHCP

administrative console. A default dump location is provided, but you can

specify a different location. Make a note of the database dump location

you choose.

3. To open the WINS administrative console, go to

Start>Programs>Administrative Tools>WINS.

4. Configure and automate WINS database dumps from the WINS

administrative console. A default dump location is provided, but you can

specify a different location. Make a note of the database dump location

you choose.

5. As part of your routine NetWorker filesystem backups, specify the save

set(s) that include(s) the filesystem locations you specified for the DHCP

and WINS databases dumps.

6. To recover a DHCP or WINS database, open the corresponding

administrative console and import the database that NetWorker backed

up and restored.
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Recovering NetWorker Client Data or Storage Node Data
You can recover the NetWorker client or NetWorker storage node data to the

original computer or to a different computer. Recovering client data or storage

node data involves the following main procedures:

1. Satisfy the NetWorker client or storage node data recovery prerequisites.

2. Reinstall NetWorker, if necessary.

3. Recover the NetWorker client or storage node data.

4. Complete the NetWorker client or storage node recovery.

These procedures are explained in detail in the following sections.

Prerequisites

To recover the client or storage node software, you need:

• The same release and patch level of the NetWorker software that was in

use before the disaster.

• The location where the NetWorker software was originally installed. By

default, NetWorker is installed in the %SystemDrive%\Program Files\nsr
directory.

How to Recover a Windows 2000 NetWorker Client or Storage Node

To recover a Windows 2000 NetWorker client or NetWorker storage node,

perform the following tasks:

Task 1: Install NetWorker

If the NetWorker software on the NetWorker client host or NetWorker storage

node is not properly installed and running, you must reinstall NetWorker.

Before reinstalling the NetWorker software on a NetWorker client or

NetWorker storage node, identify the Legato products (and associated

patches, if applicable) that were installed before the disaster (such as

SmartMedia, ClientPak, and NetWorker Modules).
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Reinstall any Legato backup software and patches that are unusable or appear

to be damaged, as follows, and by referring to the product Installation Guide as

necessary:

1. Install the same version of the NetWorker software to the same location it

occupied before the disaster.

• If the NetWorker installation kit is available on a shared drive on the

network, you can install the NetWorker software over the network.

• If you want to upgrade the NetWorker client or NetWorker storage

node software, first recover the NetWorker client or NetWorker

storage node to its original state, and then perform the upgrade.

2. Install any NetWorker patches that had been installed prior to the disaster.

3. Install the temporary enabler code for each Legato backup product. You

can find the temporary enabler code in the Installation Guide for each

product.

4. If you are restoring a NetWorker storage node, make sure that the storage

node system can see the local devices that the NetWorker server will use

the storage node devices.

Refer to the NetWorker 6.1 Administrator’s Guide, Windows Version for

instructions on configuring a stand-alone or autochanger storage node.

5. From NetWorker User, perform a test recovery to ensure the NetWorker

recovery process is functioning properly.

Task 2: Recover the NetWorker Client or NetWorker Storage Node Data

Before continuing with the following procedure, be sure you understand the

information in the NetWorker 6.1 Administrator’s Guide, Windows Version about

the proper way to restore the NetWorker SYSTEM save sets.

If the NetWorker server has failed, it should be fully recovered and functional

before you attempt to recover associated NetWorker client data or NetWorker

storage node data. If the backup device used by the NetWorker server is a

storage node, you might have to restore the storage node partially before

attempting to recover the NetWorker server.
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To recover NetWorker client or NetWorker storage node data:

1. Open NetWorker User. Click the Recover button on the toolbar.

2. In the NetWorker User Recover window, mark each of the following for

recovery:

• All local physical drives

• The SYSTEM save sets: SYSTEM STATE, SYSTEM FILES, and

SYSTEM DB

Note: To avoid having to reboot twice, make sure the SYSTEM STATE save

set is restored last. If you recover all save sets in a single operation,

NetWorker User will restore them in the correct order. If you recover save

sets in multiple NetWorker User operations, recover the SYSTEM STATE

save set last.

Important: The NetWorker software stores the user profiles folders in the save

set corresponding to the disk drive on which they are located (for example, the

C:\ save set). Therefore, this save set must be recovered to restore a user

profile.

The top level of user profiles folders is located at %SystemDrive%\Documents
and Settings.

3. In the Options>Recover Options dialog box, select Overwrite Existing

File. (If you do not set the recover options, you will need to select the

Overwrite Existing File option when the Naming Conflict dialog box

appears during the recovery process. To enable automatic overwriting of

files with the same name, select the Suppress Further Prompting option in

the Naming Conflict dialog box.)

4. Click Start.

5. When the Password Protection window appears, you can select

Recover>OK to recover these files. Files in the Recycle Bin are not

password-protected.

6. The NetWorker software logs information about the recovery process to

%SystemDrive%\networkr.log. This log is overwritten each time a recovery

is performed. Check the log file to verify that no errors messages were

generated during the recover sessions. If there are error messages in the

log file, you might need to run the recovery again after addressing the

source of the errors.
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7. Reboot the computer. The computer should now be recovered to the state

prior to the disaster.

8. After the data is recovered, you might have extra files that were recovered

from open files. You can locate these files by searching for *.*.a* (for

example, nsrexecd.exe.a1001789) and then delete them.

Important: For information about backup and recovery procedures for

terminal services licensing, refer to the NetWorker 6.1 Administrator’s Guide,
Windows Version.

Task 3: Complete the NetWorker Client or Storage Node Recovery

To complete the NetWorker client or NetWorker storage node recovery:

1. Perform a test recovery using each of the Legato backup products you are

using.

2. Recover your data using the Legato product you used to back up the data.

Refer to the appropriate Administrator’s Guide for details.

3. Verify that all services related to the Windows 2000 system state that were

previously installed have been restarted. You can use Event Log Viewer to

check for service-startup errors. Refer to the sections on preparing to

recover the SYSTEM save sets in the NetWorker 6.1 Administrator’s Guide,
Windows Version for a list of these services.

4. Verify that all devices previously managed by the Removable Storage

Manager are visible to the operating system.

5. Ensure that the storage devices to be used by the NetWorker server can be

detected by the storage node.

6. Use the Event Viewer to examine the event log for the Windows-protected

files to verify that there are no errors regarding replacing files.

7. If either the NetWorker client or NetWorker storage node was previously

configured as a domain controller, verify that the drives configured to

store the Active Directory database and log files have been recovered.
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8. Verify that any applications which were running prior to the disaster, such

as Microsoft Office, have been properly restored. You can verify this by

restarting the applications and viewing previously saved documents.

9. Perform a test backup or restore to the NetWorker server to ensure that the

connection between the NetWorker client or NetWorker storage node and

the NetWorker server is working properly.

After you complete the entire recovery, install Active Directory if you want to

use it.
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Chapter 5: NetWare Disaster Recovery

This chapter provides instructions on how to perform a disaster recovery on a

NetWare system using the NetWorker software. It also describes the

prerequisites for recovering the hardware, operating system, and software.

All of the utilities referenced in this chapter are NetWare console utilities.

The set of instructions you need to follow depends upon the extent of the

damage caused by the disaster. Refer to the following list of disaster recovery

scenarios to determine which set of instructions apply to your situation.

To recover... See...

Hard drive • “Replacing a Hard Drive” on page 92

Operating system, single-server,

with or without NDS

• “Recovering the NetWare Operating

System” on page 94

NetWorker server • “Recovering a NetWare NetWorker

Server” on page 97

Operating system, replicated NDS

partition, multiserver NDS

• “Recovering a Replicated NDS

Partition” on page 105
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Replacing a Hard Drive
To replace a hard drive:

• Obtain the hard drive information.

• Replace the hard drive.

Obtaining the Hard Drive Information

Obtain the following information about each drive:

• Size of the drive

• Size, format, and volume label assigned to each drive partition

• NetWare Directory Services (NDS), the NDS tree topology, and the

location of server objects, partitions and replicas, and bindery context

settings

You can obtain information about each drive using:

• install (or nwconfig on NetWare 5.0). This server utility provides

information about each hard drive including each volume segment on the

drive.

• netadmin (DOS) or nwadmn (Windows). These NetWorker server

utilities provide information about each server object, such as name and

location.

• dsrepair. This server utility enables you to perform a check on each

partition and replica.

• autoexec.ncf. This file contains the bindery context settings.

• ndir. This workstation utility provides information about each volume,

directory, and file on the disk.

After you obtain this information, you can replace the hard drive.
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How to Replace a Hard Drive

If you are experiencing the failure of one or more hard drives, refer to the

appropriate NetWare documentation and the appropriate hard drive vendor

documentation for detailed instructions on how to replace your hard drives.

Important: Install a new drive that is the same size or larger than the original

drive. This will ensure that you can recover all of the drive’s data.

Important: Do not delete any volume objects from the NDS tree. This would

eliminate any references that other objects might have to a particular volume.

To begin the recovery process, recover:

• The operating system. See “Recovering the NetWare Operating

System” on page 94 for details.

• The NetWorker server, if necessary. See “Recovering a NetWare

NetWorker Server” on page 97 for details.

• The computer’s data using NetWorker. Refer to the NetWorker
Administrator’s Guide, NetWare Version or details.
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Recovering the NetWare Operating System
To recover the operating system:

• Meet the operating system recovery prerequisites.

• Recover the operating system.

Prerequisites

To recover the operating system, you need the following:

• NetWare operating system, license software, patch level, and version

• Version and patch level of the MS-DOS software

• IPX/SPX and/or TCP/IP properties:

– Adapter type

– IPX network number or IP address

– Default gateway

– Subnet mask

– DNS server

• Computer properties:

– Computer name

– DNS domain name

– Administrator name and password

• Device and SCSI drivers

• Startup files, including autoexec.bat, config.sys, autoexec.ncf, and startup.ncf

How to Recover the NetWare Operating System

This section describes how to recover the NetWare operating system using the

NetWorker software. You can use this process to recover the NetWare

operating system back to the original computer, or to a different computer.

You can recover the operating system by performing either:

• A complete install or nwconfig. In this instance, you perform a complete

reinstallation and configuration of the operating system.

— or —

• A partial install or nwconfig. In this instance, you install and configure

only those files that enable the computer to communicate over the

network. Then, you recover the remaining operating system and

configuration files using the NetWorker software.
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To recover the operating system, follow these procedures, explained in detail

in the following sections:

1. Install the operating system.

2. Configure the operating system.

3. Test the operating system and configure the devices.

Task 1: Install the Operating System

To install the operating system:

1. Install MS-DOS, including the AUTOEXEC.BAT and CONFIG.SYS files,

into its original location. Refer to the MS-DOS documentation for details.

2. Install the same version and patch level of NetWare using the install or

nwconfig utility into its original location with the same:

• Version

• Patch level

• Computer name

• IPX network number and/or IP address

Refer to the NetWare documentation for details.

If you want to upgrade NetWare, first restore the operating system to its

original state, and then perform the upgrade.

3. Install NDS into its original location using the install or nwconfig utility:

• Use the same name as the original tree.

• Use the same server name.

• Use the same container and Administrator name.

• Ensure the Administrator object resides at the same level, in the same

container, as it did in the original tree.

Refer to the NetWare documentation for details.

Important: If this server will become the master of the NDS Root partition,

during installation, make sure you re-create the Organization object using the

same name. If the Organization object does not have the same name, the

sub-tree will contain new empty containers.
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Task 2: Configure the Operating System

To configure the operating system:

1. Configure the IPX/SPX and TCP/IP properties exactly as they were

configured before. If you do not, the NetWorker software will assign the

computer a new host ID. If the computer has a different host ID, you must

reregister the NetWorker software. Refer to the NetWorker Installation
Guide, NetWare Version for details.

2. If you are recovering to a new computer, assign the same hostname for the

new computer. If you do not use the same hostname, you will not be able to

recover the NetWorker indexes associated with the original computer.

3. Configure the date and time properties as they were configured before.

4. If you had any additional NetWare components or services, reinstall them

before recovering the computer’s data.

5. Restart the computer after installing the NetWare operating system.

Task 3: Test the Operating System and Configure the Devices

To test the operating system and configure the devices:

1. Configure any devices required by NetWorker. For example, SCSI

passthru devices for autochangers.

2. Perform a test to verify that the:

• Name to Address resolution is correct. Test by running nslookup
using the Fully Qualified Domain Name of the NetWare NetWorker

backup server, client, or storage node.

• Network protocols are functioning properly.

• Operating system is functioning properly.

• Time synchronization is functioning properly.

• Devices are recognized by the operating system. If the devices are not

recognized by the operating system, you might need to:

– Modify the device configuration files to enable the computer to

communicate with the device during recovery.

– Load the SCSI driver and its associated ASPI driver.

– Install the device driver.
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To complete the recovery process, recover:

• The NetWorker server, if necessary. See “Recovering a NetWare

NetWorker Server” on page 97 for details.

• The NetWorker client, if necessary.

• The computer’s data using NetWorker. Refer to the NetWorker
Administrator’s Guide, NetWare Version for details.

Recovering a NetWare NetWorker Server
To recover a NetWorker server:

• Meet the NetWorker server prerequisites.

• Recover the NetWorker server.

Prerequisites

To recover the NetWorker server, you need the following:

• Version and patch level of NetWorker

• Location of NetWorker

• Backup or clone volumes containing the:

– NetWorker server media manager. By default, this directory is

located in the SYS:NSR\MM directory.

Important: Do not attempt to recover the legatomm file manually. Recover this

file using the NetWorker Utilities Recover from a Disaster option.

– NetWorker server indexes. By default, this directory is located in the

SYS:NSR\INDEX\<SERVER-NAME> directory.

– NetWorker server configuration files. By default, this directory is

located in the SYS:NSR\RES directory.
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How to Recover a NetWare NetWorker Server

This section describes how to recover a NetWorker server. You can use this

process to recover the NetWorker server back to the same computer, or to a

different one.

To recover a NetWorker server, follow these procedures, explained in detail in

the following sections:

1. Install NetWorker.

2. Configure NetWorker so that it can perform the remainder of the recovery

processes.

3. Locate the latest bootstrap save set ID.

4. Recover the NetWorker bootstrap.

5. Rename the NetWorker server configuration files.

6. Recover the NetWorker server data.

Task 1: Install NetWorker

To install NetWorker:

1. Install the same version of NetWorker into its original location. Refer to the

NetWorker Installation Guide, NetWare Version for installation instructions.

• If you wish to upgrade the NetWorker server, first recover the server

to its original state, and then perform the upgrade.

• You do not need to reload the license enablers if the NetWorker

configuration files still exist. By default, the configuration files are

located in the SYS:NSR\RES directory.

2. Install any NetWorker patches you had installed prior to the disaster.



Legato NetWorker, Release 6.1
Disaster Recovery Guide

Chapter 5: NetWare Disaster Recovery

5

99

Task 2: Configure NetWorker

To configure NetWorker:

1. Configure the Device resource, if:

• You want to recover your data using multiple devices.

• You are not using a 4-mm device. The default device created by

NetWorker is a 4-mm device.

• You want to recover your data using an autochanger. Use [F4] to

verify that the autochanger correctly appears in the Autochanger

window.

2. Configure the Client resource associated with the server.

Set the browse and retention policies to a decade. The browse policy is one

quarter (four months) by default. This enables you to recover all of the

server’s records.

Important: If you do not reset the browse and retention policies, all of the

server’s records will be recovered. However, any records that are more than

one quarter (four months) old will be discarded, because the browse policy is

one quarter by default.

Task 3: Locate the Server’s Bootstrap Save Set ID

This section describes how to locate the save set ID for the NetWorker server’s

latest bootstrap. The NetWorker server’s bootstrap contains the server’s online

file index, media index, and resource configuration files.

Use the following steps to locate the save set ID of the most recent bootstrap if

you do not have this information:

1. Insert the most recent media or clone volumes used for scheduled backups

into the appropriate device.

2. At the NetWare system console, switch to the directory where the

NetWorker NLMs are located. By default, these files are located in the

SYS:NSR\BIN directory.

3. Use the scanner -B command to locate the most recent bootstrap on the

media.
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Task 4: Recover the NetWorker Server Bootstrap

This section describes how to recover the NetWorker server’s bootstrap. By

default, these files reside in the SYS:NSR and SYS:NSR\RES directories, and

can be recovered using the NetWorker Utilities program.

To recover the NetWorker bootstrap:

1. Load and inventory the devices. This ensures that the NetWorker software

can recognize which slots contain which volumes.

If you load a clone volume into a device, the NetWorker software will use

the clone volume for the remainder of the recovery process. You might

have to update the volume location to indicate that the original volume is

not available.

2. Start the NetWorker Utilities program by entering the following command

at the NetWare system console:

load NETUTIL

Important: Disable scheduled backups and do not use the NetWorker software

to perform backups or recovers while running the NetWorker Utilities

program. If backup and recovery processes are enabled, the state of the

NetWorker indexes will become confused. From the NetWorker Utilities

dialog box, select Recover from a Disaster.

3. Enter the full name of the backup administrator (for example,

“.cn=Admin.O= ‘top level container’”) into the User field and the appropriate

NetWare password into the Password field and press [Enter].

The Device Selection window appears.

4. From the Device Selection window, select the device you intend to use and

press [Enter].

5. Insert the most recent media or clone volumes used for scheduled backups

into the appropriate device.

• If you are using a single tape device, manually insert the volume.

• If you are using an autochanger, use the autochanger controls to

manually select the slot containing the most recent backup volume.

Refer to your printed bootstrap records to determine the required backup

volume.
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6. Press [Enter] when the following message appears.

Put the volume for disaster recovery in device xxxx and
press Enter.

7. Press [Enter] to exit the NetWorker Utilities. The server’s processor will

halt with multiple ABENDs.

8. Restart NetWorker.

9. From NetWorker, select F3>Operation>Recover.

10. Browse and mark the following files for recovery:

• SYS:NSR\NSR.RES

• SYS:NSR\NSRJB.RES

11. Press [F2] to start the recovery. When messages indicating name conflicts

appear, select Rename the Recover File for both files.

12. When recovery is complete, exit the NetWorker Utilities program.

Task 5: Rename the NetWorker Server Configuration Files

To rename the configuration files:

1. Unload all of the associated NLM files using nwdown.

2. Delete the existing files (NSR.RES and NSRJB.RES).

3. Rename the recovered files (which were renamed upon restore with a tilde

(~) prefix) to NSR.RES and NRJB.RES.

4. Restart the NetWorker software. This process restores the NetWorker

software to its last backup configuration, including passwords,

administrator privileges, backup groups, and schedules.

5. Verify that the NetWorker indexes and configuration files are restored. If

they are not restored, select Recover from a Disaster from the NetWorker

Utilities program, or use an older volume.
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Task 6: Recover the NetWorker Server Data

This section describes how to recover the remainder of the server’s data using

the NetWorker Utilities program.

To recover the NetWorker server data:

1. Insert the most recent backup or clone volumes into the device.

2. From the Mount dialog box, select the required volume.

Notice that the volume is now marked (R) ; this means the volume is write

protected.

3. From the [F3] Operation menu, select Recover to display the Client List

window.

4. Select the client with the NetWare server name and press [Enter].

Another login window appears.

5. Enter the full name of the backup administrator (for example,

“.cn=Admin.O= ‘top level container’”) into the User attribute and the

appropriate NetWare password into the Password attribute and press

[Enter].

The Browser window appears.

6. Select Schema and mark it for recover to recover all extensions to the NDS

schema.

7. From the [F2] File menu, select Start Recover, and press [Enter].

8. If you have NDS data to restore, continue with “Task 7: Restore NDS

Data”.

If you do not have any NDS data to restore, continue with “Task 8:

Complete the Server Recovery” on page 104.
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Task 7: Restore NDS Data

Before performing an NDS backup or recover, read the Novell® Application
Notes section “Backing Up and Restoring Novell Directory Services in

NetWare 4.11,” dated October 1996. This document explains concepts and

procedures that you need to understand before working with NDS backups

and recovers.

On networks with multiple servers, NDS automatically creates replicas

(copies) of the NDS database or portions of it (partitions) and stores them on

other servers. This process provides a readily available backup if NDS or a

partition is damaged. Do not circumvent this replication process.

Whenever possible, use an active replica to restore what was lost from the NDS

tree. If this is not feasible, you must restore from a Storage Management

Services (SMS) backup in the following way:

1. Restore the NDS information.

2. Restore the filesystem data and trustee rights.

NDS backup and restore is based on object names. The objects must exist

in the tree before you can restore the filesystem data and trustee

assignments for those objects. NDS should be functional (time and

partitions synchronizing normally) before you proceed with a restoration.

To restore NDS data to this server using the NetWorker software:

a. From the [F3] Operation menu, select Save Set Recover, and press

[Enter].

b. Select this server’s name as both the source and destination client.

c. Enter the full name of the backup administrator, and the password.

d. Select the {NDS} save set, and press [Enter] to display versions.

e. Select the version with the most recent full backup.

If there are any later save sets with level 1 or incremental backups, recover

them from the oldest to the most recent.

The NDS is now restored to the state of the most recent backup.
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Task 8: Complete the Server Recovery

To complete the recovery of the server:

1. Use NetWorker to recover the remaining data, including the client

indexes. In the Browser window, mark everything for recovery, and then

unmark all still-operational volumes, LEGATOMM, the server’s

LEGATODB, NSR.RES, NSRJB.RES, Schema, and NDS.

Important: Make sure you recover each client index by selecting the client

folder from the indexes directory. Each client has a legatodb file that is located

in SYS:NSR\INDEX\CLIENT-NAME.

If you run out of memory while recovering multiple files, try recovering

one volume at a time.

2. From the [F2] File menu in the Browser window, display the NetWorker

Recover Options dialog box. Select Don’t Overwrite Data.

3. Verify the recovered data. From a workstation, use the ndir command or

NetWare Administrator (NWAdmin) to check the data, trustee

assignments, file ownership, and other related information.

4. Select Cross-Check Index from the Indexes dialog box of the NetWorker

Administrator program to compare the index records to the records in the

media index.

5. Perform a check to make sure the server is fully recovered:

• Verify that the server and its associated clients are included in a

scheduled backup.

• Run dsrepair to verify the integrity of any NDS databases.

• Use the nwadmn server utility or the ndir workstation utility to

verify the data, trustee assignments, and file ownership.
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Recovering a Replicated NDS Partition
If the NetWare server did not contain an NDS partition (replicated or not), you

only need to rebuild the NetWare operating system and the server’s

filesystems.

This section contains the following information on recovering a replicated

NDS partition over the network:

• “Recover a NetWare 4.10 SYS Volume” on page 105

• “Recover a NetWare 4.11, NetWare 5.0, or IntraNetWare Server SYS

Volume” on page 109

Important: For NetWare 4.11/IntraNetWare® servers, do not delete the server

or volume objects for the failed volume from the NDS tree; you do not want to

eliminate any references other objects might have to the volume. If you must

delete objects on a NetWare 4.11/IntraNetWare server, use the NetWare 4.10

procedure for recovering from a disaster.

How to Recover a NetWare 4.10 SYS Volume

To recover a SYS volume on a NetWare 4.10 server, follow these procedures,

explained in detail in the following sections:

1. Recover the SYS Volume.

2. Restore the SMS Remote File System.

3. Complete the recovery of the SYS volume.

Task 1: Recover the NetWare 4.10 SYS Volume

To recover a SYS volume on a NetWare 4.10 server:

1. Use nwadmn or netadmin to delete the volume objects associated with the

failed server.

2. Use NDS Manager or partmgr to delete the server object for the failed

server. You cannot use netadmin to delete a server object.

Partition Manager displays a warning message; enter yes  to confirm the

deletion.
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3. Use NDS Manager or dsrepair to check the replica synchronization.

If you see error messages, wait a few minutes and try again.

4. From your NetWorker server, perform a directed recover to restore the

failed server’s Server Specific Info (SSI) files from a tape backup to a

functioning NetWorker for NetWare client.

The server-specific information files (SERVDATA.NDS, VOLSINFO.TXT,

STARTUP.NCF, and AUTOEXEC.NCF) are restored to a subdirectory

under SYS:\SYSTEM on the server you selected. This subdirectory is

given a DOS 8.3 name derived from the source server name.

5. If the failed server held a master replica, use NDS Manager or dsrepair to

designate a new master replica on a different server in the replica ring.

6. Use NDS Manager or dsrepair to perform an unattended full repair to

check replica synchronization. If necessary, use NDS Manager or dsrepair
on the servers containing master replicas to remove the failed server from

the replica ring.

7. Shut down the failed server and replace any damaged server hardware. If

you replace a hard drive, be sure that it is the same size or larger.

8. Format the DOS partitions and reinstall DOS.

Important: Use the DOS Time command to ensure that your computer is set to

the correct time to avoid time synchronization errors.

9. Reinstall NetWare 4.10 and NDS on the repaired or replaced server. Run

install or nwconfig, select Custom Install, and follow the directions on the

screen. Use the STARTUP.NCF and AUTOEXEC.NCF files recovered with

SSI to answer the questions displayed on the screen.

– Enter the same server name and internal IPX number that the server

had prior to the disaster.

– When prompted, insert the NetWare License diskette for the server

into the disk drive.

– When prompted for the name of the NDS tree, select the name of the

tree that the server resided in before the disaster.

– Select the time zone and configure the time.
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– Log in and specify the context for the server and its objects. Use the

same context used before the disaster.

– Edit the STARTUP.NCF and AUTOEXEC.NCF files to match the

versions recovered with SSI.

Installation continues; when complete, the server will contain all the files

necessary to perform an SMS remote filesystem restore. For more

information, see “Task 2: Restore the SMS Remote File System”.

Task 2: Restore the SMS Remote File System

To restore the SMS remote filesystem to a SYS volume on a NetWare 4.10

server:

1. Load the required name space modules for each restored volume. Use the

VOLSINFO.TXT file to determine which name spaces need to be loaded

(MAC.NAM, LONG.NAM, etc.).

2. Load the filesystem TSA specific to your version of the NetWare operating

system, by entering one of the following commands:

LOAD TSA410

LOAD TSA312

LOAD TSA500

3. Recover the filesystem for each volume affected by the failure. Do not

recover the Schema and [Root]; they are restored from a replica. You also

do not need to recover Server Specific Info again. When prompted,

suppress further prompting and overwrite files.

4. When you are prompted, log in using the full name of the backup user.

5. If the failed server had non-SYS volumes that were not affected by the

failure, from the [F2] File menu in the Browser window, select Recover to

display the NetWorker Recover Options dialog box. Select the Don’t
Overwrite Data; restore trustees, etc. command, and then recover the

volumes that were not affected by the failure.

6. Shut down and restart the repaired or replaced server.
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Task 3: Complete the Recovery of the NetWare 4.10 SYS Volume

To complete the recovery of a NetWare 4.10 SYS volume:

1. If necessary, use NDS Manager or dsrepair to re-establish replicas on the

repaired or replaced server.

2. Type the following commands at the command prompt:

LOAD TSA410

LOAD TSANDS

LOAD TSA500

3. From the Recover Browser window, recover the server object, volume

objects, and any objects that formerly referenced the recovered volume or

server objects. Expand the [Root] resource, mark the required objects, and

then select Recover. When prompted, suppress further prompting and

overwrite files.

4. Use NDS Manager or the Schedule immediate synchronization function of

dsrepair to synchronize the replica on all servers.

5. Verify the recovered data. From a workstation, use either the nwadmn
server utility or the ndir workstation utility to check the data, trustee

assignments, file ownership, and other related information.

The SYS volume should now be restored.
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How to Recover a NetWare 4.11, NetWare 5.0, or IntraNetWare Server
SYS Volume

To recover a SYS volume on a NetWare 4.11, NetWare 5.0, or IntraNetWare

server, follow these procedures, explained in detail in the following sections:

1. Recover the SYS Volume.

2. Install the operating systems.

3. Complete the SYS Volume recovery.

Important: For NetWare 4.11/IntraNetWare servers, do not delete the server

or volume objects for the failed volume from the NDS tree; you do not want to

eliminate any references other objects might have to the volume. If you must

delete objects on a NetWare 4.11/IntraNetWare server, use the NetWare 4.10

procedure for recovering from a disaster.

Task 1: Recover the NetWare SYS Volume

This section describes how to recover a NetWare 4.11 or IntraNetWare SYS

volume.

To recover a SYS volume:

1. From your NetWorker server, perform a directed recover to restore the

failed server’s Server Specific Info (SSI) files from a tape backup to a

functioning NetWorker for NetWare client.

The server-specific information files (SERVDATA.NDS, DSMISC.LOG,

VOLSINFO.TXT, STARTUP.NCF, and AUTOEXEC.NCF) are restored to a

subdirectory under SYS:\SYSTEM on the client you have selected. This

subdirectory is given a DOS 8.3 name derived from the source server

name.

Important: For NetWare 4.11/IntraNetWare servers, do not delete the server

or volume objects for the failed server from the NDS tree. You do not want to

eliminate any references other objects might have to the server. If objects were

deleted from the NDS tree, use the NetWare 4.10 procedure for recovering

from a disaster.
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2. If the failed server held a master replica, use NDS Manager or dsrepair to

designate a new master replica on a different server in the replica ring.

Refer to DSMISC.LOG to determine which replicas were stored on the

failed server.

3. If the failed server also contained any non-master replicas, use NDS

Manager or dsrepair on the servers containing master replicas to remove

the failed server from the replica ring.

A NetWare warning message appears. Continue with the recovery

procedure. Refer to “Backing Up and Restoring Novell Directory Services

in NetWare 4.11” in Novell Application Notes, October 1996.

4. Use dsrepair to perform an unattended full repair to ensure the ring is

functioning properly.

Refer to DSMISC.LOG to determine which replicas were stored on the

failed server. If DSMISC.LOG shows that no other server has exactly the

same replicas as the failed server, run dsrepair on any servers containing

replicas of partitions on the failed server.

5. Shut down the failed server and replace any damaged hardware. If you

need to replace a hard drive, install a drive that is the same size or larger.

Task 2: Install the Operating Systems

To install the operating systems:

1. Format the DOS partitions and reinstall DOS.

Important: Use the DOS Time command to ensure that your computer is set to

the correct time to avoid time synchronization errors.
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2. Reinstall NetWare 4.11, NetWare 5.0, or IntraNetWare and NDS on the

repaired or replaced server. Run install or nwconfig, select Custom

Install, and follow the directions on the screen.

a. When prompted, enter the same server name and internal IPX

number that the server had prior to the failure. Use the

STARTUP.NCF and AUTOEXEC.NCF files included with the

server-specific information for needed information.

b. After the preliminary files are copied, the Choose a Directory Tree

dialog box appears. Press [F5] to restore NDS (option listed at the

bottom right of the screen).

c. A new window displays two options: A: (the default) or Press [F3] to

specify a different path. If the Server Specific Info files are contained on

diskette, insert the diskette into drive A and press [Enter]. Otherwise,

press [F3] and enter the path to the Server Specific Info files restored in

step 1.

d. A Remote Server Authentication login dialog box is displayed. Log

in. When prompted, enter the Directory tree name.

e. Press [Enter], and both the files and NDS are copied to the new

server. DSMISC.LOG, VOLSINFO.TXT, and AUTOEXEC.NCF are

copied to the SYS:SYSTEM directory. STARTUP.NCF is copied to the

C:\NWSERVER directory.

f. The NDS restoration uses the information from SERVDATA.NDS
(TSANDS.NLM is not needed). NDS is now fully functional on the

server, but the partitions and replicas must still be reestablished.

g. When prompted, insert the NetWare License diskette for the server

into the diskette drive.

h. Edit the STARTUP.NCF and AUTOEXEC.NCF files.

i. If either the STARTUP.NCF or the AUTOEXEC.NCF files have

changed because they were backed up with the server-specific

information, both the original and the new files are displayed for you

to compare and make edits as necessary. If the current files are the

same as the original files, only the current files are displayed.

The server now contains all the files necessary to perform an SMS remote

filesystem restore.
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3. To finish the installation, either:

• Press [Enter] to exit the utility. NetWare will not copy the remaining

system and public files but will exit the utility. These files should be

recovered from a backup.

— or —

• Press [F3] to Continue installation and wait while the utility copies

the remaining system and public files. Then exit.

Task 3: Complete the NetWare SYS Volume Recovery

This section describes how to complete the recovery of the 4.11 SYS volume.

To complete the recovery of the SYS volume:

1. Load the required name space modules for each restored volume. Use the

VOLSINFO.TXT file to determine which name spaces need to be loaded

(MAC.NAM, OS2.NAM, and so on).

2. Load the filesystem TSA specific to your version of NetWare by typing one

of the following commands, at the prompt of the repaired or replaced

server:

LOAD TSA410

LOAD TSA500

3. Recover the filesystem for each volume affected by the failure. Do not

recover the Schema and [Root]; they will be restored from a replica. You

also do not need to recover Server Specific Info again. When prompted,

suppress further prompting and overwrite files.

If the failed server had non-SYS volumes that were not affected by the

failure, no further action is needed because the SERVDATA.NDS file

preserves the trustee assignments on these other volumes.

4. Shut down and restart the server.

5. Use NDS Manager or dsrepair to re-establish replicas on the failed server.

Use DSMISC.LOG to view a copy of the replica list that resided on the

server at the time of backup.

6. Verify the recovered data. From a workstation, use NWAdmin32 or the

rights /T /S and ndir commands to check the data, trustee assignments, file

ownership, and other related information.



Legato NetWorker, Release 6.1
Disaster Recovery Guide 113

Chapter 6: Windows 95/98 Client Disaster
Recovery

This chapter describes how to perform a disaster recovery on a Windows

95/98 system using the NetWorker software. It also describes the prerequisites

for recovering the hardware, operating system, and software.

Refer to the following list of disaster recovery scenarios to determine which

instructions apply to your situation.

To recover... See...

Hard drive • “Replacing a Hard Drive” on page

114

Operating system • “Recovering the Windows 95/98

Operating System” on page 115

NetWorker client • “Recovering a Windows 95/98

NetWorker Client” on page 118

Data • Refer to the appropriate Legato

backup utility Administrator’s Guide
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Replacing a Hard Drive
To replace a hard drive:

• Obtain the hard drive information.

• Replace the hard drive.

Obtaining the Hard Drive Information

You can use fdisk to obtain the following information about each drive:

• Size of the drive

• Size, filesystem type, and volume label assigned to each disk partition

After you obtain this information, you can replace the hard drive.

How to Replace a Hard Drive

If you are experiencing the failure of one or more hard drives, refer to the

appropriate Microsoft Windows 95/98 documentation and the appropriate

hard drive vendor documentation for detailed instructions on how to replace

your hard drive(s).

Important: Install a new drive that is the same size or larger than the original

drive. This will ensure that you can recover all of the drive’s data.

To begin the recovery process, recover:

• The operating system, if necessary. See “Recovering the Windows 95/98

Operating System” on page 115 for details.

• The NetWorker software, if necessary. See “Recovering a Windows 95/98

NetWorker Client” on page 118 for details.

• The computer’s data using NetWorker. Refer to the NetWorker 6.1
Administrator’s Guide, Windows Version for details.
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Recovering the Windows 95/98 Operating System
To recover the operating system:

• Meet the operating system recovery prerequisites.

• Recover the operating system.

Prerequisites

To recover the operating system, you need the following:

• Version, service pack, and patch level of the Windows 95/98 operating

system

• The Windows 95/98 Setup Boot Disk

• Virtual memory settings

• The following files:

– config.sys

– autoexec.bat

– CD-ROM drivers

• Protocols installed

• TCP/IP Properties:

– Adapter type

– IP address

– Default gateway

– Subnet mask

– DNS server

• Windows 95/98 Workstation Properties:

– Computer name

– Domain name

– Login name and password

• Date and time properties
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How to Recover the Windows 95/98 Operating System

This section provides instructions on how to recover the Windows 95/98

operating system using the NetWorker software. You can use this process to

recover the Windows 95/98 operating system back to the original computer or

to a different computer.

To recover the operating system, follow these procedures, explained in detail

in the following sections:

1. Install the operating system.

2. Complete the installation process.

Task 1: Install the Operating System

To install the operating system:

1. Install the same version, service pack level, and patches of the operating

system into its original location. Refer to documentation accompanying

the operating system for details.

2. Copy the original config.sys, autoexec.bat, and CD-ROM drivers to the

replacement drive.

3. Reboot the system.

4. Ensure that all disk partitions and volumes are as they were before the

disaster. The volumes must be:

• The same filesystem type as before, for example FAT, FAT32.

• At least the same size as before to hold all of the backed-up data.

5. Configure the TCP/IP properties as they were configured before the

disaster, with the same hostname, IP address, default gateway, subnet

mask, and DNS server.

Important: If the Windows 95/98 client participates in a DHCP network, it will

not have a fixed IP address. Instead, the client will have a radio button and the

name of the DHCP server, which is also known as the PDC (Primary Domain

Controller).
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If you are recovering the operating system to a different computer, you

must:

• Use the same hostname for the new computer. If you do not use the

same hostname, you will not be able to recover the NetWorker indexes

associated with the original computer.

• Assign the same TCP/IP address for the new computer; otherwise it

will be assigned a new host ID by NetWorker.

6. Configure the Windows 95/98 Workstation properties as they were

configured before the disaster, with the same computer name, domain

name, administrator name, and password.

7. Configure the date and time properties as they were configured before the

disaster.

8. Restart the computer.

9. Reset the Virtual Memory Settings to what they were previously, by

selecting System Properties>Performance>Virtual Memory>Change.

10. If you had any additional Windows 95/98 components installed, such as

File and Printer sharing, you should reinstall them before recovering the

computer’s data.

Task 2: Complete the Installation Process

To complete the installation process:

1. Verify that:

• The operating system is functioning properly.

• The network protocols are functioning properly.

• The devices are recognized by the operating system.

• The “Network connectivity” is correct.

2. If you are using a device with a configuration that is not directly supported

by the computer’s operating system, you may need to reinstall the device

driver software.

3. If you want to use Active Desktop, install it after you have recovered all of

the computer’s data.

To complete the recovery process, recover the Windows 95/98 NetWorker

software, if necessary. See “Recovering a Windows 95/98 NetWorker Client”

on page 118 for details.
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Recovering a Windows 95/98 NetWorker Client
This section describes how to recover a Windows 95/98 NetWorker client. You

can use this process to recover the client software back to the same computer

or to a different computer.

To recover a Windows 95/98 NetWorker client:

• Meet the Windows 95/98 NetWorker client recovery prerequisites.

• Recover the Windows 95/98 NetWorker client.

Prerequisites

To recover the Windows 95/98 NetWorker client software, you need the

following:

• Version and patch level of NetWorker

• Location of NetWorker

• NetWorker ClientPak for Windows 95/98

How to Recover a Windows 95/98 NetWorker Client

To recover a Windows 95/98 NetWorker client, follow these procedures,

explained in detail in the following sections:

1. Install NetWorker.

2. Recover the Windows 95/98 NetWorker client data.

3. Recover the registry files.

Task 1: Install NetWorker

To install NetWorker:

1. Install the same version and patch level of the NetWorker software into its

original location. Refer to the appropriate NetWorker 6.1 Installation Guide,
Windows Version for details.

If you want to upgrade the client software, first recover the client to its

original state, and then perform the upgrade.

2. Install any software patches that were originally installed.
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Task 2: Recover the Windows 95/98 NetWorker Client Data

To recover the Windows 95/98 NetWorker client data using the NetWorker

User program:

1. Mark all the drives for recovery.

2. Set the recover options by selecting the Overwrite Existing File radio

button from the Options>Recover Options menu.

If you did not set the recover options, you must select Suppress Further

Prompting and the Overwrite Existing File radio button, when the

Naming Conflict Dialog Box appears during the recovery process. This

will enable automatic overwriting of files with the same name.

3. Select Start.

4. When the Password Protection window appears, select Recover > OK to

recover these files. Files in the Recycle Bin are not password-protected.

NetWorker logs the output of the recovery process in

%Systemroot%\networkr.log. This file is overwritten each time a recovery is

performed, it must be renamed to be preserved.

5. Restart the computer. The computer should now be restored to its

pre-disaster state.

Once data has been recovered, you may have extra files that were

recovered from open files. Find all of these files by selecting *.*.a* (for

example, nsrexecd.exe.a1001789) and then delete them.

Note: In Windows 95, the files will follow the Windows 8.3 naming

convention. The recovered files will likely take the following form:

~2345678.123.

6. If you want to use Active Desktop, install it after you have recovered all of

the computer’s data.
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Task 3: Recover the Registry Files

Windows 95/98 does not support the functionality that enables the NetWorker

software to replace the Windows 95/98 registry files when the computer is

rebooted. If you have backed up the registry files USER.DAT and

SYSTEM.DAT in your Windows directory and need to recover them, you must

recover each registry file individually, with a reboot between each file, until

everything synchronizes correctly.

Note: The registry contains important system configuration information and

should not be overwritten unless absolutely necessary.

To recover the Windows 95/98 registry:

1. From NetWorker User, recover only the SYSTEM.DAT file from the

Windows directory.

2. Reboot the computer.

3. Restart NetWorker User and recover only the USER.DAT file from the

Windows directory.

4. Reboot the computer to complete the recovery.
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Chapter 7: NetApp Client Disaster Recovery

This chapter provides instructions on how to perform a disaster recovery

using NetWorker software on a NetworkAppliance® (NetApp®) filer running

the Data ONTAP™ operating system. It also describes the prerequisites for

recovering the hardware, operating system, and software.

Important: Use the na_recover command when recovering data for a NetApp

filer. For information on the na_recover command, refer to the na_recover man

page, the Legato Command Reference Guide, or the Legato NetWorker ClientPak for
NetApp Installation Guide.

The set of instructions you need to follow depends upon the extent of the

damage caused by the disaster. Refer to the following list of disaster recovery

scenarios to determine which set of instructions apply to your situation.

To recover... See...

Hard drive • “Replacing a Hard Drive” on page

122

Operating system • “Recovering the Data ONTAP

Operating System” on page 122

NetWorker client • “Recovering a NetApp NetWorker

Client” on page 125

Data • Refer to the Legato NetWorker
ClientPak for NetApp Installation Guide
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Replacing a Hard Drive
If you are experiencing the failure of one or more hard drives, refer to the Data
ONTAP System Administrator’s Guide and the disk shelf hardware guide

appropriate for your disk shelf hardware.

Important: Install a new drive that is the same size or larger than the original

drive. If you use a larger hard drive, the filer only uses as much space as was

available on the replaced hard drive.

To begin the recovery process, recover:

• The operating system. See “Recovering the Data ONTAP Operating

System” on page 122 for details.

• The NetWorker software, if necessary. See “Recovering a NetApp

NetWorker Client” on page 125 for details.

• The hard drive’s data using the command na_recover. Refer to the Legato
NetWorker ClientPak for NetApp Installation Guide for details.

Recovering the Data ONTAP Operating System
To recover the operating system:

• Meet the operating system repair prerequisites.

• Recover the operating system.

Prerequisites

To recover the operating system, you need the following:

• Version and patch level of the Data ONTAP operating system

• Filer system boot disks

• Protocols installed

• TCP/IP properties:

– IP address

– Default gateway

– Subnet mask

– DNS server
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• Filer properties:

– Filer name

– DNS domain name

– Administrator name and password

• Domain information

• Date and time properties

• Network media type

• License information

CIFS setup requires the following:

• WINS IP address

• Windows NT Domain information

• PC code page number (for non-ASCII character support)

How to Recover the Data ONTAP Operating System

This section provides instructions on how to recover the Data ONTAP

operating system using the NetWorker software. Use this process to recover

the Data ONTAP operating system back to the original filer or to a different

filer.

You can recover the operating system by performing either a:

• Complete installation. Perform a complete reinstallation and

configuration of the operating system.

— or —

• Partial recovery. Install and configure only those files that enable the filer

to communicate over the network. Then, recover the remaining system

and configuration files using the NetWorker software.

To recover the operating system, follow these procedures, explained in detail

in the following sections:

1. Install the operating system.

2. Complete the installation process.



Legato NetWorker, Release 6.1
Disaster Recovery Guide

7

Prerequisites

124

Task 1: Install the Operating System

To install the operating system:

1. Install the same version and patch level of the Data ONTAP operating

system into its original location.

This step includes setting the TCP/IP properties as they were before, with

the same hostname, IP address, default gateway, subnet mask, and DNS

server. It also includes setting the same filer name, domain name,

administrator name, and password.

If you install the operating system to a different filer, use the same

hostname for the new filer. If you do not, you cannot recover the

NetWorker indexes from the original filer. Also, assign the same TCP/IP

address for the new filer. Otherwise the filer is assigned a new host ID by

NetWorker, forcing you to reregister the NetWorker software.

If you want to upgrade the Data ONTAP operating system, first recover

the operating system to its original state, and then perform the upgrade.

2. Re-create all volumes that were previously on the filer. The volumes must

be at least the same size as before or larger, to hold all of the backup data.

3. Restart the filer after reinstalling the Data ONTAP operating system.

4. Reinstall any additional NetApp components or services (licensing the

filer or enabling Java services, for example), before recovering the filer’s

data.

Task 2: Complete the Installation Process

To complete the installation process, perform a test to verify that the:

• Operating system is functioning properly.

• Network protocols are functioning properly.

• Name-to-Address resolution is correct.

To complete the recovery process, recover:

• The NetWorker software and each software application, if necessary. See

“Recovering a NetApp NetWorker Client” on page 125 for details.

• The computer’s data using the na_recover command. Refer to the Legato

NetWorker ClientPak for NetApp Installation Guide for details.
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Recovering a NetApp NetWorker Client
This section describes how to recover a NetWorker client. Use this process to

recover the client software back to the same filer or to a different filer.

To recover a NetWorker client:

• Meet the NetWorker client recovery prerequisites.

• Recover the NetWorker client.

Prerequisites

To recover the NetWorker client software, you need the following:

• Version and patch level of each software application.

• Location of each software application.

• Configuration files for each major software application, for example

NetWorker components and database applications.

• The NetWorker binaries and configuration files. By default, these files are

located in the filer-name/vol/vol0/etc/app/legato/unix/bin directory for filers

administered by Solaris servers and the

filer-name/vol/vol0/etc/app/legato/windows/bin directory for filers

administered by Windows NT servers.

How to Recover a NetApp NetWorker Client

To recover a NetApp NetWorker client, follow these procedures, explained in

detail in the following sections:

1. Install NetWorker.

2. Recover the NetApp client data.

Task 1: Install NetWorker

To install the NetWorker client software:

1. Install the same version and patch level of the NetWorker software into its

original location. Refer to the Legato NetWorker ClientPak for NetApp
Installation Guide for details.

If you want to upgrade the client software, first recover the client to its

original state, and then perform the upgrade.

2. Install any software patches that were originally installed.
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Task 2: Recover the NetApp Client Data

This section provides instructions on how to recover the client data, including

the configuration files for the operating system and each of the software

applications.

To recover the data using the NetWorker User program, use the na_recover
command to recover backed-up files and data.

Important: You must use the na_recover command when recovering data for a

NetApp filer. Using the recover command can cause the recover to fail or cause

the access control lists (ACLs) to be stripped from the files; do not use this

command. Also, you should not attempt to use the NetWorker graphic user

interface (GUI) to recover data. For information on the na_recover command,

refer to the na_recover man page, the Legato Command Reference Guide, or the

Legato NetWorker ClientPak for NetApp Installation Guide.

To perform a partial recovery, refer to “How to Recover a Single File or

Directory” for the appropriate server in the Legato NetWorker ClientPak for
NetApp Installation Guide.

To perform a full recovery, refer to “How to Recover a Save Set” for the

appropriate server in the Legato NetWorker ClientPak for NetApp Installation
Guide.
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Chapter 8: Microsoft Cluster Disaster Recovery
(Windows NT 4.0)

This chapter describes how to recover one or more computers in a Windows

NT 4.0 server cluster. The following scenarios are described:

• “Recovering One Node in a Cluster” on page 128

• “Recovering a Cluster Shared Disk” on page 130

• “Replacing the Quorum Disk and Recovering Its Data” on page 133

• “Recovering the MSCS Cluster Configuration” on page 135

• “Performing a Cluster Wide Recovery” on page 137

Important: To ensure proper termination, never power off any node in the

cluster unless it is connected with a Y cable.
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Recovering One Node in a Cluster
This section describes how to recover one node in a cluster. In this scenario,

Node_A is still working and Node_B is the failed node in the cluster.

How to Recover One Node in a Cluster

To recover a failed node within a cluster, follow these procedures, explained in

detail in the following sections:

1. Evict Node_B from the cluster.

2. Reinstall the Windows NT software.

3. Reinstall the MSCS cluster and NetWorker software.

4. Recover the data.

Task 1: Evict Node_B from the Cluster

To evict Node_B from the cluster:

1. Make sure that the cluster resources failed over to Node_A, the working

node. This includes the quorum disk and any shared disks.

2. If any of the data that failed over from Node_B to Node_A is corrupt, use

the NetWorker software to recover the data.

Note: You might need to shut down some cluster resources that depend on this

data.

3. From the Cluster Administrator on Node_A, evict Node_B from the

cluster.

4. Shut down Node_B if it is still running and disconnect it from the cluster.

5. Fix or replace the damaged hardware, if necessary.

6. Reconnect the fixed or new Node_B to the cluster.
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Task 2: Reinstall the Windows NT and MSCS Software

To reinstall the Windows NT software on Node_B (the failed node):

1. Install the Windows NT 4.0 Server Enterprise Edition software.

2. Install Windows NT Service Pack 3.

3. Install the MSCS software.

4. If the node had a local tape drive, install the driver.

5. Install the latest Windows NT Service Pack.

6. Join Node_B to the cluster that Node_A is already a member.

7. Use the same drive letters that were previously used for the disk volumes.

Important: Any local drive letters you assign should not conflict with the drive

letters assigned to any of the shared disks.

Task 3: Reinstall the NetWorker Software

To reinstall the NetWorker software, on Node_B:

1. Log on to the same domain as Node_A.

2. Install the NetWorker software, and apply any needed patches. For

specific instructions, refer to the NetWorker 6.1 Installation Guide, Windows
Version.

3. Complete the following steps to ensure that the correct versions of the

msvcrt.dll and mfc42u.dll files are used by the Cluster Administrator

program.

a. Close the Cluster Administrator program on the node where you are

copying the msvcrt.dll and mfc42u.dll files.

b. Copy the msvcrt.dll and mfc42u.dll files from the NetWorker software

installation directory to the cluster installation directory. For example,

copy the msvcrt.dll and mfc42u.dll files from:

%SystemDrive%\Program Files\nsr\bin

to

%SystemDrive%\winnt\cluster

c. Open the Cluster Administrator program if required.
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Task 4: Recover the Data

To recover the data:

1. Recover all the hives in the registry or system state.

2. Use NetWorker to recover any data that is local only to Node_B.

3. Restart Node_B.

4. Make sure that the cluster that both Node_A and Node_B are members of

is working properly.

Recovering a Cluster Shared Disk
This section describes how to recover data from a cluster shared disk that is not

a quorum disk.

How to Recover a Cluster Shared Disk

To recover a cluster shared disk, follow these procedures, explained in detail

in the following sections:

1. Take the dependant resources offline.

2. Replace the hard drive.

3. Recover the data belonging to the shared disk.

4. Configure the cluster to include the shared disk.

Task 1: Take the Dependant Resources Offline

For detailed instructions, refer to the Microsoft Cluster Server documentation.

To take all of the resources that are dependant on the shared drive that you are

replacing offline:

1. Create a new Resource Group.

2. If the current shared disk’s resource group contains the shared disk and its

interdependent resources, move the cluster resources that represent the

affected shared disk into the resource group you just created.

3. Take the resource group that contains the shared disk offline.

Note: You do not need to create a new resource group if the shared disk’s

resource group only contains resources that depend on it.



Legato NetWorker, Release 6.1
Disaster Recovery Guide

Chapter 8: Microsoft Cluster Disaster Recovery (Windows NT 4.0)

8

131

Task 2: Replace the Hard Drive

For detailed instructions, refer to the Microsoft Cluster Server documentation.

To replace the hard drive:

1. Set the Startup Type of the Cluster Server service to Manual.

2. Open the Property window for each resource in the resource group. Select

the Do Not Restart property from the Advanced window.

3. Remove the shared disk from the dependency list of any resources that

depend on the shared disk.

Important: If you fail to perform this step, you might not be able to delete this

disk resource in the following step.

4. Delete the cluster resource that represents the shared disk.

5. If required, shut down the nodes.

Refer to the MSCS Cluster Hardware Manual to determine if you are

required to shut down the nodes before you replace the shared hard drives

between the nodes.

6. Remove the affected shared disk and replace it with the new shared disk.

7. If you had shut down the nodes previously, reboot them.

8. Create the drive volumes and format the new disk as it previously existed.

Task 3: Recover the Data Belonging to the Shared Disk

To recover the data belonging to the shared disk:

1. Make sure that the NetWorker software is properly installed. For details,

refer to the NetWorker 6.1 Installation Guide, Windows Version.

2. Use NetWorker to recover all the data that belonged to the shared disk.

If the resource group is a virtual server, you might need to perform a

directed recover. For details, refer to the NetWorker 6.1 Administrator’s
Guide, Windows Version.
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Task 4: Configure the Cluster to Include the Shared Disk

For detailed instructions, refer to the Microsoft Cluster Server documentation.

To configure the cluster to include the shared disk:

1. Restart the Cluster Service if it was previously stopped.

2. Create a new cluster resource to represent the new disk.

3. Add the cluster resource to the resource group you created in “Task 1: Take

the Dependant Resources Offline” on page 130.

If a new resource group was not created in Step 1, add the resource to the

resource group where it existed before the replacement.

4. Add the shared disk to the dependency list of all the cluster resources that

depend on this resource.

5. Start the resource group in which the shared disk exists.

6. If you created a new resource group:

a. Move the disk resource and all dependant resources to their original

resource group.

b. Delete the now-empty resource group.

7. Make sure that the Startup Type of the Cluster Server service is set to

Automatic.

8. Make sure that the following resource group property is set to its original

setting: Do Not Restart. In most situations, it is unselected.
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Replacing the Quorum Disk and Recovering Its Data
This section provides information about the quorum resource and explains

how to recover a quorum disk’s data.

About the Quorum Resource

If there is a communication failure between the nodes, the MSCS software uses

the quorum resource in an arbitration process to determine the members of the

cluster nodes. The quorum resource also records changes made to the cluster

database when one of the nodes in the cluster is down. For further information

about nodes in the MSCS environment, refer to the appropriate Microsoft

documentation.

Refer to the MSCS cluster documentation for detailed information on how to:

• Locate the quorum disk

• Locate the quorum data directory

• Change the quorum disk designation

Recovering the cluster configuration data in the quorum disk is important

during a disaster recovery. Recovery of the quorum resource information is not

automatic.

If the quorum disk is owned by a virtual server, configure the virtual servers

as a NetWorker client. Use one of the following save sets:

• “All”

• Drive volume or directory that has quorum data

If the quorum disk is not owned by a virtual server, configure all the nodes as

NetWorker clients. Use one of the following save sets:

• “All” (this is preferred)

• Drive volume or directory that has quorum data

The quorum disk is accessible from only one node at a given point in time.

Therefore, the backup will fail over to the node that does not have access to the

quorum disk. This is why specifying “All” as the save set is preferred over

specifying the drive volumes as the save set.
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How to Replace the Quorum Disk and Recovering Its Data

To recover the quorum disk’s data:

1. Take offline any cluster resources or applications that depend on the

quorum disk’s data.

Important: Do not take the cluster service offline.

2. Change the quorum disk designation and replace a new disk as the

quorum disk.

For detailed instructions, refer to the Microsoft documentation, including

Article ID: Q172944.

3. If required, install the NetWorker software on the node that has access to

the quorum disk.

4. Recover the data that resided on the quorum disk before the disaster.

Important: Do not recover the quorum data.
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Recovering the MSCS Cluster Configuration
This section describes how to recover the MSCS cluster configuration.

The following procedure is based on these assumptions:

• You have not changed the disk configuration from the time you

performed the last backup on the cluster database.

• You have not replaced any hardware, including the shared disk, from the

time you performed the last backup on the cluster database.

• Node_A has the latest backup of the system state.

• Node_A or a virtual server has the latest backup of the quorum data.

How to Recover the MSCS Cluster Configuration

To recover the MSCS cluster configuration, follow these procedures, explained

in detail in the following sections:

1. Recover the system state and quorum data.

2. Replace the quorum data with the recovered quorum data.

3. Evict Node_B from the cluster.

4. Install the cluster software and patches on Node_B.

Task 1: Recover the System State and Quorum Data

To recover the system state and quorum data:

1. Select a node in the cluster that has the good, and possibly the latest,

backup of the system state and the quorum data. This procedure uses

Node_A.

2. Make sure that the cluster service is running on Node_A.
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3. From Node_A, recover the following:

• System state

• Quorum data (If the quorum disk is owned by a virtual server, use

the directed recover procedure. For details, see the NetWorker 6.1
Administrator’s Guide, Windows Version.)

Make sure that you recover the quorum data to a different directory in the

quorum drive.

For example, if the quorum data previously resided in G:\MSCS, recover

the data to G:\RECOVER\MSCS.

4. Shut down Node_A.

Important: Do not reboot Node_A.

Task 2: Replace the Quorum Data with the Recovered Quorum Data

To replace the quorum data to Node_B:

1. On Node_B, uninstall the cluster software.

2. Reboot Node_B.

3. Copy the existing quorum data from its original location to another

directory. For example, copy:

G:\MSCS

to

G:\TEMP\MSCS

4. Replace the existing quorum data with the recovered quorum data. For

example, copy:

G:\RECOVER\MSCS

to

G:\MSCS

5. Shut down Node_B.
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Task 3: Evict Node_B from the Cluster

To evict Node_B from the cluster:

1. Reboot Node_A.

2. Open the Cluster Administrator and evict Node_B from the cluster.

Task 4: Install the Cluster Software and Patches on Node_B

To install the cluster software and patches on Node_B:

1. Reboot Node_B.

2. Install the cluster software and join it to the cluster in which Node_A is a

member node.

3. On Node_B, apply any needed cluster patches and Windows service

packs.

4. Verify that the cluster configuration has been successfully recovered.

Performing a Cluster Wide Recovery
This section describes how to perform a cluster wide recovery. Use the

following procedures to perform a complete cluster recovery, including

reinstallation of the operating system on all nodes participating in the cluster

environment. These procedures also describe how to perform a recovery for

both new and existing hardware.

In the following example:

• If the NetWorker server is part of the cluster, it is represented as Node_A.

• If the NetWorker server is external to the damaged cluster, choose a node

that has the most up-to-date backup of the cluster database (part of the

registry) as Node_A.

• Defective nodes and shared drives have been replaced.
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How to Perform a Cluster Wide Recovery

To recover the cluster to new hardware or existing hardware, follow these

procedures, explained in detail in the following sections:

1. On Node_A, install and configure the software.

2. On Node_B, install and configure the software.

3. Install and configure NetWorker.

4. Perform a disaster recovery.

5. Check and reassign the drive assignments.

6. Recover the data.

7. Check the disk signatures.

8. Join Node_B to the cluster.

Task 1: On Node_A, Install and Configure the Software

To install and configure the software, on Node_A:

1. Make sure that the node has been properly:

• Shut down

• Connected through the shared disks

• Terminated

2. Install Windows NT 4.0 Enterprise Edition server.

a. Add the server to the domain using the same cluster login account.

b. Create the partitions so that the new disk configuration of Node_A

matches the original configuration.

c. Use the same server name (fully qualified DNS if used) and IP

address that were used originally.

d. Configure the network adapters and the IP address using the original

settings whenever possible.

e. Log on to the domain.

3. Run the Windows NT Disk Administrator and configure the drives to

match their previous configuration.

4. Install Windows NT 4.0 Enterprise Edition server-specific service packs

(Service Pack 3).

5. Install the cluster software.
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6. Install any required service pack software. Make sure that the version is

greater than Service Pack 3.

7. If Node_A is a NetWorker server, configure the tape devices.

8. Log on to Node_A using the cluster account on the domain.

Task 2: On Node_B, Install and Configure the Software

To install and configure the software, on Node_B:

1. Make sure that the node has been properly:

• Shut down

• Connected through the shared disks

• Terminated

2. Install Windows NT 4.0 Enterprise Edition server.

a. Add the server to the domain using the same cluster login account.

b. Create the partitions so that the new disk configuration matches the

original configuration.

c. Use the same server name (fully qualified DNS if used) and IP

address that were used originally.

d. Configure the network adapters and the IP address using the original

settings whenever possible.

e. Log on to the domain.

3. Run the Windows NT Disk Administrator and configure the drives to

match their previous configuration.

4. Install Windows NT 4.0 Enterprise Edition Server-specific service packs

(Service Pack 3).

Task 3: Install and Configure NetWorker

To install and configure NetWorker on Node_A and Node_B:

1. Install the NetWorker software and any required patches.

2. If NetWorker server was originally installed as a failover server, configure

the NetWorker server as a cluster resource. For details, refer to the

NetWorker 6.1 Installation Guide, Windows Version.
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Task 4: Perform a Disaster Recovery

To perform a disaster recovery:

1. Shut down Node_B.

2. If Node_A is a NetWorker server, perform a NetWorker disaster recovery

from Node_A. For details, refer to “Chapter 3: Windows NT 4.0/UNIX

Disaster Recovery” on page 27.

3. Restore the following directories:

• Windows NT registry or system state

• Windows NT system directory

Select Overwrite and Suppress Messages.

4. Recover the quorum and the shared drives data. Follow the directed

recover procedure. For detailed instructions, refer to the NetWorker 6.1
Administrator’s Guide, Windows Version.

Note: Make sure that you restore the \MSCS directory in the quorum to a

different location, for example \MSCStemp.

5. Shut down Node_A. Do not reboot Node_A.

a. The system will ask you to restart; select Yes.

b. Shut down the node when the system is in its reboot cycle.

6. Restart Node_B and log on with Administrator privilege.

7. On the quorum drive:

a. Rename the existing \MSCS directory to \MSCSold.

b. Move the restored \MSCS directory that was restored to \MSCStemp
to the \MSCS directory.

8. Shut down Node_B.

Task 5: Check and Reassign the Drive Assignments

If you are replacing the cluster shared disks with new hardware, follow these

steps to check and reassign the drive assignments:

1. Reboot Node_A. The drive assignments might have changed.

Use the Disk Administrator to reassign the drives to their former drive

letters.

2. From the Control Panel>Services, set the startup parameter of the MSCS

service to Manual.
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3. Reboot Node_A.

4. Replace the cluster shared disks with the new hardware.

Check the drive assignments through Windows Explorer. The “phantom”

drives you see are the original shared disks. These drives cannot be

deleted or disconnected from the Windows Explorer.

5. Remove the registry entries for the phantom disks:

a. Use regedit to display the following registry entry:

HKEY_LOCATION_MACHINE\SYSTEM\CurrentControlSet\Services
\ Clusdisk\Parameters\Signatures

The numbers listed under Signatures are the drive signatures for the

former shared disks. Delete these numbers.

b. Reboot the node.

c. Check the status of the disks through Windows Explorer.

There should no longer be any phantom disks and the new shared

disks should have the proper drive letter assignments.

The new shared disk signatures are located in the following registry

key:

HKEY_LOCATION_MACHINE\SYSTEM\CurrentControlSet\Services
\Clusdisk\Parameters\AvailableDisks

Task 6: Recover the Data

To recover the data:

1. Use the NetWorker User GUI to restore the remaining data from tape. Do

not restore the data from the following directories:

• %SystemDrive%\Program Files\NetWorker\nsr\index (if this node is

the NetWorker Server)

• System state

• RepairDisk

• Windows NT system directory

For details, refer to “Chapter 3: Windows NT 4.0/UNIX Disaster

Recovery” on page 27.

2. Reboot Node_A.

3. Log on to a domain with Administrator privileges.
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Task 7: Check the Disk Signatures

If you are replacing the cluster shared disks with new hardware, follow these

steps to check the disk signatures:

1. Replace the cluster shared disks with the new hardware:

a. From the Control Panel>Services, start the MSCS service with the

-fixquorum startup option. This option allows you to fix or add a

new quorum drive.

b. Start the Cluster Administrator program and attach Node_A to the

cluster you are restoring.

c. Create the new disk resource for the quorum drive and place it in the

Quorum Group.

For detailed information, refer to Microsoft's TechNet Article Q172944
"How to Change the Quorum Disk Designation."

d. From the Cluster Administrator GUI:

– Rename all of the old shared disks.

– Create new resources for the physical disks to match the old

shared disks.

– Check for dependencies for the physical disk and make the

necessary modifications.

e. Create a new group and move all of the old shared disks to this

group. This is done for cleanup purposes.

Important: You cannot delete the old shared disks until both nodes are running

and both nodes are members of the cluster.

2. From the Control Panel>Services, set the MSCS service to Automatic.

3. Remove any Startup Parameters that may have been previously set. For

example:

-fixquorum



Legato NetWorker, Release 6.1
Disaster Recovery Guide

Chapter 8: Microsoft Cluster Disaster Recovery (Windows NT 4.0)

8

143

Task 8: Join Node_B to the Cluster

To join Node_B to the cluster:

1. On Node_A, use the Cluster Administrator to evict Node_B from the

cluster.

2. Restart Node_B.

3. On Node_B, install the cluster software and rejoin the cluster.

4. Install the latest service pack software on Node_B. Make sure that the

version is greater than Service Pack 3.

5. If NetWorker Server is installed in Node_A as a failover server:

a. Install NetWorker server software.

b. Register the resource extension. This manages the NetWorker Server

resource-type in Node_B. For more details, see the NetWorker 6.1
Installation Guide, Windows Version.

c. On Node_B, you can choose to:

– Configure the tape devices

– Install the NetWorker client software

6. Install any NetWorker specific patches.

7. Recover all the data that belongs to Node_B. This includes the system

configuration data. For example:

• System state

• RepairDisk

• Windows NT system directory

• C:\

8. Reboot Node_B.

9. Verify that the system has been restored to its original state before the

disaster.
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Chapter 9: Microsoft Cluster Disaster Recovery
(Windows 2000)

This chapter explains how to recover a Microsoft Cluster Server (MSCS) host

system in a Windows 2000 environment. Familiarity with MSCS concepts and

operations is assumed. For complete information about MSCS, refer to the

related Microsoft documentation.

The following scenarios are described in this chapter:

• “Recovering a Failed Quorum Disk” on page 146

• “Recovering One Cluster Node” on page 147

• “Recovering Multiple Cluster Nodes” on page 150

Prerequisites
To recover an MSCS host in a Windows 2000 environment, you must ensure

that each of the following prerequisites is satisfied:

• The NetWorker client is installed on each cluster node.

• Backups that include the SYSTEM save sets (SYSTEM FILES, SYSTEM

DB, and SYSTEM STATE) have been performed on a regular basis by a

NetWorker server host in the same domain as the cluster nodes. This will

help ensure that data is available from the NetWorker server for recovery

to the desired point in time. (The Microsoft cluster database is a

component of the Windows 2000 system state, and as such is

automatically included when the SYSTEM STATE save set is specified for

backup or recovery.)

• During the recovery, the domain controller (for the domain to which the

cluster nodes belong) is available to authenticate the node joining the

cluster.
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Recovering a Failed Quorum Disk
This section describes the procedure for recovering a failed quorum disk. The

procedure assumes the following:

• The quorum disk is designated for exclusive use by MSCS.

• The quorum disk resides in a drive array that is not a Redundant Array of

Inexpensive Disks (RAID).

• A spare disk (identical in type to the quorum disk) is available to replace

the failed disk. The spare disk contains at least as much total disk space as

the total space on the quorum disk.

• The new quorum disk is to be assigned the same drive letter as the failed

disk.

For related information, refer to Microsoft knowledge base article Q172944: How
to Change Quorum Disk Designation ID.

How to Recover a Failed Quorum Disk

To recover a failed quorum disk:

1. Close all instances of Microsoft Cluster Administrator.

2. Stop the cluster service on both nodes.

3. Use the Computer Management services facility to access the Cluster

Service Properties page. Change the Cluster Service Startup Type to

Manual on both nodes.

4. Shut down both nodes. Power down both nodes and the drive array.

5. Replace the failed quorum disk.

6. Power on both nodes and the drive array.

7. Format the new disk with the same file system, partitioning scheme, drive

letter, and label as the failed quorum disk. Verify that it appears identical

on both nodes.

8. On one node, use the Computer Management services facility to access the

Cluster Service Properties page.

9. Add -fixquorum as a start parameter and start the service.

10. Use Cluster Administrator to rename the failed quorum resource to

RemoveMe.

11. Create a new disk resource Disk x:  (where x is the drive letter of the old

quorum disk). Place the new disk resource in the Cluster Group.
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12. Bring this disk resource online.

13. Right-click the cluster name and select Properties.

14. Select the Quorum tab and make the new drive the quorum resource.

15. Use the Computer Management services facility to access the Cluster

Service Properties page:

a. Stop the service.

b. Remove -fixquorum as a start parameter.

c. Start the service.

16. Start the cluster service on the other node.

17. Delete the RemoveMe resource.

18. Bring the cluster group online.

19. Use the Computer Management services facility to access the Cluster

Service Properties page. Change the Cluster Service Startup Type to

Automatic on both nodes.

20. Reboot both nodes.

Recovering One Cluster Node
This section describes how to restore the Cluster Server and cluster database

in the event of failure of one of the cluster nodes.

Unexpected software behavior, such as corruption of a cluster-critical file, may

cause a partitioned cluster, in which one node of the cluster is unaware of the

presence of the other operating node. In this situation, each node may attempt

to take control of the shared quorum device, thus potentially rendering one

node unable to function as a member of the cluster.

How to Recover One Cluster Node

In the following scenario, Node_B has failed and the quorum resource has

successfully failed over to Node_A. The operating system on each cluster node

is intact and therefore does not require recovery. However, the status of the

MSCS component on Node_B is unknown; therefore the Cluster Server must

be reinstalled on Node_B.
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To recover a Microsoft cluster configuration:

1. Using Cluster Administrator on Node_A, evict Node_B from the cluster.

2. On Node_B, select Control Panel>Add/Remove Programs>Windows

Components. Uninstall the Cluster Service.

3. After the Cluster Server is uninstalled from Node_B, reboot the node.

4. From Node_B, log on as Administrator to the domain in which the cluster

nodes reside.

5. On Node_B, select Control Panel>Add/Remove Programs>Windows

Components, and select Cluster Server for installation.

This will reinstall the cluster binaries and start the cluster Setup Wizard.

Important: After reinstalling MSCS on Node_B, you will need to reproduce

the preexisting application environment on Node_B so that MSCS can

administer the applications as it was doing before the node failed. One way to

reproduce the old cluster-controlled application environment is to perform the

necessary disaster recovery procedures for each application that was

previously installed on the node.

6. During the Wizard setup, select "Join an existing cluster" and enter the

cluster name.

After the Wizard finishes on Node_B, go to Cluster Administrator on

Node_A. From Cluster Administrator on Node_A, ensure that Node_B

appears available for failover operations.

7. Only Node_A, the node that owns the shared resources, may be running

at the time of recovery of the cluster database. Therefore, stop the Cluster

Server service on Node_B using one of the following methods:

• On Node_B, go to Control Panel>Services and manually stop the

Cluster Service running on Node_B.

— or —

• On Node_B, run the command net stop clussvc from a command

prompt.

— or —

• Shut down Node_B.
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8. From the NetWorker User Recovery window on Node_A, mark at least the

SYSTEM STATE save set for recovery. The cluster database is a component

of the Windows 2000 system state, and as such is automatically included

when the SYSTEM STATE save set is specified for backup or restore.

Note: With NetWorker 5.7 (and later) for Windows 2000, the three SYSTEM

save sets are interdependent. It is safest to restore all of the SYSTEM save sets

whenever you need to restore any particular SYSTEM save set. For more

information, refer to the section on save set interdependencies in the NetWorker
6.1 Administrator’s Guide, Windows Version.

9. Click Start to begin the SYSTEM STATE recovery process.

10. After the SYSTEM STATE save set is restored, reboot Node_A.

11. Using Cluster Administrator on Node_A, confirm that the cluster

resources were restored to the point in time when the backup occurred. If

you have been performing regular scheduled backups using NetWorker,

this will recover the cluster database to a point in time shortly before the

loss of Node_B.

12. Start the cluster service on Node_B. To do so, at Node_B, run the command

net start clussvc from a command prompt, or use Computer

Management>Services.

13. From Cluster Administrator on Node_A, monitor the cluster joining status

of Node_B.

14. From Node_B, use Cluster Administrator to verify that the cluster group

can be moved between the nodes by right-clicking the group and selecting

Move group.

The cluster configuration should now have been recovered.
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Recovering Multiple Cluster Nodes
This section provides general guidelines for performing a cluster recovery in

the case of a failure of both cluster nodes. In this scenario, the operating system

is unusable on each node. Therefore, this recovery procedure includes

reinstallation of Windows 2000 on each node, as well as NetWorker recovery

of the cluster database from a previous backup.

Important: Because cluster configurations may vary, it is not possible to

provide cluster disaster recovery procedures for every situation. Depending

on the particular cluster configuration and the nature of the failure, it might be

necessary to vary some of the procedures described in this section.

How to Recover Multiple Cluster Nodes

To perform a complete cluster recovery in a situation in which both cluster

nodes, Node_A and Node_B, have failed:

1. On the system disk of each cluster node, reproduce the partition table

information that was in use prior to the loss of the node.

Note: On each cluster node, the repaired or replaced system disk must have the

same partition tables and drive letter configuration that were in place prior to

the node failure. However, enumeration of available volumes during

Windows 2000 text setup mode might cause the system disk drive letter to

change. Therefore, prior to reinstalling the Windows 2000 operating system,

disconnect the SCSI bus if the shared drives are being enumerated before the

local system drives.

2. Format and verify the system disk on each node.

3. On each node, reinstall Windows 2000 Advanced Server to the partition it

occupied before the node failure. During operating system setup on each

node, verify that the domain controller is available and that each potential

node is able to join.

4. Delete the MSCS folder on the quorum drive.

5. On the quorum disk, run chkdsk .
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6. While Node_B is still detached from the shared SCSI bus, start the MSCS

installation on Node_A from Control Panel>Add/Remove

Programs>Windows Components. The MSCS Cluster Wizard will appear

and provide guidance through the setup process.

7. During the setup process using Cluster Wizard, enter the same

configuration information that was used prior to the failure of the cluster

nodes (including user account, IP addresses, and cluster name).

8. Reboot Node_A.

9. Install MSCS on Node_B, joining A.

10. Reboot Node_B.

11. On Node_B, run the net stop clussvc  command from a command

prompt.

12. Install the NetWorker client software on Node_A.

13. From NetWorker User on Node_A, select the SYSTEM FILES and SYSTEM

STATE save sets to recover to the desired point in time prior to the cluster

failure. Click Start to begin the recovery process.

14. After the recovery on Node_A is complete, reboot Node_A.

15. On Node_A, run Cluster Administrator to confirm that the states of the

cluster resources were restored to the desired point in time.

16. Start the cluster service on Node_B. To do so, at Node_B, run the net
start clussvc  command from a command prompt, or use Computer

Management>Services.

17. From Cluster Administrator on Node_B, verify that the cluster group can

be moved between the nodes by right-clicking the group and selecting

Move group.

18. Re-install the NetWorker client software on Node_B.
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Chapter 10: Sun Cluster Disaster Recovery

This chapter explains how to recover one or more computers in a Sun® Cluster

environment.

Restoring a cluster following a disaster is similar to any NetWorker

restoration. The important difference is that you must synchronize the cluster

database data.

Important: Unsynchronized cluster databases produce unexpected and

unfavorable results. It is very important to ensure that the cluster databases

remain synchronized. Be sure to read and understand this entire section before

you attempt to restore a Sun cluster or cluster node.

The following scenarios are described:

• “Restoring a Single Cluster Node” on page 154

• “Restoring an Entire Cluster” on page 154
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Restoring a Single Cluster Node
This section describes how to restore a single cluster node. If a single node

within the cluster has failed, follow this procedure.

How to Restore a Single Cluster Node

To recover a single node:

1. Install NetWorker. For detailed installation and configuration

instructions, refer to the NetWorker 6.1 Installation Guide, Solaris Version.

2. Start the NetWorker client.

3. Using the cluster’s virtual NetWorker server running on an unaffected

node, restore the node's data and software from a recent backup. For

detailed instructions, refer to the NetWorker 6.1 Administrator’s Guide,
UNIX Version.

4. Copy the contents of the following directory from another node in the

cluster to the node that you are recovering:

/etc/opt/SUNWcluster/conf

This synchronizes the cluster database data.

Restoring an Entire Cluster
This section describes how to restore an entire cluster. It is unlikely that all the

nodes in a cluster would fail simultaneously; but if this does occur, follow this

procedure.

How to Restore an Entire Cluster

To recover an entire cluster, follow these procedures, explained in detail in the

following sections:

1. Install the software.

2. Restore the cluster.

3. Start the cluster.

4. Restore the data.
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Task 1: Install the Software

To install the software on a primary node:

1. Configure the hardware and install the operating system.

2. Reinstall the Sun Cluster software. For detailed instructions, refer to the

Sun Cluster Installation Guide. Run the scinstall  command (on the Sun

Cluster installation CD) to reinstall the cluster software.

3. Install the NetWorker software. For detailed instructions, refer to the

NetWorker 6.1 Installation Guide, Solaris Version.

Task 2: Restore the Cluster

Redefine the virtual host and disksets for the cluster. To aid in this, you can

recover the old configuration files to a different directory.

• If you know where the latest save set files are located, use the following

command to recover the latest configuration files:

scanner -S saveset_id device_path -x uasm -rv -m
/etc/opt=/etc/opt.backup

• If you do not know the save set ID, use the scanner device_path
command to determine its value:

scanner device_path > /tmp/savefile 2>&1

Task 3: Start the Cluster

1. Run the following command to create the first node in the cluster:

scadmin startcluster local-node cluster-name

Important: Depending on the nature of the disaster from which you are

recovering, you might have several versions of the cluster database (up to a

maximum of one for each cluster node). If the first database retrieved is badly

out of sync, then remove that node from the cluster--thereby deleting the

cluster definition--and start with a different cluster node.
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2. To add nodes to the cluster, enter the following for each additional node:

scadmin startnode clustname

3. Run the /usr/sbin/NetWorker.cluster script on each node in the cluster.

For more information, refer to the NetWorker 6.1 Installation Guide, Solaris
Version.

Task 4: Restore the Data

On the primary node:

1. Use the mmrecov command to restore the media database and resource

files.

2. Use the nsrck -L7  command to restore the indexes.

3. Use the recover  command to recover the initialization directories.

For detailed instructions on using the recover, nsrck, or mmrecov
commands, refer to the NetWorker 6.1 Administrator’s Guide, UNIX Version.
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Chapter 11: Compaq Cluster Disaster Recovery

This chapter explains how to recover one or more computers in a Compaq®

TruCluster™ Server, releases 1.5 or 1.6 cluster. The following scenarios are

described:

• “Recovering All Nodes in the Cluster” on page 158

• “Recovering the Virtual Servers” on page 159

• “Performing a Cluster Wide Recovery” on page 160

Prerequisites
When preparing or planning for a disaster, such as a single node or entire

cluster failure, you must record the following information:

• Network settings for every node in the cluster

• Partition information for the disk drives in your system

This information must be entered manually because the NetWorker software

cannot configure it automatically.

How to Prepare a Cluster for Disaster Recovery

To ensure that your cluster is disaster-ready:

1. Create client resources for each physical and virtual node in the cluster.

2. Enter the associated filesystems in the client resource of each node in the

cluster.

3. Ensure that the client resources of the physical nodes have only the private

(or local) filesystems defined in the save set list. Private filesystems are

those filesystems that are not dependent on a cluster service for mounting.
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4. Ensure that the clients resources of the virtual services have the public

(shared) filesystems defined in the save set list. Public filesystems are disk

partitions mounted by a cluster service.

5. Add all the physical nodes to the Remote Access field of the client

resources of each virtual node.

6. Create a NetWorker group to which you add all the client resources you

have defined and schedule this group for regular backups.

7. Perform at least one full backup in preparation for disaster recovery.

Recovering All Nodes in the Cluster
This section explains how to recover one or more physical nodes in a cluster.

The solution is to completely reinstall the operating system, cluster software

and NetWorker software on as many nodes as have failed and then use the

NetWorker software to recover the cluster database from a previous backup.

How to Recover All Nodes in the Cluster

To recover all nodes in a cluster, follow these procedures, explained in detail in

the following sections:

1. Recover nodes in the cluster.

2. Recover the private filesystems of each node.

Task 1: Recover Nodes in the Cluster

To recover one or more failed nodes within a cluster:

1. Replace all defective equipment with the same model equipment as was

previously installed. Connect all the equipment as it was connected prior

to the disaster.

2. Install the operating system on all nodes that failed in the cluster.

3. Partition the drives with the same partitions you had used previously.

Each partition must be equal to or greater than the size used before the

disaster occurred.
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4. Configure the network settings so that the nodes in the cluster can access

the remote NetWorker server. If your NetWorker server was local, refer to

“Chapter 3: Windows NT 4.0/UNIX Disaster Recovery” on page 27 for

the appropriate disaster recovery procedure.

5. Install the NetWorker client software on each node in the cluster. If you

need to recover your server software, refer to “Chapter 3: Windows NT

4.0/UNIX Disaster Recovery” on page 27.

Task 2: Recover the Private Filesystems of Each Node

To recover the private filesystems of each node:

1. Log in to the console of each node that had failed and enter the following

commands to start the recovery:

cd /

recover -s NetWorker-server

recover>  add *

recover> force

recover> recover

2. Reboot each recovered node in the cluster.

If the cluster database has changed since the last backup of this node, you

must rebuild it using ASE setup. Refer to the Compaq TruCluster Server
Administrator’s Guide for further information regarding ASE setup.

Recovering the Virtual Servers
This section explains how to recover the public filesystems within a cluster.

How to Recover the Virtual Servers

To recover the public filesystems:

1. Shut down all systems.

2. Boot one node after you have shut down all nodes.

3. Using the Cluster Administration Tool (asemgr), relocate all the services to

run on the node you have booted.

If a service fails to start, you need to manually mount the disk service

associated with that service.
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4. Enter the following commands to recover each virtual server that you

have defined:

cd /

recover -s NetWorker-server -c virtual-server

recover> add *

recover> force

recover> recover

5. Boot the remaining nodes in the cluster and restart all cluster services.

Performing a Cluster Wide Recovery
To perform a cluster wide recovery, you must complete the steps outlined in

the previous sections:

• “Recovering All Nodes in the Cluster” on page 158

• “Recovering the Virtual Servers” on page 159



Legato NetWorker, Release 6.1
Disaster Recovery Guide 161

Chapter 12: HP-UX Cluster Disaster Recovery

This chapter explains how to recover one or more computers in a HP-UX

MC/ServiceGuard cluster environment. The following scenarios are

described:

• “Recovering a Single Cluster Node”

• “Performing a Cluster Wide Recovery” on page 162

Recovering a Single Cluster Node
This section describes how to restore a cluster server on one node. This

scenario assumes that the operating system on the participating nodes has

failed and must be reinstalled.The functionality of the MC/ServiceGuard

component on the node is also in question.

How to Recover a Single Cluster Node

To recover a single node:

1. Install the operating system and the cluster software. Configure the

volume groups.

2. Add the node to the cluster:

a. Click Cluster in the System Administration Manager (SAM).

b. Select High Availability Clusters>Cluster Administration>Specify

Nodes to Join Cluster.

Note: You can also use the cmrunnode command instead of SAM.

3. Recover the node’s data from a recent backup.
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Performing a Cluster Wide Recovery
This section explains how to perform a complete cluster recovery, including

reinstallation of the operating system on all nodes. It also explains how to

recover the associated cluster database.

This procedure assumes a worst case scenario where one node of a two-node

cluster has completely failed, followed shortly by the second node failing. The

only solution is to reinstall the operating system, cluster software, and

NetWorker software on both nodes and then to use NetWorker to recover the

cluster database from a previous backup.

How to Perform a Cluster Wide Recovery

To perform a complete cluster recovery:

1. Install the operating system and cluster software on each node.

2. Install the NetWorker software as required within the HP-UX

MC/ServiceGuard cluster environment. For detailed instructions, refer to

the NetWorker 6.1 Installation Guide, HP-UX Version.

3. Select any node in the cluster and run the NetWorker server and client on

that node.

4. Re-create the configuration of the cluster and the configuration and

control files for the NetWorker package. The cluster configuration file is

usually in /etc/cmcluster and the NetWorker package configuration and

control files are usually located in the /etc/cmcluster/NetWorker directory.

• If you know where the latest save sets are located, use the scanner
command to restore the configuration files. For example:

scanner -S saveset_id device-path | uasm -i y -rv

• If you do not know the save set id, use the scanner device_path
command to determine the saveset id. For example:

scanner device-path > /tmp/savefile 2>&1

5. Run the NetWorker /opt/NetWorker/bin/NetWorker.cluster script.

Do not re-create the files legato.control and pkg.control when prompted by

the NetWorker.cluster script.

6. If the shared disk has to be replaced, configure the disk and file system of

the replacement.
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7. Create the file system. For example:

vgchange -c n /dev/vg03

vgchange -a y /dev/vg03

newfs -F hfs /dev/vg03/rlvol1

vgchange -a n /dev/vg03

8. Enter the following command to delete the existing cluster and package

configurations:

cmdeleteconf -c cluster1

9. Enter the following command to apply the cluster and package

configurations, including the NetWorker package, to all the nodes within

the cluster:

cd /etc/cmcluster

cmapplycomf -C cluster1.ascii -P networker/pkg.conf \
-P other_pkg/other_pkg

Note: It is advisable to run the cmgetconf command to save the new cluster or

package ASCII configuration file whenever the cluster or a package

configuration is created or modified. For example:

cmgetconf -c cluster1 cluster1.ascii

cmgetconf -p networker pkg.conf

These ASCII files can be saved in the /etc/cmcluster directory of a node.

Make sure that the NetWorker software backs up /etc/cmcluster so that the

configurations can be restored using cmapplyconf whenever necessary.

10. Activate the cluster. For example:

cmruncl

This should also start the NetWorker package.

11. Perform disaster recovery on the shared disk using mmrecov and recover.
For further information explaining how to perform a disaster recovery,

refer to the NetWorker 6.1 Administrator’s Guide, UNIX Version.
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Whenever you have to shut down NetWorker at this stage, use cmhaltpkg
and not nsr_shutdown. For example:

cmhaltpkg networker

exchange -a c /dev/vg03

mount /dev/vg03/lvol1 /vg031

mv /vg031/nsr/res /vg031/nsr/res.old

mv /vg031/nsr/res.R /vg031/nsr/res

umount /vg031

vgchange -a n /dev/vg03

cmmodpkg -e networker (to restart NetWorker package)

12. Recover the clients' data from recent backups.
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Chapter 13: Legato Cluster for AIX, HP-UX,
Linux, and Solaris Disaster Recovery

This chapter explains how to recover one or more computers in a Legato

Cluster™ for AIX®, HP-UX®, Linux®, and Solaris™ environment. The

following topics are described:

• “Recovering a Single Cluster Node”

• “Performing a Cluster Wide Recovery” on page 168

• “Renaming the Resource Directory” on page 174

Recovering a Single Cluster Node
This section describes how to recover a failed node within a cluster. This

scenario assumes that the operating system on the participating nodes is intact

and will not be recovered. The functionality of the Legato Cluster component

on the node is in question.

How to Recover a Single Cluster Node

To recover a single node:

1. Install the NetWorker software. For detailed installation and configuration

instructions, refer to the appropriate NetWorker 6.1 Installation Guide.

2. Start the NetWorker client.

3. Using the cluster’s virtual NetWorker server running on an unaffected

node, restore the node's data and software from a recent backup. For

detailed instructions, refer to the NetWorker 6.1 Administrator’s Guide,
UNIX Version.
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4. Make sure that the following directories have been restored:

AIX

• /etc/rc*

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

HP-UX

• /etc/rc*

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

Linux

• /etc/rc*.d

• /etc/init.d

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

Solaris

• /etc/init.d

• /etc/rc0.d

• /etc/rc1.d

• /etc/rc2.d

• /etc/rc3.d

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName
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5. Restore or copy the following files from the active node:

AIX

• $FT_DIR/bin/envsh ($FT_DIR/bin/envcsh if using C shell)

• /usr/bin/nw_ux.lc

HP-UX

• $FT_DIR/bin/envsh ($FT_DIR/bin/envcsh if using C shell)

• /opt/networker/bin/nw_ux.lc

Linux

• $FT_DIR/bin/envsh ($FT_DIR/bin/envcsh if using C shell)

• /usr/sbin/nw_ux.lc

Solaris

• $FT_DIR/bin/envsh ($FT_DIR/bin/envcsh if using C shell)

• /usr/sbin/nw_ux.lc

6. Start the cluster virtual server on the node. For example:

cd $FT_DIR/bin  (or source ./envcsh  if using C shell)

. ./envsh

./ft_startup -domain DomainName

If the virtual server fails to start on the node because of an outdated sites

file, copy the following file from the active node:

$FT_DIR/config/DomainName-sites

7. Run the networker.cluster script. For example:

AIX: /usr/bin/networker.cluster

HP-UX: /opt/networker/bin/networker.cluster

Linux: /usr/sbin/networker.cluster

Solaris: /usr/sbin/networker.cluster

If you have already restored or copied the nw_ux.lc file from an active

node, answer no to the following prompt:

Do you wish to automatically add site-specific values for:

NSR_SHARED_DISK_DIR and NSR_SERVICE_ID in

/LegatoCluster_ installation_ directory

Yes or No [Yes]?  no
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Performing a Cluster Wide Recovery
This section describes how to perform a complete cluster recovery including

reinstallation of the operation system on all nodes participating in the cluster.

How to Perform a Cluster Wide Recovery

To perform a cluster wide recovery, follow these procedures, explained in

detail in the following sections:

1. Install the software.

2. Restore the cluster.

3. Configure the NetWorker software as a highly available application.

4. Restore the data.

5. Start the cluster software on each node.

This procedure assumes a worst case scenario: where one node of a two-node

or more cluster lost contact and completely failed, followed shortly by the

second node completely failing. This is a total loss of both cluster nodes.

Task 1: Install the Software

To install the software, on a primary node:

1. Configure the hardware and install the operating system.

2. Install the Legato Cluster software. For detailed instructions, refer to the

Legato Cluster Installation Guide.

3. Install the NetWorker software. For detailed instructions, refer to the

appropriate NetWorker 6.1 Installation Guide.

4. Make sure that the NetWorker client and server software are running

locally.
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Task 2: Restore the Cluster

1. Determine the save set id that contains the platform configuration and

system files listed below:

If you do not know the save set id, enter the scanner device_path
command to determine its value:

scanner device_path > /tmp/savefile 2>&1

AIX

• /usr/bin/nw_ux.lc

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

• $FT_DIR/bin/envsh (envcsh for C-shell)

HP-UX

• /opt/networker/bin/nw_ux.lc

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

• $FT_DIR/bin/envsh (envcsh for C-shell)

Linux

• /usr/sbin/nw_ux.lc

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

• $FT_DIR/bin/envsh (envcsh for C-shell)

Solaris

• /usr/sbin/nw_ux.lc

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/DomainName_NodeName

• $FT_DIR/bin/envsh (envcsh for C-shell)

Note: $FT_DIR is the install location for the Legato Cluster software.
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2. On the primary node, enter the scanner command to restore the following

configuration files:

scanner -S saveset_id device_path -x uasm -rv -i Y path_name

Note: The path_name variable represents the platform configuration and system

files listed in Step 1.

Task 3: Configure NetWorker as a Highly Available Application

On the primary node, configure the NetWorker software as a highly available

application:

1. Run the envsh script. For example:

AIX

cd /usr/lpp/LGTOlcxx/bin

. ./envsh (or source ./envcsh if using C shell)

HP-UX

cd /opt/LGTOlcxx/bin

. ./envsh (or source ./envcsh if using C shell)

Linux

cd /opt/LGTOlcxx/bin

. ./envsh (or source ./envcsh if using C shell)

Solaris

cd /opt/LGTOlcxx/bin

. ./envsh (or source ./envcsh if using C shell)

2. Run the networker.cluster script.

If you have already restored the nw_ux.lc file, answer no to the following

prompt:

Do you wish to automatically add site-specific values for:

NSR_SHARED_DISK_DIR and NSR_SERVICE_ID in
/LegatoCluster_ installation_ directory

Yes or No [Yes]?  no

3. Start the cluster virtual server: For example:

$FT_DIR/bin/ft_startup -domain DomainName

4. Use the Legato Cluster Console to start the NetWorker resource group.
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Task 4: Restore the Data

The procedures to restore the data on the primary and each of the remaining

nodes in the cluster differ. For more information, see the following sections:

• “On the Primary Node” on page 171

• “On Each of the Remaining Nodes in the Cluster” on page 172

On the Primary Node

To restore data on the primary node:

1. Use the mmrecov command to restore the indexes, media database, and

resource files.

2. Use the recover command to recover the following initialization

directories:

AIX

• /etc/rc*

HP-UX

• /etc/rc*

Linux

• /etc/init.d

• /etc/rc*.d

Solaris

• /etc/init.d

• /etc/rc0.d

• /etc/rc1.d

• /etc/rc2.d

• /etc/rc3.d

For detailed instructions on using the recover and the mmrecov
command, refer to the NetWorker 6.1 Administrator’s Guide, UNIX Version.
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On Each of the Remaining Nodes in the Cluster

To restore data on each of the remaining node in the cluster:

1. Install NetWorker software and run the NetWorker client.

2. Recover the data and software from recent backups or from the product

installation CD-ROMs.

3. Using the virtual NetWorker server, recover the following files:

• $FT_DIR/config/*

• $FT_DIR/log/*

• $FT_DIR/ DomainName_NodeName

4. Recover or copy the following files from the active node:

AIX

• /usr/bin/nw_ux.lc

• $FT_DIR/bin/envsh (envcsh for C-shell)

HP-UX

• /opt/networker/bin/nw_ux.lc

• $FT_DIR/bin/envsh (envcsh for C-shell)

Linux

• /usr/sbin/nw_ux.lc

• $FT_DIR/bin/envsh (envcsh for C-shell)

Solaris

• /usr/sbin/nw_ux.lc

• $FT_DIR/DomainName_NodeName

• $FT_DIR/bin/envsh (envcsh for C-shell)

For detailed instructions on using the recover and the mmrecov
commands, refer to the NetWorker 6.1 Administrator’s Guide, UNIX Version.
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Task 5: Start the Cluster Software on Each Node

On each of the remaining nodes in the cluster:

1. Start the cluster virtual server. For example:

cd $FT_DIR/bin

. ./envsh

./ft_startup -domain DomainName

If the virtual server fails to start on the node because of an outdated sites

file, copy the following file from the active node:

$FT_DIR/config/ DomainName-sites

2. Run the networker.cluster script.

If you have already restored or copied the nw_ux.lc file from the active

node in step 3, answer no to the following prompt:

Do you wish to automatically add site-specific values for:

NSR_SHARED_DISK_DIR and NSR_SERVICE_ID in
/LegatoCluster_ installation_ directory

Yes or No [Yes]?  no

3. Repeat the steps 1 and 2 above for each node in the cluster.
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Renaming the Resource Directory
This section describes how to rename the resource directory. While performing

a disaster recovery on a shared disk, you might need to rename the resource

directory.

To rename the resource directory:

1. Use the Legato Cluster Console to stop the NetWorker resource group.

2. Use the Legato Cluster Console to activate and mount the following:

a. If using the Logical Volume Manager, activate the volume group by

bringing the logical volume group datasource online.

b. Mount the shared disk (that contains the shared nsr directory) by

bringing the shared disk datasource on-line.

Note: You can also activate and mount the logical volume group and the

shared disk using UNIX commands.

3. Move the newly recovered resource directory nsr/res.R to the current

resource directory. For example:

mv /nsr_shared_mnt_pt/nsr/res /nsr_shared_mnt_pt/
nsr/res.old

mv /nsr_shared_mnt_pt/nsr/res.R /nsr_shared_mnt_pt/
nsr/res

4. In the reverse order, take the data sources (logical volume group and the

shared disk) offline that you used in step 2.

5. Use the Legato Cluster Console to start the NetWorker resource group.
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Chapter 14: Legato Cluster for Windows
Disaster Recovery

This chapter explains how to recover one or more cluster nodes in a Legato

cluster for Windows NT or Windows 2000 environment. It contains the

following sections:

• “Recovering a Single Cluster Node”

• “Performing a Disaster Recovery (Entire Cluster)” on page 176

Recovering a Single Cluster Node
This section describes how to recover a failed node within a cluster. The failed

node is Node_B.

In the examples in this chapter, the backup devices are local tape drives.

To recover a single cluster node:

1. Reinstall the operating system, ensuring that it is configured identically to

the way it was configured before Node_B failed. Use the same drive letters

for the disk volumes as those that were used prior to the failure. Local

drive letters should not conflict with drive letters assigned to the shared

disk.

2. Install and configure backup devices.

3. Reinstall the NetWorker client software on Node_B. For detailed

installation and configuration instructions, refer to the NetWorker 6.1
Installation Guide, Windows Version, available for download from the

Legato web site, www.legato.com.

4. Start the NetWorker User (client) software.
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5. Select, mark, and recover all items on the node, including the Legato

Cluster software and data. Be sure to select and mark the cluster’s shared

drive so that it is included in the recover operation.

For detailed instructions about performing recover operations, refer to the

NetWorker 6.1 Administrator’s Guide, Windows Version, available for

download from the Legato web site, www.legato.com.

Performing a Disaster Recovery (Entire Cluster)
This section describes how to perform a disaster recovery; that is, a recovery of

both cluster nodes and the cluster’s shared drive.

Prerequisites

Re-install the operating system and the NetWorker software on each cluster

node.

How to Perform a Disaster Recovery

To perform a cluster wide recovery:

1. First, on the primary cluster node, complete:

a. “Task 1: Reinstall Operating System and NetWorker Software” on

page 177.

b. “Task 2: Recover the Cluster Nodes” on page 177.

2. Repeat the tasks on the secondary node.

Important: As you perform the disaster recovery, be sure to duplicate exactly

the original designations for all configured devices, including drives, servers,

virtual servers and Legato cluster domain names, including those for the

shared disk.

In our examples, the backup devices for the cluster are tape devices. The tape

devices must be connected locally to each node when the node is recovered.
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Task 1: Reinstall Operating System and NetWorker Software

To reinstall software:

1. Configure the hardware identically to the way it was configured before the

cluster node failed.

2. Install the operating system.

3. To ensure an error-free recovery, delete information on the Legato

Cluster’s shared disk.

4. Install the Legato Cluster software. For detailed instructions, refer to the

Legato Cluster Installation Guide, available for download from the Legato

web site, www.legato.com.

5. Install the NetWorker software:

a. Install the NetWorker server software.

b. Configure the NetWorker server as cluster-aware.

c. Add and configure the backup devices.

For detailed instructions for performing steps a, b and c, refer to the

NetWorker 6.1 Installation Guide, Windows Version, available for download

from the Legato web site, www.legato.com.

Task 2: Recover the Cluster Nodes

This section provides instructions for recovering both cluster nodes and the

cluster’s shared disk.

1. If you know the NetWorker save set ID number for the bootstrap file, skip

this step.

If you do not know the NetWorker save set ID number for the bootstrap

file, use the scanner -B command to display it, and note it so that you can

enter it later.

The scanner -B command must be executed on the computer that the

bootstrap is installed on; otherwise it won't work.

For detailed information about the scanner -b command, refer to the

Legato Command Reference Guide, available for download from the Legato

web site, www.legato.com.
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To use the scanner -B command, enter:

scanner -B \\.\ device_name

After you enter the command, the following messages appear:

scanner -B \\.\Tape0

scanner: no `NSR device' with the name of `\\.\Tape0' found

scanner: scanning 4mm tape trail.001 on \\.\Tape0

scanner: done with 4mm tape trail.001

scanner: Bootstrap 4171575297 of 10/26/00 14:42:08 located
on volume trail.001, file 36.

C:\>

2. To recover the media database and resource configuration files, run the

mmrecov command as follows:

mmrecov

Note: Be sure to run mmrecov on the node that currently owns the

NetWorker server resources.

For detailed information about the mmrecov command, refer to the Legato
Command Reference Guide, available for download from the Legato web

site, www.legato.com.

After you enter the command, screen messages similar to those shown

below appear, and you are prompted to enter information. When you are

prompted for the starting file and record numbers, you can accept the

defaults by pressing the [Enter] key.

These advisories appear:

mmrecov: Using clarks as server

NOTICE: mmrecov is used to recover the NetWorker server's
media index and resource files from media (backup tapes or
disks) when any of this critical NetWorker data has been
lost or damaged. Note that this command will OVERWRITE the
server's existing media index. mmrecov is not used to
recover NetWorker clients' on-line indexes; normal recover
procedures may be used for this purpose. See the Legato
NetWorker Disaster Recovery Guide for more details.

rd=clarks:\\.\Tape0

rd=lewiss:\\.\Tape0

What is the name of the device you plan on using
[rd=clarks:\\.\Tape0]?

Enter the latest bootstrap save set id:  4171575297
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Enter starting file number (if known) [0]:

Enter starting record number (if known) [0]:

Please insert the volume on which save set id 4171575297
started into rd=clarks:\\.\Tape0. When you have done this,
press <RETURN>:

Scanning rd=clarks:\\.\Tape0 for save set 4171575297; this
may take a while...

scanner: scanning 4mm tape trail.001 on
rd=clarks:\\.\Tape0

Q:\nsr\res.R\nsr.res

Q:\nsr\res.R\nsrjb.res

Q:\nsr\res.R\nsrla.res

scanner: ssid 4171575297: scan complete

scanner: ssid 4171575297: 47 KB, 6 file(s)

Q:\nsr\res.R\

Q:\nsr\mm\

rd=clarks:\\.\Tape0: Mount operation in progress

rd=clarks:\\.\Tape0: verifying label, moving backward 2
file(s)

rd=clarks:\\.\Tape0: mounted 4mm tape trail.001 (write
protected)

3. As the mmrecov process finishes, advisory messages show on the screen.

Detailed information regarding the advisories appears in steps 3a - 3d. The

advisories are as follows:

If your resource files were lost, they are now recovered
in the 'res.R' directory. Copy or move them to the 'res'
directory, after you have shut down the service. Then
restart the service. Otherwise, just restart the service.

If the on-line index for clarks was lost, it can be
recovered using the nsrck command.

C:\>

a. Take the cluster resource group offline:

In the Legato Cluster Enterprise Console, double-click on the

NetWorker resource group. The Resource Group Editor dialog box

appears. Click the Take Group Offline button.
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Open the Services window (Start>Settings>Control Panel>Services)

to stop the NetWorker Remote Exec Service, and check to be sure that

the NetWorker Backup and Recovery Server services are stopped.

b. In the nsr folder on the cluster’s shared disk, find the res folder and

the res.R folders. Copy the contents of the res.R folder into the res
folder, overwriting identically named files.

c. In the Resource Group Editor window, select one of the cluster node

groups and then select Bring Group Online.

d. In the NT Services window, check to be sure the Remote Exec Service

and the Backup and Recover Server service were restarted when you

brought the resource group online; if they were not, start them.

4. To recover the client indexes for the cluster nodes and the shared volume,

enter:

nsrck -L7

As the indexes are recovered, the following messages appear:

nsrck -L7

index for 'lewiss'

The file index for client 'lewiss' will be recovered.

Recovering index save sets of 'lewiss' from 'trail'

Recover completion time: Fri Oct 27 14:08:43 2000
completed recovery of index for client 'lewiss'

Q:\nsr\index\lewiss contains 6269 records occupying 663 KB

checking index for 'trail'

The file index for client 'trail' will be recovered.

Recovering index save sets of 'trail' from 'trail'

Recover completion time: Fri Oct 27 14:09:20 2000
completed recovery of index for client 'trail'

Q:\nsr\index\trail contains 65 records occupying 8 KB

checking index for 'clarks'

The file index for client 'clarks' will be recovered.

Recovering index save sets of 'clarks' from 'trail'

Recover completion time: Fri Oct 27 14:10:09 2000
completed recovery of index for client 'clarks'

Q:\nsr\index\clarks contains 6268 records occupying 658 KB

Completed checking 3 client(s)
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5. From a Windows command prompt, start NetWorker User, using the

winworkr command and the switch for the virtual server that you are

restoring:

winworkr -s virtual_server_name

6. Click the Recover button to open the Recover view.

In the Recover view, select the following:

– boot drive

– system state object

– all the data on the cluster node

– shared volume.

Click the Mark button to mark each selection for the recover operation.

For more detailed information about recovering the system save sets, refer

to “Chapter 4: Windows 2000 Disaster Recovery” on page 61.

Click the Recover button to start the recover operation.

7. When the recover operation is complete on the primary node, repeat the

disaster recovery steps on the secondary node.

Troubleshooting the Disaster Recovery
If the recovery does not succeed and there is a message saying there are no

client indexes, use the scanner -i command on each node to perform the client

index recovery again. Enter:

scanner -i rd= virtual_server_name:\\.\ <device_name>

The scanning operation can take a long time to complete. After it is complete,

repeat steps 5 and 6 above.
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Chapter 15: HACMP for AIX Disaster Recovery

This chapter explains how to recover one or more computers in a High

Availability Cluster Multi-Processing for AIX (HACMP for AIX) environment.

The following topics are described:

• “Restoring a Single Node”

• “Restoring an Entire Cluster” on page 184

For detailed installation and configuration instructions, refer to the following

documentation:

• NetWorker 6.1 Installation Guide, AIX Version

• NetWorker 6.1 Administrator’s Guide, UNIX Version

• HACMP for AIX documentation

Restoring a Single Node
This section describes how to recover a failed node within a cluster. This

situation assumes that the operating system on the participating nodes is

intact and will not be recovered. The functionality of the HACMP for AIX

component on the node is in question.

Restoring a cluster following a disaster is similar to any NetWorker software

restoration. The important difference is that you must synchronize the data in

the cluster database.
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How to Recover a Single Node

To recover a single node:

1. Install the NetWorker software.

2. Start the NetWorker client.

3. From an unaffected node in the cluster, use the virtual NetWorker server

to restore the node's data and software from a recent backup.

4. From an unaffected node in the cluster, use the SMIT utility to

synchronize the cluster topology and resources.

Restoring an Entire Cluster
This section describes how to perform a complete cluster recovery including

reinstallation of the operating system on all nodes participating in the cluster.

Note: It is unlikely that all the nodes in a cluster would fail simultaneously; but

if this does occur, follow this procedure.

How to Perform a Cluster-Wide Recovery

To perform a cluster-wide recovery, follow these procedures, explained in

detail in the following sections:

1. Install the software on the primary node.

2. Restore the cluster database.

3. Start the cluster.

4. Restore the data.

Task 1: Install the Software

To install the software on a primary node:

1. Configure the hardware and install the operating system.

2. Reinstall the HACMP for AIX software.

3. Install the NetWorker software.
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Task 2: Restore the Cluster Database

To restore the cluster database:

1. From all nodes in the cluster, make sure that all cluster software is halted.

2. From one node in the cluster:

a. Determine the save set id that contains the following configuration

directories:

– /etc/objrepos

– /usr/sbin/cluster/etc/objrepos

If you do not know the save set id, enter the scanner device_path
command to determine its value:

scanner device_path > /tmp/savefile 2>&1

b. Enter the following scanner commands to restore the cluster

database:

scanner -S saveset_id device_path -x uasm -i Y -rv
/etc/objrepos

scanner -S saveset_id device_path -x uasm -i Y -rv
/usr/sbin/cluster/etc/objrepos

3. From the restored node in the cluster, use the SMIT utility to synchronize

the cluster topology and databases.

Task 3: Start the Cluster

To start the cluster:

1. Use the SMIT utility to bring up all nodes within the cluster.

2. Run the /usr/bin/NetWorker.cluster script on each node in the cluster.

Task 4: Restore the Data

To restore the data from the primary node:

1. Use the mmrecov command to restore the media database and resource

files.

2. Use the nsrck -L7 command to restore the indexes.

3. Use the recover command to recover the initialization directories.
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Glossary

This glossary provides definitions for terms used in this guide.

ACL An abbreviation for access control list. This is a list

that specifies the permissions assigned to a specific file

or directory.

To recover a file that has an associated ACL, you must

either be logged into the system as root, as

Administrator, or as the file’s owner.

active group A NetWorker backup group that has its Autostart

attribute enabled.

administrator The person normally responsible for installing,

configuring, and maintaining NetWorker software.

Administrators
group

A Windows NT and Windows 2000 user group whose

members have all the rights and abilities of users in

other groups, plus the ability to create and manage all

the users and groups in the domain. Only members of

the Administrators group can modify Windows NT

and Windows 2000 operating system files, maintain

the built-in groups, and grant additional rights to

groups.

agent The term used to denote a cluster server. Also known

as a logical server (Compaq), a package (HP-UX), and

a virtual server (Microsoft).
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annotation A comment that you associate with an archive save set

to help identify that data later. Annotations are stored

in the media index for ease of searching and are

limited to 1,024 characters.

archive The process by which NetWorker software backs up

directories or files to an archive volume and then

grooms them to free disk space. When data is

archived, it is written to one or more storage volumes

and then marked so that it is never subject to

automatic recycling. You can delete the archived files

from the client, thus freeing disk space. See also

grooming.

archive clone pool A pool composed exclusively of archive clone save

sets.

archive pool A volume pool composed exclusively of archive save

sets. Archived save sets are in a different format than

regular backup save sets, and must be maintained on

separate media.

archive volume A tape or other storage medium used to store

NetWorker archive data, as opposed to a backup
volume.

ASM An abbreviation for application-specific module. An

ASM is a program that, when used in a directive,

specifies the way that a set of files or directories is to

be backed up and recovered. For example,

compressasm is a NetWorker directive used to

compress and decompress files.

ASM
specification

A directive that specifies how files or directories with

a matching pattern are backed up. This specification

appears in the form [+] ASM [args ...]: pattern ...

For more information, refer to the nsr_5 man page or

the Legato Command Reference Guide.

attribute A feature of a resource. It is a service or information

that the resource provides.

authorization
code

A code that is unique to your network that unlocks the

software for permanent use.
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autochanger A mechanism that uses a robotic arm to move media

among various components located in a device,

including slots, media drives, media access ports, and

transports. Autochangers automate media loading

and mounting functions during backup and recovery.

The term autochanger refers to a variety of robotic

libraries, including autoloader, carousel, datawheel,

jukebox, library, and near-line storage.

auto media
management

A feature that enables the storage device controlled by

the NetWorker server to automatically label, mount,

and overwrite a volume it considers unlabeled.

Volumes that are eligible for reuse are also

automatically recycled.

backup The writing of saved data to a volume.

backup cycle The period of time from one level full backup to the

next level full backup.

backup group See group.

backup level See level.

Backup Operators
group

A group of Windows NT or Windows 2000 users who

can log on to a domain from a computer or a server,

back it up, and restore the data. Backup operators can

also shut down servers or computers.

backup volume A tape or other storage medium used to store

NetWorker backup data, as opposed to an archive

volume.

base enabler code See enabler code.

bootstrap A save set that is essential for the NetWorker disaster

recovery procedures. The bootstrap is composed of

three components that reside on the NetWorker

server: the media database, the resource database, and a

server index.

browse policy A policy that determines how long entries for your

backup data remain in the client file index.
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carousel A tray or tape cartridge that holds multiple backup

volumes.

client A computer that accesses the NetWorker server to

back up or recover files. Clients may be workstations,

computers, or fileservers.

client file index A database of information maintained by the

NetWorker server that tracks every database object,

file, or filesystem backed up. The NetWorker server

maintains a single client index file for each client

computer.

client-initiated
backup

See manual backup.

clone The NetWorker process used to make an exact copy of

saved data (save sets). You can clone individual save

sets or the entire contents of a backup volume.

Cloning is different from a simple copy operation

carried out on an operating system or hardware

device. It is indexed and tracked by NetWorker

software in both the client file index and the media
database.

clone pool A pool of volumes composed exclusively of cloned

data. Three types of clone pools can be used: backup

clone, archive clone, and migration clone. Save sets of

different types (for example, archive and migration)

cannot be intermixed on the same clone volume.

clone volume A volume belonging to a clone pool.

cluster Two or more nodes that are connected and appear to

network users as a single, highly available system. A

highly available system allows the application

services to continue despite most hardware or

software failures.

connection port The port NetWorker processes use to perform backup

and recovery sessions through a firewall.
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consolidate To create a complete backup of a save set by merging

the most recent level 1 save set with its corresponding

full level save set. For more information, refer to the

nsrssc man page or the Legato Command Reference
Guide.

continued save
set

Data associated with a save set that is continued from

a previous volume. Continued save sets are created by

the backup server when large save sets are being

backed up, cloned, or archived to multiple volumes.

daemon A program that lies dormant waiting for a specified

condition to occur.

datawheel See autochanger.

device 1. A storage unit that reads from and writes to storage

volumes (see volume). A storage unit can be a tape

device, optical drive, autochanger, or file connected to

the server or storage node.

2. When Dynamic Drive Sharing (DDS) is enabled,

refers to the access path to the physical drive.

DFS component An abbreviation for Distributed File System root or

child node. DFS is a Microsoft add-on for Windows

NT 4.0 Server (Alpha or Intel) or Windows 2000 that

allows you to create a logical directory of shared

directories that span multiple machines across a

network.

directed recover A method of recovery that recovers data that

originated on one client computer and re-creates it on

another client computer.

directive An instruction that directs the NetWorker software to

take special actions on a given set of files for a

specified client during a backup.

drive When Dynamic Drive Sharing (DDS) is enabled, refers

to the physical backup object, such as a tape drive,

disk, or file. See also device.
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enabler code A special code provided by Legato that activates the

software. The enabler code that unlocks the base

features for software you purchase is referred to as a

base enabler. Enabler codes for additional features or

products (for example, autochanger support) are

referred to as add-on enablers.

exit code An indicator that specifies whether a backup or

recovery session succeeded. An exit code of zero (“0”)

indicates the session completed successfully. A

nonzero exit code indicates the session did not

complete successfully.

expiration date The date when the volume changes from

“read/write” to “read-only.”

expired save set A save set whose browse time has been reached;

therefore, it can no longer be browsed. In addition, the

save set has been removed from the client file index.

failover In a cluster network, the process of relocating a

resource to its redundant or backup component, either

because of a hardware or software failure or for

administrative purposes.

file index See client file index.

filesystem 1. A file tree that is on a specific disk partition or other

mount point.

2. The entire set of all files.

3. A method of storing files.

firewall A system designed to prevent unauthorized access to

or from a private network. All messages entering or

leaving the intranet pass through the firewall, which

examines each message and blocks those that do not

meet the specified security criteria. There are several

types of firewall techniques. The NetWorker software

supports client backups from computers that are

protected by packet filtering.



Glossary

G
lossary

Legato NetWorker, Release 6.1
Disaster Recovery Guide 193

fork A child process created by NetWorker software to

perform the requested operation. In instances where a

command uses a parallelism value, NetWorker

software creates multiple instances of that command.

Each instance of the command is identical to the

original command and is referred to as a child process.

Once each child process is created, they are run

simultaneously.

full backup See level.

grooming The NetWorker process of removing the original files

from a local disk after a successful archive operation.

group A client or group of clients configured to start backing

up files to the NetWorker server at a designated time

of day.

high-availability
system

A system that allows the application services to

continue despite a hardware or software failure. Each

cluster node has its own IP address. Each cluster node

also has private (local) resources or disks that are

available only to that machine.

inactivity timeout An attribute that indicates the number of minutes

NetWorker software waits before determining that a

client is unavailable for backup.

incremental See level.

index policy A policy that specifies how long file and data index

entries should remain valid. Clients specify which

index policies they wish to use.

jukebox See autochanger.

LCP An abbreviation for library control program, a

program that the Legato GEMS SmartMedia software

uses to control robotic libraries.
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level A measurement that determines how much data

NetWorker software saves during a scheduled or

manual backup.

A full (f) backup backs up all files, regardless of

whether they have changed. Levels one through nine

[1-9] back up files that have changed since the last

lower numbered backup level. An incremental (incr)

backup backs up only files that have changed since the

last backup.

library See autochanger.

license enabler The enabler code that enables you to run a feature or

product.

local cluster client A NetWorker client that is not permanently bound to a

physical machine, but is instead managed by a cluster

manager. It can be bound to more than one physical

machine in the cluster and can own its own data disks.

It is also referred to as a logical or virtual client.

local host The node on which the client or server program is

running.

logical server The term used by Compaq to denote a cluster server.

Also known as an agent (Solaris), a package (HP-UX),

and a virtual server (Microsoft).

LUS An abbreviation for User SCSI. The LUS driver is used

by Legato software products as a proprietary device

driver that sends arbitrary SCSI commands to an

autochanger.

manual backup A backup that a user requests from the client’s save
program. The user specifies participating files,

filesystems, and directories. A manual backup does

not generate a bootstrap save set.

media The physical storage medium to which backup data is

written. NetWorker software supports tape, magnetic

or optical disk, and filesystems as backup media. See

also volume.
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media database A database that contains indexed entries about the

storage volume location and the life cycle status of all

data and volumes managed by the NetWorker server.

See also volume.

migration The process of moving data from a local filesystem to

storage media in the migration store to free up disk

space on the local drive.

multiplexing A NetWorker feature that permits data from more

than one save set to be simultaneously written to the

same storage device.

NDMP An abbreviation for Network Data Management

Protocol, which is a storage management client/server

protocol for enterprise-wide backup of

network-attached storage. NetWorker software uses

NDMP to provide connections to computers with

NDMP data modules for tape operations, allowing a

significant reduction in network traffic.

near-line storage See autochanger.

NetWorker client See client.

NetWorker server See server.

NetWorker
storage node

See storage node.

NFS client A computer that can access files on a network file

system (NFS) server.

NFS server A computer that contains exported filesystems that

NFS clients can access.

nonclone pool Pools that contain data that has not been cloned.

notification A message generated and sent to the NetWorker

administrator about important NetWorker events.
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online indexes The databases located on the NetWorker server that

contain all the information pertaining to the client

backups (client file index) and backup volumes (media
database).

operator The person who monitors the server status, loads

backup volumes into the server devices, and

otherwise executes the day-to-day NetWorker tasks.

override A NetWorker feature that allows you to configure a

different backup level for a specific date listed in a

Schedule resource.

package The term used by HP-UX to denote a cluster server.

Also known as an agent (Solaris), logical server

(Compaq), and virtual server (Microsoft).

packet filtering A method of firewall protection that looks at each

packet entering or leaving the network and accepts or

rejects it based on user-defined rules. See also firewall.

parallelism A NetWorker feature that enables the NetWorker

server to either back up save sets from several clients

or many save sets from one client at the same time.

Parallelism is also available during recovers.

pathname A set of instructions to the operating system for

accessing a file. An absolute pathname tells how to find

a file beginning at the root directory and working

down the directory tree. A relative pathname tells how

to find the file starting where you are now.

physical cluster
client

A NetWorker client that is bound to a physical

machine in the cluster and can represent its own

resources (private or local). It can also be called the

physical client.

physical host Any one of the nodes (or machines) that forms the

cluster.
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policy A set of constraints that specify how long an entry can

remain in a client’s online file index. When a policy

expires, the save sets associated with that policy are

marked recyclable. Each client resource uses two

policies: a browse policy and a retention policy. For

more information, refer to the nsr_policy (5) man page

or the Legato Command Reference Guide.

pool A feature that enables you to sort backup data to

selected volumes. A pool contains a collection of

backup volumes to which specific data has been

backed up.

probe The process NetWorker software uses to determine the

directories or files to back up on each client.

purging The process of deleting all entries for files on the

volume from the client file index, but allowing entries

for the save sets to remain in the media database.

recover A recovery method that re-creates an image of the

client filesystems and database on the NetWorker

server.

recyclable save
set

A save set whose browse and retention policies have

been reached; therefore, the save set has been

removed from the media database.

recyclable volume A volume whose data has passed both its browse and

retention policies and is now available for relabeling

and use by a NetWorker server or storage node.

Registry A database of configuration information central to

Windows NT and Windows 2000 operations. It

centralizes all Windows settings and provides security

and control over system, security, and user account

settings.

remote device A storage device that is attached to a NetWorker

storage node.

RPC An abbreviation for remote procedure call, which is

the protocol the NetWorker server uses to perform

client requests over a network.
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resource A component of the NetWorker software that

describes the NetWorker server and its clients.

Devices, schedules, clients, groups, and policies are

examples of NetWorker resources. Each resource

contains a list of attributes that define the parameters

to use for the specific NetWorker resource.

resource database A database that contains information about each of the

configured backup server’s resources.

resource owner The cluster (logical, not physical) host that owns the

resource. If a resource (for example, a shared disk) is

not owned by any virtual host, it is assumed to be

owned by the local host (physical node) that hosts the

resource.

retention policy A policy that determines how long save set entries are

retained in the NetWorker server’s media database.

retrieve The process of locating and copying back files and

directories that NetWorker software has archived.

retry mechanism The action NetWorker software performs when client

operations fail. This situation might occur when the

rate of transmission is either low or nonexistent. By

using this mechanism, a previously failed operation

might be more successful. Another common situation

whereby a retry mechanism might succeed is when

the client is in a reboot cycle.

root 1. (UNIX only) The UNIX superuser account (with

user name “root” and user ID). By extension, the

privileged system-maintenance login on any

operating system.

2. (Windows NT/Windows 2000 and UNIX) The top

node of the system directory structure; the home

directory of the root user.

save set A group of files or a filesystem from a single client

computer backed up onto storage media.

save set
consolidation

The process that merges a level 1 backup with the last

full backup of a save set to create a new full backup.

See also level.
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save set ID An internal identification number that NetWorker

software assigns to a save set.

save set recover The recovery of specified save sets to the NetWorker

server.

save set status The NetWorker attribute that indicates whether a

given save set is restorable, recoverable, or recyclable.

The save set status also indicates whether the save set

has been successfully backed up.

save stream The data and save set information being written to a

storage volume during a backup. A save stream

originates from a single save set.

server The computer on a network that runs the NetWorker

server software, contains the online indexes, and

provides backup and recovery services to the clients

and storage nodes on the same network.

server index A file that lists all the server files that were backed up

during a scheduled backup.

service port The port used by a server or storage node to listen for

backup and recovery requests from clients through a

firewall.

shared disk The storage disk that is connected between multiple

nodes in the cluster.

shell prompt A cue for input in a shell window where you enter a

command.

silo A repository for holding hundreds or thousands of

volumes. Silo volumes are identified by barcodes, not

by slot numbers.

skip A backup level in which designated files are not

backed up. See also level.
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SMS An abbreviation for system management software,

which is a Microsoft-based software installation

system that allows the wide-scale, automatic

installation of software products on clients from a

single remote server.

SNMP An abbreviation for Simple Network Management

Protocol, which is a protocol that defines the

communication between a manager (sometimes called

a monitor or management station) and an object (the

item being managed). NetWorker software uses

SNMP to send messages to the administrator about

NetWorker events.

ssid See save set ID.

staging The process of moving data from one storage medium

to another, less costly medium, and later removing the

data from its original location.

stand-alone In a cluster environment, if the NetWorker.clustersvr
file is missing at the binary location, the NetWorker

server will start in noncluster mode, also called

stand-alone mode. The stand-alone mode is

sometimes referred to as the server backing up itself.

stand-alone
device

A storage device that contains a single drive for backing

up data.

storage device The hardware that reads and writes data during

backup, recovery, or other NetWorker operations.

storage node A storage device physically attached to another

computer whose backup operations are administered

from the controlling NetWorker server.

versions The date-stamped collection of available backups for

any single file.
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virtual cluster
client

A NetWorker client that is not permanently bound to a

physical machine, but is instead managed by a cluster

manager. It can be bound to more than one physical

machine in the cluster and can own its own data disks.

It is also referred to as a logical cluster client or a

virtual client.

virtual server The term used by Microsoft to denote a cluster server.

Also known as an agent (Solaris), a logical server

(Compaq), and a package (HP-UX).

volume A unit of storage media, such as a magnetic tape, an

optical disk, or a file. A storage device reads from and

writes to volumes, which can be physical units (for

example, a labeled tape cartridge) or logical units (for

example, optical media can store multiple volumes on

a single physical platter).

volume ID The internal identification assigned to a backup

volume by NetWorker software.

volume name The name you assign to a backup volume when it is

labeled.

volume pool See pool.
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